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12 Introduction

1 Introduction

Altova UModel 2024 Professional Edition is a UML modeling application with a rich visual interface and superior
usability features to help level the UML learning curve. UModel includes many high-end functions to empower
users with the most practical aspects of the UML 2.5 specification. UModel is a 32/64-bit Windows application
that runs on Windows 10, Windows 11, and Windows Server 2012 or newer. 64-bit support is available for the
Enterprise and Professional editions. For an ovenview of UModel capabilities, see Support Notes 3}

UModel®

UML®, OMG™, Object Management Group™, and Unified Modeling Language™ are either registered
trademarks or trademarks of Object Management Group, Inc. in the United States and/or other countries.

Last updated: 20 October 2023

Altova website: ¢ UML tool

Altova UModel 2024 Professional Edition © 2017-2023 Altova GmbH
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1.1 Support Notes

UModel is a 32/64-bit Windows application that runs on the following operating systems:

e Windows Server 2012 or newer

e Windows 10, Windows 11

64-bit support is available for the Enterprise and Professional editions.

UML diagrams

UModel supports all fourteen diagrams of the UML 2.5.1 specification, and additional specialized diagram

types.

Structural

Behavioral

Additional

Class Diagrams

Activity Diagram

XML Schema Diagrams

Component Diagram

Communication Diagram

BPMN (Business Process
Modeling Notation) 1.0/ 2.0
Diagrams (UModel Enterprise and
Professional editions)

Composite Structure Diagram

Interaction Overview Diagram

SysML 1.2, 1.3, 1.4, 1.5, 1.6
Diagrams (UModel Enterprise and

Professional editions)

Deployment Diagram Sequence Diagram Database Diagrams (UModel
Enterprise and Professional

editions)

Object Diagram State Diagrams (State Machine

and Protocol State Machine)

Package Diagram Timing Diagram

Profile Diagram Use Case Diagram

UModel has been designed to allow complete flexibility during the modeling process:

¢ UModel diagrams can be created in any order, and at any time; there is no need to follow a prescribed

sequence during modeling.

e The syntax coloring in diagrams is customizable. For example, you can customize modeling elements

and their properties (font, color, borders, etc.) in a hierarchical fashion at the project, node/line,

element family and element level, see Changing the Style of Elements @

e The unlimited lewvels of Undo/Redo track not only content changes, but also all style changes made to

any model element.
e Modeling elements support hyperlinks, see Hyperlinking Elements @
e You can create multiple layers in the same UML diagram, see Adding Layers to Diagrams @

© 2017-2023 Altova GmbH
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Support Notes

Code engineering and import of binaries
UModel supports code generation and reverse engineering of program code written in the following languages:

Language

Code engineering

Import of binaries

C#

1.2, 2.0, 3.0, 4.0, 5.0, 6.0, 7.0, 7.1, 7.2,
7.3,8.0,9.0', 10

Same language versions as for code
engineering?

C++ (UModel Enterprise
Edition)

C++98, C++11 and C++14, C++17, C+
+20

Only partial support for C++20:
modules are not supported.

Not applicable

Java

1.4, 5.0 (1.5), 6 (1.6), 7 (1.7), 8 (1.8), 9
(1.9), 10, 11, 12, 13, 14, 15, 16, 17, 18,
19

Same language versions as for code
engineering®

Visual Basic .NET 7.1 or newer Same language versions as for code
engineering
XML Schemas* 1.0 Not applicable

Databases® (UModel
Enterprise and
Professional editions)

For more information about supported
databases, see Database Supportm.

Not applicable

Table footnotes:

1. If you import binary files compiled from C# 9.0 code, note that any records will be imported as classes.
This limitation is due to the fact that records are marked as classes in the assembly, which makes it
impossible to distinguish them from classes.

2. C# code engineering and import of binaries include support for .NET Framework, .NET Core, .NET 5,
and .NET 6. Note that .NET Framework, .NET Core, .NET 5 or .NET 6 must be installed, as applicable.
Binaries of other .NET implementations which are not mentioned are likely to be imported as well. See
also Importing Java, C# and VB.NET Binaries @9

3. ltis also possible to import binaries targeting Java Virtual Machines other than Oracle JDK, such as
OpendDK, SapMachine, Liberica JDK, and others, see Adding Custom Java Runtimes &9

4. In the case of XML Schemas, code engineering means that you can import a schema (or multiple

schemas from a directory) into UModel, view or modify the model, and write the changes back to the
schema file. When you synchronize data from the model to a schema file, the schema file is always

overwritten by the model. See also XML Schema Diagrams @&,

In the case of databases, code engineering means that you can (i) model a database in UModel with
the option to update the database through a script generated from the model, or (ii) import an existing
database structure into a model, make changes to it, and then deploy a script generated from the

model to the database. Some database object types are not supported for modeling. For details, see

UModel and Databases @.

General notes:

Altova UModel 2024 Professional Edition
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e You can synchronize the code and model at the project, package, or even class level. UModel does
not require that pseudo-code, or comments in the generated code be present, in order to accomplish
round-trip engineering.

e A single project can support Java, C#, or VB.NET code simultaneously.

e UModel supports the use of UML templates and their mapping to or from Java, C# and Visual Basic
generics.

e While importing source code, you can optionally generate Class © and Package diagrams. Once
the source code is imported into the model, you can also generate Sequence“* diagrams.

e You can generate program code from Sequence diagrams and from State Machine diagrams

e UModel projects can be split up into multiple sub-projects allowing several developers to
simultaneously edit different parts of a single project. You can then reintegrate the changes back into a
common model. You can also merge UModel projects, as a 2-way or as a 3-way merge, see Merging
UModel Pro'ects.

e Code generation in UModel is based on Spy Programming Language (SPL) templates and is
customizable.

UML documentation generation

You can generate documentation from UModel projects in HTML, RTF, Microsoft Word 2000 or later formats.
Various options are available that let you configure the level of detail of generated documentation, the look and
feel, and other preferences. Generating documentation in PDF format and deep customization of document
generation templates is possible with Altova StyleVision (https://www.altova.com/stylevision). For more
information, see Generating UML Documentation €.

IDE Integration
UModel is optionally available as a plug-in to the following integrated development environments:

e Visual Studio 2012/2013/2015/2017/2019/2022, see UModel Plug-in for Visual Studio@
e Eclipse 2023-09, 2023-06, 2023-03, 2022-12, see UModel Plug-in for Eclipse

UModel provides a COM-based API@ and also allows integration of custom IDE Plug-lns (DLL libraries)

into its graphical user interface. The Scripting Editor® allows for development of custom VBScript or JScript
scripts and macros to automate various tasks.

Microsoft Office integration

By virtue of its database modeling support, UModel can import Access databases into a model, and generate
SQL scripts for Access databases. For more information, see UModel and Databases @

Interoperability
UModel also provides support for importing or exporting projects to or from XML Metadata Interchange (XMI)
format, see XMI - XML Metadata Interchange.

© 2017-2023 Altova GmbH Altova UModel 2024 Professional Edition
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1.2 Database Support

The table below lists all the supported databases. If your Altova application is a 64-bit version, ensure that you
have access to the 64-bit database drivers needed for the specific database you are connecting to.

Database

Notes

Firebird 2.x, 3.x, 4.x

IBM DB2 8.x, 9.x, 10.x, 11.x

IBM Db2 fori 6.x, 7.4, 7.5

Logical files are supported and shown as views.

IBM Informix 11.70 and later

MariaDB 10 and later

MariaDB supports native connections. No separate drivers are
required.

Microsoft Access 2003 and later

At the time of writing (early September 2019), there is no
Microsoft Access Runtime available for Access 2019. You can
connect to an Access 2019 database from Altova products only
if Microsoft Access 2016 Runtime is installed and only if the
database does not use the "Large Number" data type.

Microsoft Azure SQL Database

SQL Sener 2016 codebase

Microsoft SQL Server 2005 and later
Microsoft SQL Server on Linux

MySQL 5 and later

MySQL 5.7 and later supports native connections. No separate
drivers are required.

Oracle 9i and later

PostgreSQL 8 and later

PostgreSQL connections are supported both as native
connections and driver-based connections through interfaces
(drivers) such as ODBC or JDBC. Native connections do not
require any drivers.

Progress OpenEdge 11.6

SQLite 3.x

SQLite connections are supported as native, direct connections
to the SQLite database file. No separate drivers are required.

Sybase ASE 15, 16

Teradata 16

Altova UModel 2024 Professional Edition
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2 UModel Tutorial

This tutorial shows you how to create various UML diagrams with UModel, while acquainting you with the
graphical user interface. You will also learn how to generate code from a UML model (forward engineering) as
well as how to import existing code into a UML model (reverse engineering). With respect to code engineering,
you will also learn how to perform full round-trip engineering (either model->code->model or code->model-
>code). This tutorial assumes basic knowledge of the UML.

The tutorial is organized into sections as shown below. In the initial sections of this tutorial you will be working
with a sample project pre-installed with UModel. If you would like to quickly create a new modelling project from

scratch with UModel, you can skip directly to Forward Engineering (from Model to Code)@.

Getting Startedm

Use Cases

Class Diagrams

Creating Derived Classes
Object Diagrams
Component Diagrams@
Deployment Diagrams@

Forward Engineering (from Model to Code)
Reverse Engineering (from Code to Model)

This tutorial makes use of the following sample UModel project files available in the directory C:
\Users\<username>\Documents\Altova\UModel2024\UModelExamples\Tutorial:

BankView-start.ump This is the UModel project file that constitutes the initial state of the tutorial
sample. Several model diagrams as well as classes, objects, and other model
elements exist in this project. By working through the tutorial, you will be adding
new elements or diagrams, or editing existing ones, using UModel.

Note: This project is deliberately incomplete, so validation errors and warnings
will be shown if you check the project syntax using the Project | Check Project
Syntax menu command. The tutorial shows you how to resolve these issues.

BankView-finish.ump This is the UModel project file that constitutes final state of the tutorial sample.

Note: All UModel example files are initially available in the directory C:\ProgramData\Altova\UModel2024.
When any user starts the application for the first time, the example files are copied to C:
\Users\<username>\Documents\Altova\UModel2024\UModelExamples. Therefore, do not move,
edit, or delete the example files in the initial directory.

© 2017-2023 Altova GmbH Altova UModel 2024 Professional Edition
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21 Getting Started

When you start UModel for the first time after installation, it opens a default empty project "NewProject1". On
subsequent runs, UModel will open the last project that was loaded. To create, open, and save UModel projects
(.ump files), use the standard Windows commands available in the File menu or in the toolbar.

(T Altova UModel - MewProject] - | *

File Edit Project Layout View Tools Window Help
Dl o g p | A XKEBPB S M8
Model Tree

[ Root

- [ Component View

MMessages x

El Model Tree | B Diagram Tree | {} Favorites ﬂ ﬂﬂ ﬂﬂ ﬂﬂ ﬂ!ﬂ ﬂ

Properties o x

[=l Properties @ Styles | El Hierarchy

Civerview o x

Cwverview Documentation | @ Layer

UMaodel Enterprise Edition v2018 Connected to Altova LicenseServer at ©1993-2017 Altova GmbH CAP NUM SCRL

UModel Graphical User Interface

Note the major parts of the user interface: multiple helper windows on the left hand side and the main diagram
window to the right. Two default packages are visible in the Model Tree window, "Root" and "Component View".
These two packages cannot be deleted or renamed in a project.

The helper windows in the upper-left area are as follows:

e The Model Tree window contains and displays all modeling elements of your UModel project.
Elements can be directly manipulated in this window using the standard editing keys as well as drag
and drop.

o The Diagram Tree window allows your quick access to the modeling diagrams of you project wherever
they may be in the project structure. Diagrams are grouped according to their diagram type.

o The Favorites window is a user-definable repository of modeling elements. Any type of modeling
element can be placed in this window using the "Add to Faworites" command of the context menu.

Altova UModel 2024 Professional Edition © 2017-2023 Altova GmbH
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The helper windows in the middle-left area are as follows:

The Properties window displays the properties of the currently selected element in the Model Tree
window or in the Diagram window. Element properties can defined or updated in this window.

The Styles window displays attributes of diagrams, or elements that are displayed in the Diagram view.

These style attributes fall into two general groups: Formatting and display settings.

The Hierarchy window displays all relations of the currently selected modeling item, in two different
views. The modeling element can be selected in a modeling diagram, the Model Tree, or in the
Favorites window.

The helper windows in the lower-left area are as follows:

The Overview window which displays an outline view of the currently active diagram.

The Documentation window which allows you to document your classes on a per-class basis.
The Layer window allows you to define multiple layers for any UModel diagram. Single, as well as
multiple, layers can be shown, locked and hidden. Layers allow you to make logical groupings of
modeling elements on a diagram.

In this tutorial, you will be working mostly within the Model Tree and Diagram Tree windows, as well as the
main dia%m window. For further information about the graphical user interface elements, see UModel User
Interface .

To open the tutorial project:

1.

Select the menu option File | Open and navigate to the ...\UModelExamples\Tutorial folder of
UModel. Note that you can also open a *.ump file through a URL, please see Switch to URL @ for
more information.

Open the BankView-start.ump project file. The project file is now loaded into UModel. Several
predefined packages are now visible under the Root package. Note that the main window is empty at
the moment.

© 2017-2023 Altova GmbH

Altova UModel 2024 Professional Edition



20 UModel Tutorial

Getting Started
@ Altova UModel - ChUsers\altova\DocumentshAltoval UModel201 84 UModelExamples\ Tutorial\BankView-start.ump - O X
File Edit Project Layout View Tools Window Help
D@ o> q4p R XEKEBRB S Es)
Model Tree o x
| Root

[ Compaonent View

[ Deployment View

[ | Design-phase

.Ia\ra Lang [Java Lang.ump]
[ Unknown Externals

E]Ja\ra Profile [Java Profile.ump]

Messages x
El Model Tree | = Diagram Tree | ‘#}' Favorites ﬁ ﬂﬂ ﬂﬂ ﬂﬂ !!ﬂ H

Properties n X

[= Properties @J Styles | El Hierarchy

Overview

Cwverview Documentation | % Layer

UMuaodel Enterprise Edition v2018 Connected to Altova LicenseServer at

W
- ©1998-2017 Altova GmbH CAP NUM SCRL .
Bank View-start.ump project
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2.2 Use Cases

This tutorial section shows you how to create a Use Case diagram, while acquainting you with the basics of the
UModel graphical user interface. Specifically, it illustrates the following tasks:

Add a new package to the project

Add a new use case diagram to the project

Add use case elements to the diagram, and define the dependencies amongst them
Align and adjust the size of elements in the diagram

Change the style of all diagrams in a UModel project.

To proceed, run UModel and open the BankView-start.ump project (see also Opening the Tutorial Proiect@).

Adding a new package to a project

As you already know from UML, a package is a container for organizing classes and other UML elements,
including use cases. Let's begin by creating a package that will store a new use case diagram. Note that
UModel does not require that a specific diagram must reside in a specific package; however, you might want to
organize diagrams into packages for better organization and consistency.

1. Right-click the Root package in the Model Tree window, and select New Element | Package.
2. Enter the name of the new package (in this example, "Use Case View"), and press Enter.

_

Root
[ Component View
g Deployment View
- Design-phase

- & Java Lang [Java Lang.ump]
------- Use Case View
| Unknown Externals

- [« 7] Java Profile [Java Profile.ump]

ElMCIdElTrEE EDiagramTree {%Fav-:nrites

Adding a Use Case diagram to a package

1. Right-click the previously created "Use Case View" package.
2. Select New Diagram | UseCase Diagram.

© 2017-2023 Altova GmbH Altova UModel 2024 Professional Edition
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Model Tree o pkg Use{?.ase‘u’im) _ '
Root

A Component View
A Deployment View
- Design-phase
[ &7 Java Lang [Java Lang.ump]
A Unknown Externals
B 1 Use Case Wiew
- F™ UseCaseDiagram1
- [+ 7] Java Profile [Java Profile.ump]

Ell"ﬂﬂdelTrEE @Diagram Tree %% Favaorites
Properties o X
name UseCaseDiagram1

element kind UseCase Diagram

[=] Properties @ Styles @Hierarchy

F™ useCaseDiagram

A Use Case diagram has now been added to the package in the Model Tree window, and a new
Diagram window has been created as well. A default name has been provided automatically.

3. Double-click the diagram name in the Model Tree window, change it to "Ovenview Account Balance",

and press Enter to confirm.

Model Tree

Root
[ Component View
[ Deployment View
BEs| Design-phase
[ &7 Java Lang [lava Lang.ump]
g Unknown Externals
B 1Use Case View
- F™ Overview Account Balance
- [« 7] Java Profile [Java Profile.ump]

EIMcndEITree @DiagramTree %%Fam:-rites

Adding Use Case elements to the Use Case diagram
1. Right-click in the newly created diagram and select New | Actor. The actor element is inserted at the

click position.

Altova UModel 2024 Professional Edition
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2. Click the Use Case toolbar button = and then click inside the diagram window to insert the

element. A "UseCase1" element is inserted. Note that the element, and its name, are currently
selected, and that its properties are \visible in the Properties window.

pkg Use Case View |

Actort

UseCasel

extension points

|

3. Change the title to "get account balance", press Enter to confirm. Double-click the title if it is
deselected. Note that the use case is automatically resized to adjust to the text length.

pkg Us:e{:;:m:‘|.|’|'\f.-1.|'.'ﬂI o

Adtort

2 get account balance

Note: To create a multi-line use case name, press Enter while holding the Ctrl key pressed.

Manipulating UModel elements: handles and compartments

When selected, model elements in a diagram display various connection handles and other items used to
manipulate them. Handles can be used to create relationships between elements, or show or hide certain
compartments from the element, as shown below.

1. Double-click the "Actor1" text of the Actor element, change the name to "Standard User" and press

Enter to confirm.
2. Place the mouse cursor over the handle to the right of the actor. A tooltip containing "Association"

appears.
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pkg Use{:ase‘u’im) L

_Standard User

2]

| Aszociation .
account balance )

Click the handle, drag the Association line to the right, and drop it on the "get account balance" use
case. An association has now been created between the actor and the use case. The association
properties are also visible in the Properties window. The new association has been added to Model

Tree under the Relations item of the Use Case View package.

pkg Use Case View ] =

_Standard User

: get account balance .

Click the use case and drag it to the right to reposition it. The association properties are visible on the

association object.

Click the use case to select it, then click the collapse icon on the left edge of the ellipse.

ISR
"_,..--' -‘--"-l

o 'f \\. o
> N

./ oetaccount balance %,
o=
k- extension points S
Sul e

™

L. L Mmg T L
" L e

The "extension points" compartment is now hidden.

e

- .
-
-
L

bl
Y L
D—!\ get account balance fH
_E_"'-.

B - —--'."".-'IE.
!
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A blue dot next to an element in the Model Tree window signifies that the element is visible in the
current diagram. For example, in the image below, three elements are currently visible in the diagram

and thus have a blue dot in the Model Tree:

Model Tree o X

- Deployment View
-H Design-phase
A & Java Lang [Java Lang.ump]
-H Unknown Externals
B Use Case View
E - Overview Account Balance
] get account balance
aﬁ- Standard User
= :’g} Relations
D_} Association: [get account balance - !

L]

-7 [« #]Java Profile [Java Profile.ump] W

pkag UseCase‘u'Tm,_J o

_Standard User

Resizing the actor adjusts the text field, which can also be multi-line. To insert a line break into the

text, press Enter while holding the Ctrl key pressed.

To finish up the Use Case diagram:

N —

>

Lo

Click the Use Case

toolbar button and simultaneously hold down the Ctrl key.

Click at two different vertical positions in the diagram to add two more use cases, then release the Ctrl

key.

Name the first use case "get account balance sum" and the second, "generate monthly revenue

report”.

Click the collapse icon of each use case to hide the extensions compartment.
Click the actor and use the association handle to create an association between "Standard User" and

"get account balance sum".
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To create an "Include" dependency between use cases (creating a subcase):

pkg Use Case Wﬂv)

_Standard User

: get account balance sum

generate monthly revenue report

Click the Include handle of the "get account balance sum" use case, at the bottom of the ellipse, and
drop the dependency on "get account balance". An "include" dependency is created, and the include

stereotype is displayed on the dotted arrow.

pkg Use Case View.] =

2

zincludes=

: get account balance sum

generate monthly revenue report
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Inserting user-defined (customized) actors

The actor in the "generate monthly revenue report" use case is not a person, but an automated batch job run by
a bank computer. The instructions below show to add a new actor to the diagram, and also use a custom
image for it.

Click the Actor toolbar button to insert an actor in the diagram.
Rename the actor to "Bank".

N —

3. Inthe Properties window, click Browse E‘ next to "icon file name" entry, and browse for the Bank-
PC.bmp file available in the same folder as the project.

4. Clear the Absolute Path check box to make the path relative. Select Preview to display a preview of
the selected file in the dialog box.

Enter Filepath

File path:| Bark-PC.bmp |-

[Jabsolute path [ Preview i— o]

Hefresh

Cancel

5. Click OK to confirm the settings and insert the new actor. Move the new "Bank" actor to the right of the
lowest use case.

6. Click the Association toolbar button and drag from the "Bank" actor to the "generate monthly
revenue report" use case. This is an alternative method of creating an association.

pkg Use Case View |

_Standard User

3

azincludes=

: get account balance sum

generate monthly revenue report

" Bank

Note: The background color used to make the bitmap transparent has the RGB values 82.82.82.
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Aligning and adjusting the size of diagram elements

When dragging components in a diagram, guide lines appear allowing you to align an element to any other
element in the diagram. You can enable or disable this option as follows:

1. On the Tools menu, click Options.
2. Click the View tab.
3. Inthe Alignment group, select the Enable snap lines check box.

You can also align and adjust the size of multiple elements, as follows:

1. Create a selection marquee by dragging on the diagram background, making sure that you encompass
all three use cases starting from the top. Alternatively, to select multiple elements, click elements
while holding the Ctrl key pressed. Note that the last use case to be marked, is shown in a dashed
outline in the diagram, as well as in the Overview window.

pkg Use Case Vim) L.

_Standard User

-
D—{ generate monthly revenue repo ::

LY
e -
E.‘_‘ _'__,..l-"'
. E‘. .. .-"-.-!--\.__E__.--r.-"". ..

" Bank

All use cases are selected, with the lowest being the basis for the following adjustments.

2. Click the Make same size toolbar button.

3. Toline up all the ovals, click the Center Horizontally dls toolbar button.
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pkg Use Case View/) -}

_Standard User

. U
s
D—:_ generate monthly revenue report :i—i--—-
-\\.‘ L
. @' 5 G -'.-"'.-'l-—u-—l__.--r.-""." .

B

" Bank

Change the style of diagrams in a project

By default, all diagrams of the tutorial project have a gradient background color, and a background grid is also
visible. The appearance of diagrams in a project is configurable. For example, to change the background color
of all diagrams, do the following:

1. In the Properties window, click Styles.
2. Under Project Styles, identify the setting Diag. Background Color.

Styles o =
Project Styles w
Draw Mirrored false ol LS
Diag. Background Color |gradient |
Diag. Grid Color black HEE ~ |3
Diag. Show Grid true |
Diag. Snap to Grid true | w
Jhiiin o _aial fine == =!
[=] Properties @l Styles @Hierarchy

3. Change the value from "gradient" to a color of your choice.

To enable or disable the diagram background grid:

e Change the setting Diag. Show Grid from "true" to "false”. (Alternatively, if a diagram is currently
open, click the Show Grid | toolbar button.)
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2.3 Class Diagrams

This tutorial section illustrates the following tasks:

e Add an abstract class to an existing class diagram

e Add class properties and operations, and define parameters as well as their direction and type
e Add a return type to an operation

e Change icons to UML conformant symbols

e Delete and hide class properties and operations

e Create a composite association between two classes.

To proceed, run UModel and open the BankView-start.ump project (see also Opening the Tutorial Proiectm
).

Adding an abstract class

The diagram to which the abstract class will be added is called "BankView Main" and can be opened as
follows:

1. In the Diagram Tree window, expand the "Class Diagrams" package to display all class diagrams
contained in the project.

Diagram Tree o x

= Diagrams
------- i) Activity Diagrams
B 5] Class Diagrams
-------- [ Apply Java Profile
o 7 BankView Main
------- a4 Communication Diagrams
-H g Component Diagrams
------- = Composite Structure Diagrams
- (g1 Deployment Diagrams
------- g Interaction Owerview Diagrams
- @ Object Diagrams
------- 3| Package Diagrams
------- Eg| Profile Diagrams
------- I=7|Protocol State Machine Diagrams
------- o) Sequence Diagrams
------- =7 5tate Machine Diagrams
------- Timing Diagrams
------- 5 UseCase Diagrams
------- wp| XML Schema Diagrams

ElMDdHTFEE @DiagramTree %%Favnrites

2. Do one of the following:

e Double-click the "BankView Main" diagram icon.
e Right-click the diagram, and select Open diagram from the context menu.
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Note: It is also possible to open the diagram from the Model Tree window. First, locate the diagram under

the package "Root | Design-phase | BankView | com | altova | bankview", and then use either of the
methods above to open it.

Two concrete classes with a composite association between them are visible in the class diagram.

pkg bankview ] 5
BankView - Bank
@] banks:Bank[*] {ordered} : : @] bankname:5tring
&1 bankAPLIBankAP! ) _{°riz"_°‘d} &1 IPAddress:string
o - . .amFs &1 username:String
P «constructors BankView(in bankAPLIBankaP) 1‘-—.;- @] password:String
@) collectBankAddressinfos(:boolean o
g\) collectAccountinfos(:boolean o » «constructor= Bank(in name:String, in IP:String, in userString, in pw:String)
¢» colledtDatal}:boolean s o o o oa » collectAccountinfos(in bankAPLIBankAPl:boolean
¢» getBalanceAtBank(in bankname:string):int ° o o o o ¢» getBalanceOfAccounts(iint
» getBalanceSumOfAllBanks():int oo » getBankMame(:5tring
o » getlPAddress():String
¢» getUsername(}:5tring
» getPassword():5tring

"Bank View Main" diagram

The new abstract class can be added as follows:

1. Click the Class = toolbar button, and then click to the right of the Bank class to insert the new

class.
2. Double-click the name of the new class and change it to Account.

Bank
@] bankname:5tring -
I @] IPAddress:String o
[ @] username:string . -I---t--.ii.
o @] password:3tring 1 Account H
. -0
¢» «constructor= Bank(in name:String, in IP:String, in usenString, in pw:String) | | m===a=amn

% collecthccountinfos(in bankAPLIBankaPl:boaolean
% getBalanceOfAccounts(int

% getBankMame():String

™ getiPaddress(:String

™ getUsername():String

% getPassword(:5String

3. Inthe Properties window, select the abstract check box to make the class abstract. The class title is
now displayed in italic, which is the identifying characteristic of abstract classes.
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4. In the code file name text box, enter "Account.java" to define the Java class.

Properties q x
name Account

qualified name Design-phase:zBankView::c
element kind Class

visibility public |
leaf O

abstract

isFinalSpecialization O

active O

code file name E;ﬁ.cc::uunt.java|

code file path

«annotationss O

«statics O

astrictfps O

[=] Properties @St}'les @Hierarch}'

Adding properties to a class

1. Right-click the "Account" class and select New | Property, or press F7. A default property propertyl
is inserted with stereotype identifiers << >>.

A T .
1 Account | _
ol i
o1 S Prapeni e
e

2. Change the property name to balance, and then enter a colon ( : ) character. A drop-down list

containing all valid types is displayed.

3. Type "f", and press Enter to insert the return type "float". Note that drop-down lists are case sensitive.
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R i -
o Account i .
EE:@] <> Balancerf (= -
"-.'-.'-.'-f-'.-'.-'.'! Type Mame Mamespace Sl
R B File Unknown Externals A
B FileDescriptor Unknown Externals
B Finalizer Java Lang:java:langiire
B FinalizerThread Java Lang:java:langiire
B FinalReference Java Lang:java:langiire
v

4. Continue on the same line by appending "=0" to define the default value.
5. Using the same method as abowe, create a new property id of type string.

1

|
—-

bal Float=0
¢l _djsath_CE_ pat=0 o
@] id:5tring y

Adding operations to a class
1. Right-click the Account class and select New | Operation, or press F8.
2. Enter "Account()" as operation name. Notice that the stereotype has changed to <<constructor>>,
since the operation name is the same as the class name.

I Account 1
. -
] A

!@1 balance:float=0 s

. L [
'_;@] id:String :—EI )
= [

1 4% cconstructors Account() :

o e

3. Using the same method as abowe, add two more operations, namely, getBalance () : float and
getId() :String.
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RN .
o Account i
=1 1
] [
~ 1@l balance:float=0
&1 idiString L.
oo & .
e o
1 4% «constructors Account() o
. A :
: % getBalance]:float . _
1
' <% getld():String i,
emmssesmessssnans e

Let's now add a new operation which takes a parameter. We will also specify the parameter direction and type.

1. Press F8 to create another operation, collectAccountInfo().
Place the mouse cursor within the brackets and start typing "i". A drop-down list opens, allowing you
to select the parameter direction: in, inout, or out.

T S

Account

-

1

1

1

@1 balance:float=0 - o
. . |
id:5tring

@l g [

¥ wconstructors Account]
M getBalance(:float
<» getid(:String

PR -

3. Select "in" from the drop-down list, enter a space, and continue editing on the same line.
4. Enter "bankAPI" as parameter name and then a colon (: ). A drop-down list opens, allowing you to
select the parameter type.
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]
: : Account -
H
- 1@l balancefloat=0 |
_'_;@] id:5tring :_}
1
QJ-E ¢» «zconstructors Account( :_':'
. E\’} getBalance(:float :
1 <% getld():String 1
'\'} <<= > collectAccountinfolin hank_-ﬁ.F‘I:I : 5
L | * ]
| Type | Name Mamespace Si... |
| B AbstractMethodError  Java Lang:java:lang s
| B AccessControlContext Unknown Externals
B AccessibleCbject lava Lang:java:lang:re
B Account Design-phase:BankVie
[E] AnnotationPresets Java Profile
B ArithmeticException  Java Lang:java:lang W

5. Select IBankAPI from the drop-down list.

Adding a return type to an operation

So far, the operation parameter has been added, but it does not have a return type yet. To add a return type:
1.

2.

Place the mouse cursor after the close parenthesis character ")" and enter a colon (: ). A drop-down

list opens, allowing you to select a return type.

Press the "b" key and select boolean as data type.

. my -t
1 Account :
d I
. 1 I .
_ :@] balance:float=0 1
,;};EEH id:String :_}
] :ﬁ) zconstructors Account() :_t'
. V<> getBalance(:float ] _
_ V¢ getidp:String E _
. By <e>> collecthccountinfolin bank-‘-‘-.F‘I:IBanl'.:l'-.F‘I]:b|E:_.
. ESSSSssssssSSSssssSSSSSSSSSSsSSSss
1| Type MName Mamespace 5i...|
B AssertionErrar Java Lang:javaslang
B AssertionStatusDirectiv Java Lang::java:lang
B EBank Design-phase:BankVie
B EBankView Design-phase:BankVie
B BasicPermission Unknown Externals
[ @ boolean  Javabrotile g
I:I:|:| fig
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To specify an operation's \isibility (for example, "private", "protected”, "public"), click the icon preceding the
operation name, and select the required value, for example:

]

]

]

]

]

]

]

]

]

]

]

]

]

]

r .
]

] N
—=
-
]

Y -
]

]

]

]

]

]

]

]

]

]

]

]

]

]

JI

@"I balance:float=0
@‘I id:string

% getBalance(:float
g :String

1
1
L
1
1
1
1
—
1
g «CORSTIUCTOr= ACCOURNT|

“> tructors & t :—”
1
1
1
1
1

P M-

ountinfolin bank-*-.P'I:IEEanL‘.-'-‘-.P'I]:h-:u-:nI-sanE. 5
e

\?pmtected
' \?prhrate

The Visibility "package" is applicable for Java. In C#, use "package" to specify visibility as "internal". For
information about how UModel elements map to constructs in each language, see UModel Element
Mappings 23]

Changing icons to UML conformant symbols
The visibility icons can be changed to UML conformant symbols if necessary, as follows:

1. In the Styles window, select Project Styles from the top drop-down list.
2. Scroll down to the Show Visibility setting, and select UML Style.

Deleting and hiding class properties and operations from a Class diagram
Press F8 to add a dummy operation Operationl to the Account class.

To delete the dummy operation, select it and then press Delete. (Alternatively, right-click it and select Delete
from the context menu). A message box appears asking if you want to delete the element from the project.
Click Yes to delete operationl from the class diagram as well as from the project.

To delete the operation from the class in the diagram, but not from the project, press the Ctrl+Delete. This
hides the operation from the diagram, although it continues to exist in the project. Classes with hidden
members are displayed with an ellipsis ( ... ) character, as shown below:
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Account

gl balancefloat=0
g id:5tring

¥ wconstructors Account]

% getBalance(:float

<» getld(:5tring

% collecticcountinfolin bankAPLIBankAPl:boolean

A class with hidden operations

To unhide the operation, double-click the ellipsis at the bottom of the class. A dialog box appears where you
can choose the elements that should be \visible on the diagram, for example:

Vizible elements

Element Stules Attributes | k. |
Show Attributes @'1 balance:float=0
public protected @ | id:String Cancel
] Operations
private package Oy Account])
™ getBalance():float

Show Operations < getld(:String
El ublic atected % collectaccountinfolin bankaPlBankaPl:boolean

; ; [] <% Operation1()
private package Select Al
Show nested Classifier Select None

public protected YWhen new elements are added and not hidden by Element Styles

private package (®) Show elements

i) Hide elements [except thoze added ta thiz node]

"Visible elements" dialog box

It is possible to configure UModel not to display a message box when you attempt to delete an object from the
diagram, as follows:

1. On the Tools menu, click Options.
2. Click the Editing tab.
3. Under Ask before deleting from project, clear the in diagrams check box.
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Creating a composition association between the Bank and Account classes

1. Click the Composition *~ | toolbar button, and then drag from the Bank class to the Account class.

The class is highlighted when the association can be made. A new property (Propertyl:Account) is
created in the Bank class, and a composite association arrow joins the two classes.

Bank

@] bankname:5tring

@] IPAddress:5tring Account
;@] username:string L pal Floated

@] password:5tring L gﬂ .aan.CE' oat=0

@'1 Property1:Account . @] id:5tring

¥ xconstructors Bank(in name:String, in IP:String, in user:String, in pw:String) | . FFTOPEMY < «constructors Account(

» collectAccountinfosfin bankAPl:IBankAPl:boolean A GetBalanclEIJ:fl-Jat

& getBalanceOfAccounts(:int .. . . . | < getld:String

» getBankMame(:5tring S 3 collectAccountinfalin bankAP:IBankAP):boolean
'\) getlPAddress():5tring S e © © © © © © © © © © © ©° © © o o °
» getUsername():String

¢ getPassword(:5tring

2. Double click the new propertyl property in the Bank class and change it to "accounts”, being sure

not to delete the Account type definition (displayed in teal/green).

Press the End keyboard key to place the text cursor at the end of the line.

4. Enter the open square bracket character ([ ) and select asterisk ( * ) from the dropdown list. This
defines the muiltiplicity, namely, the fact that a bank can have many accounts.

w

Bank
@] bankname:5tring
g1 IPAddress:String Account
@] username:5tring L
rl @1 password:String D .balan_ce:flaat=.,-
g1 accounts:Account]¥] .. . . . |91 idstring
» =constructors Bank(in name:String, in IP:String, in user:String, in pw:string) | . Faccounts < wconstructors Account]
3 collectAccountinfos(in bankAP:IBankAP:boolean B ) getBaIanc.m].fI-:uat
¢} getBalanceOfAccounts(:int . . . . . | < getld]:String
» getBankMame(:5tring S 3 collectAccountinfalin bankAP:IBankAP):boolean
L :
& getlPAddress(:String e e e oeos s oe s
% getUsername():String
» getPassword(:5tring

Notice that the multiplicity range previously added to the diagram is also visible in the Properties
window:
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2.31

Properties 3 x
name accounts ~
qualified name Design-phase:BankView
element kind Property

visibility protected |
leaf ]

ordered ]

unigue

multiplicity * |
type Account |
type modifier n/a

static ]

readOnly |

I-:||-I . E v
=] Properties @ Styles El Hierarchy

Creating Derived Classes

This tutorial section illustrates the following tasks:

Note:

Add a new class diagram to the project

Add existing classes to a diagram

Add a new class to a diagram

Create derived classes from an abstract class, using generalizations.

It is assumed you have already followed the previous tutorial section, Class Diagrams , to create the
abstract class Account.

Creating a new Class Diagram

1.

In the Model Tree window, right-click the bankview package (under Root | Design-phase |
BankView | com | altova), and select New Diagram | Class Diagram.

2. Double-click the new "ClassDiagram1" entry, rename it to "Account Hierarchy", and press Enter to

confirm. The new "Account Hierarchy" diagram is now \isible in the working area.

Adding existing classes to a diagram

1.

In the Model Tree window, click the Account class in the bankview package (under com | altova |
bankview), and drag it into the diagram.
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Model Tree o x pkag bankview ]

Root M
-H Component View
- Deployment View
i Design-phase

i ] Overview Accoant
éw Banking access S
@& BankView - |=1 balancefloat=0
- [ Apply Java Profile L 'EJ] id:5tring
E‘ Ry com '\') sconstructor: Account()
E‘ - alt;:uak. <% getBalance(:float
LA W bankview > L
) > getld(:5tring
--------E;ccokuvr?t H|:1ra_rchy ¢» collectAccountinfolin bankAPl:IBankAPl:boolean
ankView Main

- [0 Sample Accounts
- B9 AltovaBank
- B John's Checking
E Account
-{# B Bank
- B BankView
-F B Checkingiccount
-F B CreditCardAccount
-E1 =% Relations
“E__, Assodation: [Account - Ban v
< >

EIM:::dEITrEE @DiagramTree {%‘Fav-:urites

2. Click the checkingaccount class (of the same package) and drag it into the diagram. Place the class
below and to the left of the account class.

3. Use the same method to insert the Creditcardaccount class. Place it to the right of the
CheckingAccount class.
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pkg bankview,|

Account

@] balance:float=0
@] id:5tring

&» =constructors Account()
% getBalancef):float
'C) getld(:5tring

% collectAccountinfolin bankAPLIBankaP:boolean

CheckingAccount

CreditCard Account

@] minimumEBalance:float=10000

» «constructors CheckingAccounti)
O  collectAccountinfolin bank&PlIBankAPl:boolean

&1
&l
&l

creditLimit:float
interestRateCnEBalance:float
interestRateCnCashAdvance:float

o
4
o
o
(4]

sconstructors CreditCardAccount(
getCreditLimit(:float
getinterestRateCnBalance():float
getinterestRateOnCashAdvance():float
collectAccountinfolin bankAPLIBankAP:boolean

Adding a new class

The third derived class, SavingsaAccount, will be added manually to the diagram.

1. Right-click the diagram and select New | Class. A new class is automatically added to the correct
package (bankview) which contains the current class diagram "Account Hierarchy".

N

Double-click the class name and change it to SavingsAccount.

3. Create the class structure as illustrated below. To add pro%rties and operations, use the methods
illustrated in the previous tutorial section, Class Diagrams .

SavingsAccount

g interestRate:float

¢» sconstructors SavingsAccount(
% getMinimumBalance[:float

3. Inthe Properties window, in the "code file name" text box, enter "SavingsAccount.java" to define the

Java code class.
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Properties o=
visibility public s
leaf Il
abstract Il
isFinalSpecialization ([
active Il
code file name 553vingsﬁ.ccount.java|
code file path
=annotations: Il
astatic Il
astrictfps |
W

=] Properties @Sty‘les ElHierarch}'

Properties and operations can be directly copied or moved from one class to another:

Within a class in the current diagram

Between different classes of the same diagram

In the Model Tree window

Between different UML diagrams, by dropping the copied data onto a different diagram.

This can be achieved using drag and drop, as well as the standard Copy/Paste keyboard shortcuts (Ctrl + C,

Ctrl + V), see also Renaming, Moving, and Copying Elements @ For the scope of this example, you can
quickly copy the collectAccountInfo () operation from the Account class to the new savingsAccount class,

as follows:

1. In the Model Tree window, expand the Account class.
2. Right-click the collectaAccountInfo operation and select Copy.
3. Right-click the savingsaAccount class and select Paste.

The operation is copied into the savingsAccount class, which is automatically expanded to display the new
operation.
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Model Tree

EandEITrEE @Diagram Tree |‘§¢r§ Favorites

B/ com
L3 v bankview

waltova

-------- [ Account Hierarchy
-------- [ BankView Main
-------- @ Sample Accounts
- B AltovaBank
- B John's Checking
--EE Account
........ §1 balance
-------- @ id
........ Qﬁccgunt
-@ O collecticcountinfo
@ ¥ getBalance
@ ¥ getld
- B Bank
-[F B BankView
‘E CheckingAccount
‘E CreditCardAccount
E‘E SavingsAccount

1 interestRate
i@ % collectAccountinfo
<% getMinimumBalance
b 3 SavingsAccount

W

The new operation is now also \isible in the savingsaAccount class in the class diagram.

Creating derived classes using generalization/specialization

At this point, the class diagram contains the abstract class, Account, as well as three specific classes.
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Account

g1 balancefloat=0
&1 id:tring

¥ wconstructors Account]
{» getBalance(:float
» getld]:String

<» collectAccountinfolin bankAPL:IBankAPI):boalean

CheckingAccount

CreditCardAccount

SavingsAccount

&1 minimumBalance:float=10000

&1 creditlimit:float

&» «constructors CheckingAccount()

4] collectAccountinfo(in bankAPEIBankAPl:boolean

@'1 interestRateCOnBalance:float
&1 interestRateOnCashAdvance:float

&1 interestRate:float

¢» wconstructors CreditCardfccount(

<» getCreditLimit():float

% getinterestRateOnBalance():float

4] getinterestRateOnCashAdvance(:float

<» collectAccountinfo(in bankAPl:IBankAPl:boolean

¥ =constructors SavingsAccount()
4] getMinimumBalance(j:float
¢» collectAccountinfolin bankAPl:IBankAPl):boolean

We will now create a generalization/specialization relationship between account and the specific classes (that
is, create three derived concrete classes).

N —

Click the Generalization

T

toolbar button and hold down the Ctrl key.
Drag from CreditCardaccount class and drop on the Account class.

3. Drag from the checkingAccount class and drop on the arrowhead of the previously created

generalization.

4. Drag from the savingsAccount class and drop on the arrowhead of the previously created
generalization: release the Ctrl key at this point.

Generalization arrows are created between the three subclasses and the Account superclass.

Account

balance:float=0
id:5tring

zconstructor: Account()

getBalance():float

getld(}:5tring

collectAccountinfofin bankA&PlIBankAPl:boolean

Ay

CheckingAccount

CreditCard Account

SavingsAccount

ance:float= 10000

g1

creditLimit:float

@'1 interestRate:float
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24 Object Diagrams

This tutorial section illustrates the following tasks:

e Combine class and object diagrams into one diagram

e Create objects/instances and define the relationships between them
e Format association/links

e Enter real-life data into objects/instances

To proceed, run UModel and open the BankView-start.ump project (see also Opening the Tutorial Proiectm).
The project includes a predefined object diagram "Sample Accounts"”, which will be used to illustrate the tasks
abowe.

Combining objects and classes into one diagram

In the Model Tree window, navigate to the following path: Root | Design-phase | BankView | com | altova |
bankview. Then double-click the icon next to the "Sample Accounts" diagram.

Bank

&1 bankname:5tring
@] IPAddress:String
@] username:5tring
@] password:5String
@] accounts:Account[*]

¢» «constructor= Bank(in name:String, in IP:String, in userString, in pw:String)
% collecthccountinfos(in bankAPLIBankaPl:boaolean

% getBalanceOfAccounts(int

% getBankMame():String

™ getiPaddress(:String

™ getUsername():String

% getPassword(:5String

AltovaBank:Bank =| @ [Johns Checking: CheckingAccount =
bankname = AltovaBank |~ T balance =
IPAddress = 1010427128 [ |id=
username = John Doe L minimumEBalance = 10,000,00
password = lodoe
accounts =

"Sample Accounts" diagram
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This object diagram combines both classes and instances of them (objects). Specifically, AltovaBank:Bank is
the object/instance of the Bank class, while John's checking: CheckingAccount is an instance of the class

CheckingAccount class (not yet added to the diagram).

Let's now add the missing Account class to the diagram, by dragging it from the Model Tree into the diagram.
Notice that the composite association between Bank and account is displayed automatically (this association

was defined in one of the previous tutorial sections, see Class Diagrams ).

Bank

bankname:string
IPAddress:5tring
username:string
password:5tring
accounts:Account[®]

aconstructors Bank(in name:5string, in [F
collectAccountinfos(in bankAPLIBEankAP
getBalanceOfAccounts(iint
getBankMame():5tring
getlPAddress():5tring
getUsernamef):5tring
getPassword(:5tring

Account

@l

balance:float=0
idi5tring

:#a:ccn:un:ts &

s | O
&
&

wconstructor: Account(
getBalance():float
getld(}:5tring

collectAccountinfolin bankAPLIEa

Adding a new object/instance (Approach 1)

Let's now add a new object to the diagram, called John's credit. This object will instantiate the
CreditCardAccount class.

1.

Click the InstanceSpecification

[

AltovaBank: Bank E

toolbar button, and then click inside the diagram, below the
object John's Checking: Checking Account.

2. Change the name of the new instance to John's Credit, and press Enter.

John's Checking: Checki

count &

bankname = AltovaBank
IPAddress = 10,10,127.128
username = lohn Doe
password = Jlodoe
accounts =

balance =
id =

v

minimumEBalance = 10,000,

| John's Credit: |

: =L 1
. ';i-—---.--p-.-qw.

3. Select the new instance to display its properties in the Properties window.
In the Properties window, next to "classifier", select CreditCardAccount from the drop-down list.

4.
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Properties o X
name Jlohn's Credit

qualified name Design-phasenBankView::c
element kind Instancespecification
visibility public ol
classifier CreditCardAccount hdl
specification

[=] Properties @Sty‘les @Hierarch}'

The instance has now changed appearance to display all properties of the class. Double-click any
property to enter a value, for example:

John's Credit: CreditCard Account E-‘

[}
o1
—
]

nnnnn

1
1
1
i
W
pid = o
! creditlimit = :
: interestRateCnBalance = :

1
: interestRateCOnCashAdvance = 1
To show or hide specific nodes, right-click the instance and select Show/hide node content (Ctrl+Shift+H)
from the context menu.

Adding a new object/instance (Approach 2)

We will now add a new instance of the class savingsaccount, this time using a different approach:

1. Inthe Model Tree window, right-click the bankview package, and select New element |
InstanceSpecification.

2. Rename the new instance to John's Saving, and press Enter to confirm. The new object is added to
the package and sorted accordingly.

© 2017-2023 Altova GmbH Altova UModel 2024 Professional Edition



48 UModel Tutorial Object Diagrams

Model Tree o =

[ Banking access ~
3 & BankView
........ [ Apply Java Profile
-A[ w7 com

E| o altova

@[ bankview

........ Hhccnunt Hierarchy
........ [ BankView Main
-------- [@ sample Accounts
E AltovaBank
g Jlohn's Checking
- Y John's Credit
........ [ John's 5aving
- B Account W

EIMndeI Tree @Diagram Tree |{% Favaorites

3. While the object is still selected in the Model Tree window, select SavingsAccount next to
"classifier" in the Properties window.

Properties 3 X
name John's Saving

qualified name Design-phasenBankView::c
element kind Instancespecification
visibility public il
classifier Savingsiccount hdl
specification

[=] Properties @ Styles | EI Hierarchy

4. Drag the object John's saving from the Model Tree window into the diagram, placing it below the
object John's Credit.

John's Credit: CreditCardAccount B

balance = S995%9

id =

creditLimit =
interestRateCnBalance =
interestRateOnCashAdvance =

:Jnhri‘sSavi Savil nt E:
4 :
:balance = —
:id = :
! interestRate = : .
II """"""""""" B
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Creating links between objects

Links are the instances of class associations, and describe the relationships between objects/instances at a
fixed moment in time.

1. Click the existing link (association) between the object AltovaBank: Bank and the object John's
Checking: CheckingAccount.

2. In the Properties window, next to "classifier", select the entry Account - Bank. The link now changes
to a composite association, in accordance with the class definitions.

AltovaBank;Bank =| @ [)ohn's Checking: Checki count &
bankname = AltovaBank _I S a:ccc-:un:ts balance =
IPAddress = 1010127128 lid=
username = John Doe ... . . . . . . . . . |minimumBalance = 1000000
password = lodoe
accounts =
3. Click the InstanceSpecification = toolbar button, and position the cursor over the object John's

Credit: CreditAccount. The cursor now appears as a + sign.

4. Drag from the object John's Credit: CreditAccount t0 AltovaBank: Bank to create a link between
the two.

5. In the Properties window, next to "classifier", select the entry Account - Bank.

6. Finally, using the methods outlined abowve, create a link between the object A1tovaBank: Bank and the
object John's Saving: SavingsAccount.

AltovaBank:Bank =| [ John's Checking: Checki count B

bankname = AltovaBank . " accounts | balance =

IP&ddress = 10,10.127.128 . . id =

username = lohn Doeg . | minimumBalance = 10,000,00
password = lodoe

accounts = S

- John's Credit: CreditCardAccount E

. . . . . . . . . . . . . . . . . . . ECCCrLIﬂtE

id =

creditLimit =
interestRateCnBalance =
interestRateCnCashAdvance =

John's Saving: Savi count &

balance =
accounts | jd =

interestRate =

Note that changes made to the association type in any class diagram are automatically updated in the object
diagram.
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Formatting association/link lines in a diagram

To format links between objects, place the cursor on the line and drag to the desired position. To reposition the
line both horizontally and vertically, drag the corner waypoint, as illustrated below.

AltovaBank; Bank & |

b

John's Checking: Checki count &

bankname = AltovaBank

username = John Doeg
password = Jodoe
accounts =

IPAddress = 10,10.127.128 pgpe——— o

_accounts

balance =
id =
minimumEBalance = 10,000,000

>

Waypoint

Links in an object diagram

Entering sample data into objects

- accounts

: % balance =

accounts

John's Credit: CreditCardAccount E

id =
creditLimit =
interestRateCnBalance =

interestRateCOnCashAdvance =

John's Saving: Savi count &

id =
interestRate =

The instance value of an attribute/property in an object is called a slot. To describe the state of an object,
double-click the slots and enter sample instance data after the "=" character, for example:
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AltovaBank: Bank E

John's Checking: Checki nt &

bankname = AltovaBank

username = lohn Doe
password = Jodoe

IPAddress = 10,10.127.125 uge

_accounts

balance = 11,975.00
id=1
minimumBalance = 10,000,000

accounts = -

- accounts

John's Credit: CreditCardAccount B

balance = 82.00

id= 2

creditLimit = 7500.00
interestRateCOnBalance = 1
interestRateCnCashAdvance = 1.5

John's Saving: SavingsAccount B

accounts

balance = 8,743.00
id= 3
interestRate = 1.2

Object slots can also be filled from the Properties window, by selecting the object and entering the appropriate

text next to "value", for example:

Properties

element kind Slot
definingFeature balance
value 3,743.00

[=] Properties @ Styles | EI Hierarchy
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2.5 Component Diagrams

This tutorial section illustrates the following tasks:

e Create realization dependencies between classes and components

e Change the appearance of lines used in the diagram
e Add usage dependencies to an interface
e Use "ball-and-socket" interface notation

To proceed, run UModel and open the BankView-start.ump project (see also Opening the Tutorial Proiect@).
The project includes sewveral predefined object diagrams which will be used to illustrate the tasks abowe. It is
assumed you have already followed the tutorial section Creating Derived Classes ® to create the class

SavingsAccount.

Creating realization dependencies between classes and components

In the Diagram Tree window, expand "Component Diagrams", and double-click the "BankView realization"
diagram icon. This diagram already contains the Bankview component and several classes connected to it with
dependencies of type "ComponentRealization". The text "from bankview" inside each class indicates the name

of the package where the class belongs.

pkg Ban kKView | .

=

scomponents £ ﬁea.llza.tlcfnz.»
BankView

g &Réalfigtinn'in'

«Realizationd». . ..
B
SEl 1‘\

BankView
[from bankview]

- =Realization]x.-

Bank
[from bankview)

[from bankview)

CheckingAccount |

CreditCard Account
[from bankview)

"Bank View realization" diagram

Let's now add a new class to the diagram and also create a realization dependency between the new class and

the Bankview component.
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1. Inthe Model Tree window, locate the savingsaAccount class in the bankview package. If this class is
missing, follow the tutorial section Creating Derived Classes & to create it first.
2. Drag the savingsAccount class from the Model Tree into the diagram.

By default, the class is displayed with all compartments expanded. Click the collapse/expand icons to the left
of the class to show or hide properties and operations.

Collapse/Expand S j‘ o
icons S P M
o SavingsAccount |

To create a realization dependency between the class and the component, do one of the following:

e Click the Realization toolbar button and drag from the savingsaAccount class to the Bankview
component.
e Movwe the cursor over the "ComponentRealization" handle of the class and drag to the BankView
component.
R R

I;:)_:Saﬁngsﬁttﬂllnt ]

"ComponentRealization"
Handle

The realization dependency between savingsAccount and BankView has now been created.
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pkg BankView.
BankView
- RealizationTs.- [from bankview)
R i ﬁea’lizatidnh Bank

R components ] i) n
. T L. BankView T [from bankview)

1
P . . . . . P '.". . . . . .

! Y .
':' «Réalization3a
Ly 8 o o ke .
- I . . . . i’ K

. b
e «Realizafiond=. . . e
. : _!- _'-___‘l‘ .

. L. o 'y .
SavingsAccount | : 1 |CheckingAccount |
[from bankwview) | . . . . . ... | [from bankview]
CreditCard Account
[from bankview)

To give a name to the new dependency line (for example, "Realization5"), first select the line, and then start
typing its name directly. Alternatively, select the line, and then edit the Name property in the Properties
window.

Changing the appearance of diagram lines
Let's now change the line appearance from "curved" to "direct line", as follows:

1. Select the line created previously (that is, the one between savingsAccount and BankView).

/

2. Click the Direct Line toolbar button.

Adding usage dependencies to an interface

1. In the Model Tree window, navigate to Root | Design-phase and double-click the icon next to the
"Owveniew" diagram. The "Overview" component diagram is opened and displays the currently defined
system dependencies between components and interfaces.
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pkao Design-phase .J,

cinterfaces
IBankAPI

[from EankAPl)

QP
D
o
o
o
O
O
]
]
4]
QP
D
D
o
o

connect(in IPAddress:5tring):boolean

login(in username:5tring, in password:5tring):boolean
disconnect(ivoid

getMinimimBalance(in nAccountMrint):float
getNrOfAccounts(iint

getAccountlD{in nAccountMriint):5tring
getAccountBalance(in nAccountMrintl:int
getdccountLlimit(in nAccountMrint):int
isCheckingAccount(in nAccountMrintp:boolean
isSavingsAccount(in nAccountNrinti:boolean
isCreditCardAccount(in nAccountNrint:boolean
getinterestRate(in nAccountMrint):float
getCreditLimit(in nAccountNrint:float
getinterestRateOnBalance(in nAccountMrint).float
getinterestRateCOnCashAdvance(in nAccountMrint):float

scomponents ]

Bank API client

[from Banking access)

2. In the Model Tree window, navigate to Root | Component View | BankView and drag the Bankview
GUI package into the diagram.
3. Also drag the Bankview package into the diagram.

u
4. Click the Usage * |toolbar button and drag from the Bankview GUI package to the 1BankaAPI
Interface.
pkg Design-phase J_
«interface=
IBankAP]
[from BankAPl)
- =COmponents |
¥ connect(in IPAddress:String):boolean P — Bank AP client
'\) login(in username:String, in password:String):boolean {from Banking access)
» disconnect(:void
¥ getNrOfAccounts(iint
t\) getAccountIDiin nAccountMrint):String
«COmMponents » getAccountBalance(in nAccountirint)int
Banlt\ﬁewﬁﬂl t\) getAccountlimit(in nAccountMrinthint
(EID TS t\) isCheckingAccount(in nAccountMrint:boolean

t\) isSavingsAccount(in nAccountirintj:boolean

t\) isCreditCardAccount(in nAccountMrinti:boolean
t\) getMinimimBalance(in nAccountMrint):float

t\) getinterestRate(in nAccountMrint):float

R) getCreditlimitin nAccountirint):float

R) getinterestRateOnBalance(in nAccountNrint):float

"\> getinterestRateOnCashAdvance(in nAccountMrint):float

5. Repeat the previous step for the package Bankview.

© 2017-2023 Altova GmbH

Altova UModel 2024 Professional Edition



56 UModel Tutorial Component Diagrams

As illustrated below, both packages now hawve a usage dependency to the interface. Namely, the 1BankaPT
interface is required by the packages Bankview and Bankview GUI. As for the package Bank APT Client, it
provides the interface.

pkag Desrgn-phaseJ_
cinterfaces
IBankAP1
[from Bank&Pl)
scomponents 2] :“u.sﬂ; } - afomponents |
BankView e ¢» connectiin IPAddress:String):boolean ] Bank APl dlient
{from BankView] - C) loginfin username:5tring, in password:5tring):boolean {from Banking access)

¢» disconnect(j:void
. . . | <» getNrOfAccounts(iint
scomponents E] [ Lyusen <» getAccountiD(in nAccountNrint):String

BankView GUI R ¢» getAccountBalance(in nAccountNrint):int
[from BankWiew) A k)

getAccountlimit(in nAccountMrintlint

C} isCheckingAccount(in n&ccountMrint):boolean

\) isSavingsAccount(in nAccountMrinti:boolean

\) isCreditCardAccount(in nAccountMrinthboolean

\) getMinimimBalance(in nAccountMrint):float

\) getinterastRatefin nAccountMrint):float

\) getCreditLimitin nAccountMrint:float

\) getinterastRateCOnBalance(in nAccountMrint):float

k) getinterestRateOnCashAdvance(in nAccounthrint):float

Using "ball-and-socket" notation
Optionally, it is possible to convert the current diagram notation to "ball-and-socket" style notation, as follows:

e Select the interface, and then click the Toggle Interface Notation button in its lower-right corner.
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[from BankaPl)

]

]

]

]

]

]

]

]

]

]

]

]

]

y
' .
]
—
]
M.
]

]

]

]

]

]

]

]

]

]

]

]

]

]

]

]

]

[ ]

=zinterface=
IBankAPl

ool

o
&
&
&
&
&
&
&
o
&
&
&
&
&
&

ad

i

e

""""""""" g e =

connect(in IPAddress:String):boolean

login(in username:String, in password:String):boolean
disconnect(l:void

getNrOfAccounts(iint

getAccountiD{in nAccountMrint):5tring
getAccountBalance(in nAccountMrintlint
getdccountlimit{in nAccountMrint)int
isCheckingAccount(in nAccountMrint:boolean
isSavingsdccount(in nAccountMrinti:boolean
isCreditCard&ccount(in nAccountMrinti:boolean
getMinimimBalance(in nAccountMrint):float
getinterestRate(in nAccountMrint):float
getCreditLimit(in nAccountMrintlfloat
getinterestRatenBalance(in nAccountMrint):.float
getinterestRateOnCashAdvance(in nAccountMrint):float

e eg——— g [

E

Toggle interface

notation
The diagram has now changed to "ball-and-socket" notation.
pkog De-sTgn-phas-e,J. o
ccomponents I
BankView
[from BankView) L
[BankAPl | scomponents £]
Q Bank APl client
(from Banking access)

ccomponents I
BankView GUI
[from BankView])

To switch back to the previous notation style, select the interface, and then click the Toggle interface
notation button again.
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2.6 Deployment Diagrams

This tutorial section illustrates the following tasks:

Add a dependency between two artifacts in a Deployment diagram

Add elements to a Deployment diagram

Embed artifacts into a node in a Deployment diagram

Creating artifact elements (for example, properties, operations, nested artifacts)

To proceed, run UModel and open the BankView-start.ump project (see also Opening the Tutorial Proiect‘B
).

Adding a dependency between two artifacts in a Deployment diagram

In the Diagram Tree window, under "Deployment Diagrams", double-click the icon next to the "Artifacts"
diagram to open it. As illustrated below, this diagram shows the manifestation of the Bank aPI client and the
BankView components, to their respective compiled Java .jar files.

pkg Deployment ‘ufl'ew) L

wCOMmponents | .
Bank APl cient | . cmanifests  foapifad. O
[from Banking access) | . . . . . . . . . BankAPljar

scomponent= 2 (
BankView . . “manifeste |arifacs [
[from BankView) o BankView.jar

"Artifacts" diagram

These manifestations were created using a technique similar to other relationships previously illustrated in this
tutorial, as follows:

1. Click the Manifestation toolbar button.
2. Mowe the mouse cursor over the artifact and drag into the component.

Using the same technique, let's also add a dependency between the two .jar files, as follows:

..... -

1. Click the Dependency toolbar button.
2. Mowe the cursor over the Bankview.jar artifact and drag into the BankaPI.jar artifact.
3. Select the dependency line and type "Dependency?2".
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=COMponents 3
Bank APl cient | . cmanifests  foogifag. Oy
[from Banking access) o BankAPLjar

T

" «Dependency?=

«=component= 21
BankView R oc.ma.mf.est.n. . |=artifact= [H
[from BankView) .. . . . . . . . . | BankView.jar

Adding elements to a Deployment diagram

In the Diagram Tree window, under "Deployment Diagrams", double-click the icon next to the "Deployment”
diagram to open it. This diagram is deliberately incomplete and consists of a single node, which represents a
home PC. In the following steps, we will be adding more elements to this diagram.

pkag Deplo}.rment‘u’im/l_ o

Home PC

"Deployment” diagram

Assuming that the goal is to illustrate a TCP/IP connection between the home PC and a bank, let's add the
required elements:

1. Click the Node =) toolbar button, and click right of the Home PC node to insert it.
2. Rename the node to "Bank", and drag one of its edges to enlarge it.
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Home PC

3. Click the Dependency toolbar button, and then drag from the "Home PC" node to the "Bank"
node. This creates a dependency between the two nodes.
4. Select the dependency line and enter "TCP/IP" as name of the new dependency. (Alternatively, edit the

Name property in the Properties window).

Home PC

wTCR/IP= *

Bank

Embedding artifacts

In the Model Tree window, expand the "Deployment View" package, and then drag all of the following artifacts
into the diagram: BankAddresses.ini, BankAPIl.jar, and BankView.jar. The project is preconfigured to
include deploy dependencies between these artifacts and the "Home PC" node, so all these dependencies are

now \visible in the diagram:
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Home PC
e
edegdloy= - - - - edegloys- - - «deploy= -
sartifact= ™ sartifact» [ sartifact= [
BankAddresses.ini BankView.jar |. BankAPLjar

You can also embed the artifacts into the "Home PC" node, by dragging each of the artifacts into it. Notice that
the deploy dependencies are no longer \isible on the diagram, although they continue to exist logically.

Home PC
aartifacts Oy
BankAddresses.ini . Bank
. «TCP/IPs "
=artifact= [ e
BankView.jar
iy
0 adeqllny
]
T .
! cartifacts !
o ) Lo
. 1 BankAPLjar .
L N

Artifacts embedded into the node can also have dependencies between them. To illustrate this:

"BankView.jar" artifact into the "BankAddresses.ini".
2.  While holding the Ctrl key pressed, drag from the "BankView.jar" artifact into the "BankAPI.jar"
artifact.
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Home PC

wartifact=
BankView.jar

O

i

Wi

- TCRAPs

wartifact= ™
BankAddresses.ini

cartifacts= [0
BankAPLjar

Bank

Note: Dragging an artifact out of a node onto the diagram always creates a deployment dependency

automatically.

Creating artifact elements (properties, operations, nested artifacts)

In UML, artifacts can be composed of properties, operations, and other elements, including nested artifacts. To
create such nested elements, right-click the artifact in the Model Tree window and select the appropriate
action from the context menu (for example, New Element | Operation, or New Element | Property). The new

element will appear nested below the selected artifact in the Model Tree window.
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2.7 Forward Engineering (from Model to Code)

This example illustrates how to create a new UModel project and generate program code from it (a process
known as "forward engineering"). For the sake of simplicity, the project will be very simple, consisting of only
one class. You will also learn how to prepare the project for code generation and check that the project uses
the correct syntax. After generating program code, you will modify it outside UModel, by adding a new method
to the class. Finally, you will learn how to merge the code changes back into the original UModel project (a
process known as "reverse engineering").

The code generation language used in this tutorial is Java; however, similar instructions are applicable for other
code generation languages.

Creating a new UModel project
You can create a new UModel project as follows:

¢ On the File menu, click New. (Alternatively, press Ctrl+N, or click the New toolbar button.)

At this stage, the project contains only the default "Root" and "Component View" packages. These two
packages cannot be deleted or renamed. "Root" is the top grouping level for all other packages and elements in
the project. "Component View" is required for code engineering; it typically stores one or more UML
components that will be realized by the classes or interfaces of your project; howewver, we didn't create any
classes yet. Therefore, let's first design the structure of our program, as follows:

1. Right-click the "Root" package in the Model Tree window and select New Element | Package from
the context menu. Rename the new package to "src".

2. Right-click "src" and select New Element | Package from the context menu. Rename the new
package to "com"

3. Right-click "com" and select New Element | Package from the context menu. Rename the new
package to "nanonull".

4. Right-click "nanonull" and select New Element | Class from the context menu. Rename the new class
to "MyClass".

Model Tree b4

_|Root
o Component View
EE| SrC
E"L:J com
§.E| nanonull
] B MyClass

EI Model ... BB Diagra... %:% Favaorites

Preparing the project for code generation
To generate code from a UModel model, the following requirements must be met:
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e A Java, C#, or VB.NET namespace root package must be defined.

e A component must exist which is realized by all classes or interfaces for which code must be
generated.

e The component must have a physical location (directory) assigned to it. Code will be generated in this
directory.

e The component must have the property use for code engineering enabled.

All of these requirements are explained in more detail below. Note that you can always check if the project
meets all code generation requirements, by validating it:

e On the Project menu, click Check Project Syntax. (Alternatively, press F11.)

If you validate the project at this stage, the Messages window displays a validation error ("No Namespace Root
found! Please use the context menu in the Model Tree to define a Package as Namespace Root"). To resolve
this, let's assign the package "src" to be the namespace root:

¢ Right-click the "src" package and select Code Engineering | Set As Java Namespace Root from
the context menu.

e  When prompted that the UModel Java Profile will be included, click OK.

Utodel ot

This command will include the UModel Java Profile and apply it to the
selected Package.
Do you want to continue?

QK Cancel

Notice the package icon has now changed to =71, which signifies that this package is a Java namespace root.
Additionally, a Java Profile has been added to the project.

Model Tree x

Roat
-------- Compaonent View
B & src
E| com
EE| nanonull
E B MyClass
= Relations

-[# [+7] Java Profile [lava Profile.ump]

E| Model T..| = Diagram... %% Favorites

The actual namespace can be defined as follows:

1. Select the package "com" in the Model Tree window.
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2. In the Properties window, enable the <<namespace>> property.

Properties b
name com

qualified name SFCCOm

element kind Package

visibility public dl
LR

«Mamespaces

=] Properties @I Styles EI Hierarchy

3. Repeat the step above for the "nanonull" package.

Notice that the icon of both "com" and "nanonull" packages has now changed to %!, which indicates these are
now namespaces.

Another requirement for code generation is that a component must be realized by at least a class or an
interface. In UML, a component is a piece of the system. In UModel, the component lets you specify the code
generation directory and other settings; otherwise, code generation would not be possible. If you validate the
project at this stage, a warning message is displayed in the Messages window: "MyClass has no
ComponentRealization to a Component - no code will be generated". To solve this, a component must be
added to the project, as follows:

1. Right-click "Component View" in the Model Tree window, and select New Element | Component from

the context menu.
2. Rename the new Component to "nanonull".

Model Tree b4

Root
2 JComponent View
- £ ] nanonull
3=

El " com
EE| ~nanonull
: B MyClass
5..;}¢;Ff-':l_=.t|-:-n:-

-[H [+« 7] Java Profile [Java Profile.ump]

EIM::dEITr... EDiagram... %'%Fat-‘-:urites

3. Inthe Properties window, change the directory property to a directory where code should be
generated (in this example, "src\com\nanonull"). Notice that the property use for code engineering
is enabled, which is another prerequisite for code generation.

© 2017-2023 Altova GmbH Altova UModel 2024 Professional Edition



66 UModel Tutorial Forward Engineering (from Model to Code)

name nanonull

Javad.0 {1.9) Ll
srovcominanonull

use for code engineering

=] Properties @I Styles EI Hierarchy

4. Save the UModel project to a directory and give it a descriptive name (in this example, C:
\UModelDemo\Tutorial.ump).

Note: The code generation path can be absolute or relative to the .ump project. If it is relative as in this
example, a path such as src\com\nanonull would create all the directories in the same directory
where the UModel project was saved.

We have deliberately chosen to generate code to a path which includes the namespace name; otherwise,
warnings would occur. By default, UModel displays project validation warnings if the component is configured to
generate Java code to a directory which does not have the same name as the namespace name. In this
example, the component "nanonull" has the path "C:\UModelDemo\src\com\nanonull", so no validation
warnings will occur. If you want to enforce a similar check for C# or VB.NET, or if you want to disable the
namespace validation check for Java, do the following:

1. On the Tools menu, click Options.
2. Click the Code Engineering tab.
3. Select the relevant check box under Use namespace for code file path.

The component realization relationship can be created as follows:

¢ In the Model Tree window, drag from the MyClass created previously and drop onto component
nanonull.
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Model Tree

O Info:

Drop will add ComponentRealizations to the Component

Root
B Compo

H = s

El w | COm

E E--L:_l w | nanonull

: P B MyClass
E--?&;F{-’:L‘ltiﬂl'l‘.’-

& [« Java Profile [Java Profile.ump]

ElMCIdElTrEE EDiagramTree %}Fam-‘-:urites

The component is now realized by the project's only class MyClass. Note that the approach abowe is just one of
the ways to create the component realization. Another way is to create it from a component diagram, as
illustrated in the tutorial section Component Diagrams.

Next, it is recommended that the classes or interfaces which take part in code generation have a file name.
Otherwise, UModel will generate the corresponding file with a default file name and the Messages window will
display a warning ("code file name not set - a default name will be generated"). To remowve this warning:

1. Select the class MyClass in the Model Tree window.
2. In the Properties window, change the property code file name to the desired file name (in this
example, MyClass.java).

Properties x
name My Class

qualified name sroicomananonull:byCl
element kind Class

visibility public il
leaf ]

abstract ]

isFinalspecialization [

active ]

code file name MyClass.java

code file path ChUModelDemotsroico
«annotationss ]

wstatics ]

astrictfps I

=] Properties @I Styles EI Hierarchy

Including the JDK types

Although this step is optional, it is recommended that you include the Java Development Kit (JDK) language
types, as a subproject of your current UModel project. Otherwise, the JDK types will not be available when you
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create the classes or interfaces. This can be done as follows (the instructions are similar for C# and VB.NET):

1. On the Project menu, click Include Subproject.
2. Click the Java tab and select the Java JDK 9 (types only) project.

Include Subproject

Bazsic CH Java Ok

PS
@ ava JDK 9 (types only).ump Cancel

@ Java IDK 8 (types onlyl.ump
@ Java IDK 7 (types onlyl.ump
@ lava IDK & (types onlyl.ump
@ Java DK 5.0.ump

Mo ( WP PP v I Browse. .. I

Description:
Containg acceszible packages: and types from fram Sun Jawva SE 9 far
Java 3 [without operations and properties).

3. When prompted to include by reference or as a copy, select Include by reference.

Include Subproject

K.ind of include

(®)nclude by reference; Store a reference ta the original data of your subpraject.
Include subproject elements: E ditable Fieadonly

() Include as a copy: Store a copy of the ghared data of your subproject in wour kodel
project file. References to the onginal data will be lost,

Styles of included diagrams
Fetain styles: Included diagrams will appear as defined in their subproject.

IJze project file shyles: Diagrams will uze curent project file stules.

|Java'3.[l"-.] ava 0K 9 [lwpes anly].ump
kake path relative to Lk odelT utonial ump Cemee

Generating code
Now that all prerequisites have been met, code can be generated as follows:
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1. On the Project menu, click Merge Program Code from UModel Project. (Alternatively, press F12.)
Note that this command will be called Overwrite Program Code from UModel Project if the
Overwrite Code according to Model option was selected previously on the "Synchronization
Settings" dialog box illustrated below.

Synchronization Settings

Code from Model  Model from Code
SPL templates
|User-defined ovemde default

When deleting Code

(® Comment out () Delete
Synchronization

(®) Merge Model into Code

() Overwrite Code according to Model

[litsheaps show dislog when synchronizing

Project Settings Cancel

2. Leawe the default synchronization settings as is, and click OK. A project syntax check takes place
automatically, and the Messages window informs you of the result:

Messages x
W v|al vjal wlal O)GE X

Bl starting Syntax Check ...
H— .. finished Syntax Check - 0 error(s), 0 warning(s)

Bl starting update code from project ..
i Collecting source files in "ChUModelDematsrdcominananull’

Parsing file: "C\UModelDemosrcicomnanonullMyClass.java'

Resolving type references
---------- w finished update code from project - 0 error(s), 0 warning(s)

Modifying code outside of UModel

Generating program code is just the first step to developing your software application or system. In a real life
scenario, the code would go through many modifications before it becomes a full-featured program. For the
scope of this example, open the generated file MyClass.java in a text editor and add a new method to the
class, as shown below. The MyClass.java file should look as follows:

package com.nanonull;
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public class MyClass{
public float sum(float numl, float num2) {
return numl + num?2;

}

MyClass.java

Merging code changes back into the model
You can now merge the code changes back into the model, as follows:

1.  On the Project menu, click Merge UModel Project from Program Code (Alternatively, press Ctrl +
F12).

Synchronization Settings

Code from Model Meodel from Code

Synchronization
(@ Merge Code into Model

() Overwrite Model according to Code

[litsheaps show dislog when synchronizing

Froject Settings Cancel

2. Leawe the default synchronization settings as is, and click OK. A code syntax check takes place
automatically, and the Messages window informs you of the result:

Messages x
W v|a v]al vlal O)GE X
I:Tlﬂtarting update model from code ... &~

[ Collecting source files in "C\UModelDema'sreycomnanonull®

Parsing file: "Ch\UModelDemotsroicominanonull My Class java’

Resolving type references

fr— .. finished update model from code - 0 error(s), O warning(s) -

The operation sum (which has been reverse engineered from code) is now \visible in the Model Tree window.
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[Root

2/ | Component View
E--E_|$:| nananull
:’:; Relations
H Ev‘]Jaua IDKE 9 [types only) [Java JOK S [types only
BB sre
B[ com
E-EH‘]nannnull

- < return
-@ = Relations
S| F‘q]aua Profile [Java Profile.ump]

4 [ g

EI Model Tree | Diagram Tree | {E‘ Favarites
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2.8 Reverse Engineering (from Code to Model)

This tutorial section illustrates how to import existing program code from a directory into a new UModel project
(reverse engineering). You will also add a new class into the model, prepare it for code generation, and then
merge changes back into the Java code (forward engineering). Although this tutorial illustrates importing Java
code, the process is similar if you would like to import existing C# or VB.NET code.

Note: The sample Java code used in this tutorial is available as a ZIP archive at the following path: C:
\Users\<username>\Documents\Altova\UModel2024\UModelExamples\OrgChart.zip. Please
unzip the archive to the same directory before starting the tutorial.

Importing existing code from a directory

1. On the File menu, click New.

2. On the Project menu, click Import Source Directory.

3. Select the language of the source code (in this example, Java).
4

Click the Browse button U , select the OrgChart directory unzipped previously, and click Next. Notice
the Enable diagram generation check box is selected, which instructs UModel to generate Class
Diagrams@ and Package Diagrams@ from the source code.

Import Source Directory >

Language: |Javal.0(1.8) e

Dlirectony: |C:"-._LIsers"-.ahu:uva"—..Du:uu:umerdS"-.}-‘-.Itwa"-._LlMu:udeIEmI w

Process all subdirectores
Import directories relative to UModel project file

Java Project Settings
[]JavaDocs a= Documentation

Resolve aliases

Synchronization
(@) Merge Code into Model
() Owerwrite Model according to Code

Diagram generation

Enable diagram generation

< Back Mest = Cancel

5. Select the Generate diagram per package option. This instructs UModel to create a new diagram
for each package. The diagram styling options can be changed later if necessary.
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Content Diagram Generation >

Content diagrams

Style
[ ] Show Attributes compartment

[ |iSenerate single diagram;

(Generate diagram per package

[Jopend [] Show Operations compartment
pen diagrams

[ ] Show nested Classifiers compartment
[] Show nested classfiers separately
[ ] Show EnumerationLiterals compartment
[] Show Tagged Values

Ise own compartment for MET properties

[] Show anonymous bound elements
Hyperink package(s) to diagramis)

Show MNET properties compartment

Autolayout
Autolayout
hierarchic w
< Back Mest = Finish Cancel

6. Click Next to continue. This dialog box allows you to define the package dependency generation
settings.
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Package Dependency Diagram Generation >

Package dependency diagram

S . Style
GGenerte diagram:

Fill color of extemal packages:
[ ] Open diagram " | |

St
[ lgnore extemal packages
{nat child of impart target)

Hyperink package to diagram Autolayout

Autolayout

hierarchic w

< Back Next 3 Cancel

7. Click Finish. When prompted, save the new model to a directory on your system. The data is parsed,
and a new package called "OrgChart" is created.

Maodel Tree »

_|Foot

Component View

[@[% | OrgChart

D Unknown Externals

E.D Jawva Profile a Profile.umnl

T
[u1]
=1]

.
(=]

[

F1Model ... | = Diagra... | # Favorites

8. Expand the new package and keep expanding the sub packages until you get to the OrgChart
package (com | OrgChart). Double-click the "Content of OrgChart" diagram icon:
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Model Tree 4

Root
H Component View
= & OrgChart
-------- [ Content of OrgChart
-------- ﬁPackage dependencies of OrgChart
-E wcom
........ [ Content of com
- | w7 altova
-B w1 CrgChart
........ [ Content of OrgChart
- | wipo
-F EH CompanylogoType
-F E Desclype
-[F E DivisionType
-[F E emailType
-[# E FirstType
[ B OfficeType
-[H B COrgChartDoc
- B CraChartType
-[# E PersonType
-[# B PersonType2
- B TextType
~[#| v OrgChartTest
-@ = Relations
o] Unknown Externals

[ [« 7] Java Profile [Java Profile.ump]

E|M::udEITrEE @Diagram Tree| 3§ Favorites

The "Content of OrgChart" diagram is now displayed in the main pane.
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pkg -DrgChart,J

] | . |DescType
«Namespacex
ipo

[CompanylogoType | [DivisionType

[emailtype | [Firstiype | :

OrgChartDoc |  [OrgChartType | [TextType |

Adding a new class to the OrgChart diagram

At this stage, you have fully reverse engineered some existing Java code and created a model out of it, which
also includes sewveral automatically generated diagrams. We will now go one step further, and extend the model
to include a new class.

1. Right-click inside the "Content of OrgChart" diagram, and then select New | Class from the context
menu.
2. Click the header of the new class, and enter CompanyType as the name of the new class.

pkg OrgChart -
[7] | | DescType
«famespacex
ipo
A P n
01_; CompanyType| E;_,
. = o
[CompanylogoType | . [DiwisionType | e
[emailType |~ [FirstType | [OfficeType |
e
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3. Add new operations to the class using the F8 shortcut key. For the purpose of this example, add the
following operations: CompanyType (), getCompanyType () : String, setCompanyType () : String.

L} u
: F;' CompanyType -E :
= .
'3':': » «constructors CompanyType() g
’ ] <» getCompanyType(:5tring '
: % setCompanyType():String : _
SSS s s s s T

Note: Since the class name is CompanyType, the operation CompanyType () is automatically assigned the
<<constructor>> stereotype.

Making the new class available for code generation

Now that the model has been extended with a new class, you will most likely want to update the underlying
code accordingly, in order to keep both in sync. However, if you press F11 to check the project syntax at this
stage, a warning is displayed in the Messages window: ‘CompanyType' has no Component Realization to a
Component - ComponentRealization to Component ‘OrgChart' will be generated. The reason is that the new
class requires realization to a component before code can be generated from it, as explained in Round-Trip
Engineering (Model-Code-Model . In some cases (including this example), UModel can generate the
required realization automatically; however, you can also define the realization dependency manually, as
follows:

1. While the companyType class is selected in the diagram, locate the property "code file name" in the
Properties window and enter "CompanyType.java" as file name.

name CompanyType A
qualified name COrgChart:com:OrgChart
element kind Class

visibility public bl
leaf O

abstract O

isFinalSpecialization |

active O

code file name CompanyType.java

code file path

«annotationss O W

[=] Properties @St}'les @Hierarchy

2. Click the new companyType class in the Model Tree, drag upwards and drop onto the OrgChart
component below the Component View package. A notification appears when the mouse pointer is over
a component.
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Model Tree o= ||
[— 1 [nlem Mirerhark |
Root -
arcd @ Info: :I

-EE] Drop will add CormponentRealizations te the Component
HE]
B £] OrgChart PersonType? | .

[ =% Relations
B Z] COrgChartTest
[ &] types
.$:| ®ml
B & CrgChart
-------- [ Content of OrgChart
-------- EﬂPackage dependencies of OrgChart
-A 1 com
........ [ Content of com
@ altova

-E [ OrgChart :
.7 Content of OrgChart P—

E CompanylLogaoType

-E CompanyType

‘E DescType W

| CompanyLogoType

This method creates a relation of type "ComponentRealization" between a class and a component. An
alternative way to do this is to draw the relation in a component diagram, see Component Diagrams
. Expand the Relations item below OrgChart to see the newly created relation.

Model Tree *

“IRoot N
B 1 Component View
- £] altova
-E ] ipo
E_|$:| OrgChart
E| —c- Relations
CnmpnnentReallzatmn [{CompanylogoType]
[ CnmponentReallzatlon [CompanyType)
-------- b ComponentRealization: [DescType)
e CnmpnnentRealizatinn' [DivisionType)
CnmpnnentReallzatmn [emailType) ¥

ElMGdHTrEE @Dlagram Tree |§% Favorites

Merging program code from a package

In UModel, you can generate code at pack £ level, component level, or for the entire project, see also
Synchronizing the Model and Source Code In this example, we will generate code at component level, as
follows:
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1. In the Model Tree window, locate the OrgChart component in the "Component View".
2. Right-click the OrgChart component, and select Code Engineering | Merge Program code from

UModel Component from the context menu.

Synchronization Settings

Code from Model  Model from Code
SPL templates
|User-defined ovemide default

When deleting Code
(® Comment out () Delete

Synchronization
(®) Merge Model into Code
() Overwrite Code according to Model

[litslways show dislog when synchronizing

Project Settings Cancel

The messages window displays the syntax checks being performed and status of the synchronization

process.
Messages x
¥ v|al wa vlal BBE X
Parsing file: "ChilUsers\altovaiDocumentsiAltovatUModel2018\UModelExamples\COrgChartwcom\OrgChart TextType.java’ -~
Resolving type references
Creating file: "Ch\Users\altova\DocumentstAltova\UModel201 8 WUModelExamples\CrgChartcom\CQrgChat\CompanyType.java’
Changing file: 'C\Users\altova\DocumentsiAltova'UModel201 8\UModelExamples\OrgChart\com\OrgChart\CompanyType java' [Pass
- .. finished update code from project - 0 error(s), 0 warning(s) W
£ >

When the process completes, the new CompanyType.java class has been added to the folder ...
\OrgChart\com\OrgChart\.

All method bodies and changes to the code will either be commented out or deleted depending on
the setting in the "When deleting code" group, in the Synchronization settings dialog box.

You have now completed a full round-trip code engineering cycle with UModel.
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3 UModel Graphical User Interface

The UModel graphical user interface consists of the main diagram pane, as well as several smaller helper

windows where you can enter or view data. The diagram pane serves as a parent contai
windows that are open. To cycle through all open diagram windows, press Ctrl+Tab.

ner for any diagram

) Altova UModel - C:\Users\altova\Documents) — O >
ﬁ File Edit Project Layout View Tools Window Help -8 X
O == 4 b $XERRBR S B8R & @ 2300 al & | Diagram
o ane
o e Do B M By £ B Eo @ EE B [mooe m # | [0 p
Diagram Tree o X pkg bankview A
EDiagrams
------- [ Account Hierarchy
------- [ Apply Java Profile
....... () Artifacts
------- [ BankView Main BankView
------- &7 BankView realization
_______ (5 Deployment &1 banks:Bank[*] {ordered} ordered)
_______ & Overview @1 bankAPl:IBankAR] £bank
Model Tree -H-Hcsjverv:ewAc_countBalance i » wconstructors BankView(in bankAPL:IBankAPl) ige—————
window [ Sample Dlag_ram Tree Fﬂj""':[""tes g» collectBankAddressinfos(:boolean !
| window wincow g collectAccountinfos:boolean Diagram
=% ) P — » collectDataj:boolean window
EImodel Tree | P Diagram Tree | 4% Favorites » getBalanceAtBank(in bankname:String]int
Properties o X » getBalanceSumOfAllBanks(:int
name BankView Main o
- hent kKind Class Diagrary -
Prl:l_pgrtles Styles Hierarchy 4
[RIC O window window  BankView Main Messages 4 b
J M window x
[= Properties @l Styles EI Hierarchy Essages
_ ¥ val vial va miww X
Overview a x
Overview L1 _1 %
window Documentation Layer
— window A
o & _wmduw
Ovenriew [E Documentation @Layer |
UMadel Connected to Altova LicenseServer at CAP NUM  SCRL

UModel graphical user interface

By default, the helper windows on the left side are docked in groups of three, and the M

essages window

appears below the diagram pane. You can, however, move and dock or undock any window as necessary. All
windows can be searched using the Find combo box in the Main toolbar, or by pressing Ctrl+F. See also

Finding and Replacing Text.

To dock or undock a window:

¢ Right-click its title bar, and select Docking (or Floating, respectively) from the context menu.
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To move a window:

1. Click the window's title bar and drag to a new position. Several docking helpers appear.

2. Drag the window over a top, right, left, or bottom handle to dock it to the new position.

To reset all toolbars and windows to their default state:

¢ On the Tools menu, click Restore toolbars and Windows.

This chapter provides reference information about the parts that make up the UModel graphical user interface,
as follows:

Model Tree Window

Diagram Tree Window
Fawvorites Window
Properties Window
Styles Window

Hierarchy Window@
Oweniew Window

Documentation Window

Layer Window@
Messages Window
Diagram Window
Diagram Pane@
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3.1 Model Tree Window

The Model Tree window enables you to view and manipulate all items (packages, classes, diagrams,
relationships, and so on) in the UModel project.

Model Tree »

_|Root
-~ Component View

E|M::udEITrEE @Diagramﬂ'ee 2% Favorites

Model Tree window

When you create a new UModel project, two packages are available by default, the "Root" and "Component
View" packages. These two packages are the only ones that cannot be renamed or deleted. The "Root"
package serves as starting point for modeling all other elements, while the "Component View" package is
required for code engineering.

You can create additional packages, classes, diagrams, and their hierarchy either from this window or directly
from a diagram, see Creating Elements @ For additional operations that you can take against items in the
Model Tree, see the How to Model... chapter.

Note: UModel includes several example projects that you can explore in order to learn the modeling basics
and the graphical user interface. These can be found at the following path: C:
\Users\<username>\Documents\Altova\UModel2024\UModelExamples.

Showing, hiding, and sorting items in the Model Tree

To configure what should be displayed in the Model Tree window, as well as the sorting options, right-click
inside the window, and then select the required menu option. To view all actions that can be taken against
items displayed in the Model Tree window, right-click the item and observe the context menu options.

Collapsing and expanding items in the Model Tree
To expand items (for example, packages) in the Model Tree window:

e Press the * (asterisk) key to expand the current item and all child items
e Press the + (plus) key to expand the current item only.

To collapse the packages, press the - (dash) keyboard key. To collapse all items, click the "Root" package
and press - (dash). Note that you can use both the standard keyboard keys and the numeric keypad keys to
achiewe this.
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Model Tree Window

83

Identifying active diagram items

When a diagram is open in the Diagram pane, the Model Tree window shows some items with a light-blue dot

at their base. These are items that are displayed in the active diagram (like "BankView" and "Java Profile" in

the example below):

Model Tree a
Root
- Behavior View
[ Component Wiew
[ Deployment View
= Design View
- B Owerview

Accaunt Transfer
é Banking access
'CLF" BankWiew
:i Relations

[ Interaction View
- [ JDKS.0 [Java (types o
[ Unknown Externals
- Use Case View

-4 #]Java Profile [Java Profile.ump]

pkag BankView | .

Apply Java Profile in order to get the Java specific
Stereotypes and Datatypes
Apply ‘'namespace’ stereotype to define a Java -

namespace

BankView oca.pp;lyx-. wprofiles
ffrom Design View] f--c----mmaemmeeem-22d Java Profile |
[from Root)

ElModelTree @DiagramTr-‘:-‘: ‘%%Fa‘-.-‘-:uritr:s

Icon reference

The Model Tree window may display a large number of icons which correspond to elements and diagrams in
your project, the code engineering packages, as well as the imported profiles or subprojects. Specifically, it

may display the following package types:

Icon | Description
Standard UML Package

= Java namespace root package. Used to generate or reverse engineer Java code

o C# namespace root package. Used to generate or reverse engineer C# code

WE Visual Basic namespace root package. Used to generate or reverse engineer VB.NET code

S0 XML Sphema namespace root package. Qsed to %lerate XML schemas from the model, or import
them into the model, see XML Schema Diagrams %=

5] Database namespace root package. Used to import databases into the model, and change their
structure from the model, see UModel and Databases “+.
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Icon | Description

M A namespace package (a package with the <<namespace>> stereotype applied to it)

4F A UML profile

The diagrams that can appear in the Model Tree window are listed below.

Icon | Description

[l | Activity Diagram

] BPMN 1 (Business Process Modeling Notation) Business Process Diagram
CH BPMN 2 Business Process Diagram
CH) BPMN 2 Choreography Diagram
L3 BPMN 2 Collaboration Diagram

1 | Class Diagram

Ed | Communication Diagram

2] Component Diagram

= Composite Structure Diagram

& Database Diagram

& Deployment Diagram

@ Interaction Ovenview Diagram

=] Object Diagram

= Package Diagram

Profile Diagram

= Protocol State Machine Diagram
= Sequence Diagram

B State Machine Diagram

i SysML diagrams (9 diagram types)
Timing Diagram

™ | Use Case Diagram

Fsl | XML Schema Diagram
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Below are some examples of UML modeling elements that can appear in the Model Tree window. For more
information about UML elements and the diagram types where they occur, see the UML Diagrams@ chapter.

Icon | Description
=] Class
o1 Property
» Operation
b Parameter
| Actor
o Use Case
£] Component
7 Node
O Artifact
0= Interface
H Class Instance (Object)
1 Class instance slot
= Relations

Constraints
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3.2 Diagram Tree Window

The Diagram Tree window displays any diagrams contained in the current UModel project.

Diagram Tree =
£ Diagrams

------- [=] Account Transfer

------- [E] Apply Csharp Profile

....... [E] BankAPI Draft

....... [ BankView Main

....... =7 BankView realization

------- rE'I Collect Account Information
....... [l collectData Draft

....... [E] Connect to BankAPI

....... [ Ceployment

------- [ Hierarchy of Account

....... =7 Overview

------- B Overview Account Balance
....... [El Query BankServer Draft

....... [@ sample Accounts

E| Model T..| & Diagra... %} Favorites

Diagram Tree window

Diagrams in this window can be shown either as an alphabetical list, or grouped by type. To change the display
option, right-click in the window, and select or clear the Group by Diagram type option.

For instructions about creating, opening, and generating diagrams, including how to model their content, refer
to the How to Model... @2 chapter. For specific information about each diagram type, refer to the UML

Diagrams@ chapter.
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3.3 Favorites Window

The Favorites window displays any modeling elements or diagrams that you have added as favorites.
"Favorites" represent a personal, custom-picked list of modeling elements or diagrams that you can use for

quick access, for example.

Favorites

& Favorites

5-1_:_| v bankview

........ [ BankView Main
........ [ Hierarchy of Account
........ [ sample Accounts
- B AgencyBank

-[ [ John's 1st

- B lohn's 2nd

- B lohn's 3rd

-[F B Account

- B Bank

- B BankView

W

E| Model Tree | = Diagram Tree 2% Favorites

Favorites window

By default, the contents of the Favorites window are automatically saved when you save the project. You can
change this option from the Tools | Options menu, File tab. The relevant option name is Load and save with

project file | Favorites.

ltems in the Favorites window are not copies or clones; they represent the actual elements or diagrams. Most
actions that you take in the Model Tree window are also applicable in the Favorites window, including adding or

deleting elements. For more information, see the How to Model...

chapter.
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3.4 Properties Window

The Properties window shows information about an item that is currently selected (in focus). The "in focus"
element can be an element selected in the Model Tree window (or other windows), an element selected on the
diagram, or even a diagram itself.

The Properties window also enables you to change the properties of the currently selected element or
relationship. The available properties depend on the kind of the element that is selected. There are properties
which are read-only and grayed out (such as "element kind") and properties that you can modify (for example,
"name").

If an operation or property takes a parameter, you can quickly jump to the respective parameter type in the
Model Tree window, directly from the Properties window. To do this, right-click the "type" property of the
parameter in the Properties window and select Select in Model Tree from the context menu. The same is
applicable for return parameters.

Properties x
name api

qualified name Design View::BankView::c
element kind Parameter

visibility unspecified |
ordered |

unigue

multiplicity |
type dBankAP| |
type modifier n/a Select in Model Tree
direction in ]
default o |
yartrglist |

zannotations: |

«fFinals |

[=] Properties @ Styles EI Hierarchy

Properties window

Changing a property of an element from the Properties window is immediately reflected in the diagram.
Likewise, making a change in the diagram (for example, changing the visibility of an operation from public to
private) affects the applicable property in the Properties window.

Properties that are enclosed within guillemets represent stereotypes (for example, «final»). You can add
custom stereotypes to the project, in which case they would appear as properties in the Properties window, in
addition to the default ones. For more information, see Example: Creating and Applying Stereotypes D
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3.5 Styles Window

The Styles window enables you to view or change the visual appearance of diagrams or elements that are
currently selected (in focus). The style attributes fall into two general groups:

e Formatting settings (for example, font size, weight, color, etc)
e Display settings (for example, show background color, grid, \visibility settings, etc).

Styles x
Project Styles W
Header Gradient Bec/#ATAGBF [N LI@ ~
Header Gradient Enclwhite —1 LI@
Header Colol black [ Kal])
Header Font Segoe LI hdl
Header Font-Size 11 ]|
Header Font-Weight|bold hdl
Fill Color white =153
Trans. Fill Color Ld)
Pen Colot #525252 W w |53
Font Color black [ Kal])
Font Segoe LI hdl
Font-Size 11 ]|
Font-Weinht narmal - | b
=] Properties '-.?;.l Styles ElHierarch}-'

Styles window

Changing a property from the Styles window is immediately reflected in the user interface. Likewise, making a
style change in another place (for example, setting the visibility of the diagram grid using the Show Grid ::
toolbar button) affects the applicable property in the Styles window.

The Styles window has a dropdown list in the upper part, which enables you to select the level at which the
style change is to be applied (for example, at individual element level, or at project level). For more information,
see:

¢ Changing the Style of Elements
¢ Changing the Style of Diagrams
e Changing the Style of Lines and Relationships
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3.6 Hierarchy Window

The Hierarchy window displays all relations of the currently selected modeling item, in two different views. The
modeling element can be selected in a diagram, in the Model Tree window, or in the Favorites window.

ltems in the Hierarchy window can be displayed in two views:

o Tree view
e  Graph view

To switch between views, click the Show tree view E or Show graph view buttons in the upper-left
corner of the window.

The tree view shows multiple relations of the currently selected element, as a tree. Click the buttons at the top
of the window to select types of relations that are to be shown. In the image below, only generalizations
and associations are selected to be shown.

E| 4— Subtypes
i B CheckingAccount
........ H SavingsAccount
- H CreditCardAccount

E‘—; Associations

=l Properties @St}-‘les @Hierarchy

Hierarchy window (tree view)

The graph view shows a single set of relations in a hierarchical oveniew, as a diagram. In this view, only one of

the relation buttons can be active at any one time. In the image below, the Show Generalizations button
is currently active.
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Hierarchy =

B[] — B omor .

-E Account

B CheckiﬁgAcmunt B Sauing.sAccount B CreditCérdAccount

Create diagram as this graph

[=] Properties @St}-‘les @Hierarchy

Hierarchy window (graph view)

In the graph view, you can generate diagrams that include the elements visible in the window. To do this, right-
click inside the window, and select Create diagram as this graph from the context menu.

Settings pertaining to Hierarchy window can be changed using the menu option Tools | Options | View, in the
Hierarchy group in the lower section of the dialog box.

The Hierarchy window is navigable: double-click one of the element icons, inside the window, to display the
relations of that element. This applies both in the tree view and in the graph view.
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3.7 Overview Window

The Ovenview window displays an outline view of the currently active diagram. This is especially handy when
you need to scroll very large diagrams. To scroll the diagram, click and drag the red rectangle.

Owverview »

Overview window

See also Zooming into/out of Diagrams .
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3.8 Documentation Window

The Documentation window enables you to document any of the UML elements available in the Model Tree
window. To add documentation to an element, first click the element, and then enter text in the Documentation
window. This window supports the standard editing shortcuts, including Select All (Ctrl+A), Cut (Ctrl+X),
Copy (Ctrl+C) and Paste (Ctrl+V).

Documentation =
IThis is some documentation text which
contains a hypedink.

Documentation window

Text inside the Documentation window can be spell-checked. To do this, right-click inside the window, and
select Documentation Spelling from the context menu.

Documentation text can also be exported as comments in the generated source code, or imported from source
code comments during reverse engineering. For more information, see Documenting Elements @,
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3.9 Layer Window

The Layer window enables you to define multiple layers for any UModel diagram. Layers allow you to make
logical groupings of modeling elements on a diagram. For example, you can create, in addition to the default
layer, some extra layers that would store notes with some internal information, or unfinished classes.

Layer x

g2 X @B [#e

& 8| pefautt (5)

@J Notes (1)

EE Work in progress (2

Cwerview Documentation ﬁLayer

Layer window

For more information, see Adding Layers to Diagrams .
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3.10 Messages Window

The Messages window displays any of the following message types: information messages, warnings, and
errors. Such messages may occur when you check the project syntax (see Checking Project Syntax), or
when you perform code engineering tasks. For more information about code engineering, see Generating

Program Code and Importing Source Code@.

Messages *
Y vjal vial vjal binE X

Bl starting Syntax Check ...
- . finished Syntax Check - 0 error(s), 0 warning(s)

[El starting update code from praoject ...
-------- Collecting source files in "CAWUNML_Bank_SampletJavaCodecomtaltovaibankview’

-------- Parsing file: "CA\UML_Bank_Sample’JavaCode\com\altova\bankviewhAccount.java’

-------- Parsing file: "CA\UML_Bank_Sample'JavaCode\com'\altovaibankview'\Bank. java'

-------- Parsing file: "CA\UML_EBank_Sample‘JavaCode\com'altovaibankview'\BankView java'

-------- Parsing file: "CAUML_Bank_Sample'JavaCode\com\altova\bankview\CheckingAccount,java’
-------- Parsing file: "CA\UML_Bank_Sample'JavaCode'\com'\altova\bankview\CreditCardAccount.java'
-------- Parsing file: "C\UML_Bank_Sample‘JavaCode'\com'\altova'\bankview\5avingsiccount.java'
-------- Resolving type references

-------- w finished update code from project - 0 errar(s), 0 warninag(s)

Messages window

The table below lists possible message types and their icons.

Icon Description

none Indicates an information message.

r, Indicates a warning message. Warnings are less critical than errors, but they may still
prevent code from being imported or generated.

1] Indicates an error message. When an error occurs, code generation or import fails.

The buttons available at the top of the Messages window enable you to take the following actions:

Icon Description
| Filter messages by sewerity: information messages, and warnings. Select Check All to

include all severity lewvels (this is the default behavior). Select Uncheck All to remowve all
severity lewvels from the filter.

o Jump to the next error.
al Jump to the previous error.
= Jump to the next warning.
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Icon Description

2 Jump to the previous warning.

hd Jump to the next line.

al Jump to the previous line.

Copy the selected line to the clipboard.

Copy the selected line to the clipboard, including any lines nested under it.
Copy the full contents of the Messages window to the clipboard.

X Clear the Messages window.

When UModel runs as a Visual Studio or Eclipse plug-in, and parsing errors occur, you can quickly jump to the
source code file where the error originates directly from the Messages window. To do this, click the parsing
error in the Messages window. For more information, see UModel Plug-in for Visual Studio©? and UModel
Plug-in for Eclipse“+.
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UModel Graphical User Interface

3.11 Diagram Window

Whenever you create a new diagram, or open an existing one, a new Diagram window is loaded in the Diagram
Pane ¥  The diagram window provides the canvas (drawing area) where you design UML diagrams. Various
modeling commands are available when you right-click either the diagram canvas itself, or any element on it.

Importantly, the toolbar buttons and the context menu commands in UModel change based on the type of
diagram that is currently active (in focus). For example, if you click inside a Class diagram, the toolbar buttons
will include only elements applicable to class diagrams. To view the diagram type, click inside an empty area in
the diagram, and observe the "element kind" property displayed in the Properties window . The diagram type
can also be distinguished by the icon accompanying the diagram, see Creating Diagrams “J.

E=N Eol =53

57 BankView realization

Show what our sample
component will realize
(when forward

engineering):
BankView
[from bankview]
_,ﬁ.-.--
ccomponent= 3 | s Bank
BankView T [from bankview)
AT
Account | S
(from bankview) | = .~ 7 . L N
J . .J!. S ‘.x\‘.
¢ Do o A :
CheckingAccount |
SavingsAccount {from bankview]

(from bankview) | = = !

CreditCard Account
[from bankview)

Diagram window

For information about creating new.diagrams, opening existing ones, and manipulating elements inside the
107

diagram, see the How to Model...

chapter.
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3.12 Diagram Pane

The diagram pane hosts all diagram windows that are currently open. For information about creating new
diagrams, opening existing ones, and manipulating elements inside the diagram, see the How to Model... @
chapter.

The image below illustrates the diagram pane with four diagram windows open and positioned using the
Window | Cascade menu command.

[F

== Account Transfer | = ” =] ” 2 |

i [B Apply Java Profile IEREREE
=] || £2

st| [ BankView Ma o || © |

[ - "

=

[P} [ BankaP! Draft

’_FI

' g1 banks:Bank[*] {ordered} I
@1 bankAPl:IBankAP|

ol |

Tordered} &1 v
>

Accnunt Transfer | Apply]ava Profile | E BankAPl Draft Eﬂank‘.l'"lew Main

Diagram pane

Sewveral commands applicable to the current diagram window are available when you right-click the
corresponding window tab at the lower area of the diagram pane.

To apply miscellaneous commands to windows inside the diagram pane, use the commands available in the
Window menu. Several window manipulation commands are also available on the Window dialog box (to open
this dialog box, select the menu command Window | Windows).
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Windows >

Select window: Activate

(=) Account Transfer

|E=) Apply Java Profie oK
[ BankAF| Draft
[ BankView Main Close Window(z)

Cascade
Tile Horizontalhy
Tile Verically

Minimize

Windows dialog box

To select multiple windows on the dialog box above, hold down the Ctrl key pressed and click the
corresponding entries.

To cycle through all open diagram windows, press Ctrl+Tab.
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4 UModel Command Line Interface

In addition to the graphical user interface, UModel also has a command line interface. To open the command
line interface, run the UModelBatch.exe file available in the C:\Program Files\Altova\UModel2024 directory.
If you run UModel 32-bit on a 64-bit operating system, the path is C:\Program Files (x86)
\Altova\UModel2024.

The command line parameter syntax is shown below, and can be displayed in the command prompt window by
entering: umodelbatch /?

Note: If the path or file name contains spaces, enclose it in quotes, for example: "C:\Program Files\...
\MyProject.ump".

usage: UModelBatch.exe [project] [options]

/? or /help ... display this help information

project ... project file (*.ump)

/new[=file] ... create/save/save as new project, see Creating, Loading, and Saving
Projects in Batch Mode €&

/set ... set options permanent

/gui ... display UModel user interface

commands (executed in given order) :

/chk ... check project syntax
/isd=path ... 1lmport source directory
/isp=file ... lmport source project file

(*.project, *.xml, *.jpx, *.csproj, *.csdproj, *.vcxproj, * .vbproj, *.vbdproj
,*.sln, *.bdsproj)

/ibt=1ist ... lmport binary types (specify binary[typenames] list)
(';'=separator, '*'=all types, '#' before assembly names)

/ixd=path ... import XML schema directory

/ixs=file ... import XML schema file (*.xsd)

/m2c ... update program code from model (export/forward engineer)

/c2m ... update model from program code (import/reverse engineer)

/ixf=file ... import XMI file

/exf=file ... export to XMI file

/inc=file ... include file

/mrg=file ... merge file

/doc=file ... write documentation to specified file

/lue[=cpri] ... list all elements not used on any diagram (i.e. unused)

/1dg ... list all diagrams

/1lcl ... list all classes

/1lsp ... list all shared packages

/1lip ... list all included packages

options for save as new project:
/npad=opt ... adjust relative file paths (Yes | No | MakeAbsolute)

options for import commands:
/iclg=lang ... code language (Javal.4 | Java5.0 | Java6.0 | Java7.0 | Java8.0 |
Java9.0 |
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options for import binary types

/ibrt=vers

(after /iclg):
runtime version

/ibpv=path override of PATH variable for searching native code libraries
/ibro[=0]1] use reflection context only

/ibua[=0]1] use add referenced types with package filter

/ibar[=flt] add referenced types package filter (presets /ibua)

/ibot [=0]1] import only types

/ibuv[=0]1] use minimum visibility filter

/ibmv [=key] keyword of required minimum visibility (presets /ibuv)
/ibsa[=0]1] suppress attribute sections / annotation modifiers
/iboa[=0]1] create only one attribute per attribute section

/ibss[=0]1] suppress 'Attribute' suffix on attribute type names

options for diagram generation:

/dgen[=0]1] generate diagrams

/dopn [=0]1] open generated diagrams

/dsac[=0]1] show attributes compartment
/dsoc[=0]1] show operations compartment
/dscc[=0]1] show nested classifiers compartment
/dstv[=0]1] show tagged values

/dudp [=0]1] use .NET property compartment
/dspd[=0]1] show .NET property compartment

options for export commands:

/ejdc[=0]1] Java comments as JavaDocs
/ecdc[=0]1] C# comments as DocComments
/evdc [=0]1] VB comments as DocComments
/espl[=0]1] use user defined SPL templates

UModel Command Line Interface 101
Javal0.0 | Javall.O | Javal2.0 | Javal3.0 | Javald.0 |
Javal5.0 |
C#1.2 | C#2.0 | C#3.0 | C#4.0 | C#5.0 | C#6.0 | C#7.0 |
C#7.1 | C#7.2 | C#7.3 | C#8.0 | C#9.0 |
VB7.1 | VB8.0 | VB9.0 |
C++98 | C++11 | C++14 | C++17)
/ipsd[=0]1] process sub directories (recursive)
/irpf[=0]1] import relative to UModel project file
/ijdc[=0]1] JavaDocs as Java comments
/icdc[=0]1] DocComments as C# comments
/icds[=1st] C# defined symbols
/ivdc[=0]1] DocComments as VB comments
/ivds [=1lst] VB defined symbols (custom constants)
/icppdm[=1st] C++ defined macros
/icpphi[=0]1] read only C++ header files
/icpphc[=0]1] treat .h files a .cpp files
/icppms [=0]1] enable C++ Microsoft Compiler compatibility
/icppmv [=ver] .. MSVC version to use (1900 | 1800 | 1700 | 1600 | 1500 | 1400 | 1310
| 1300 | 1200)
/icppsy[=0]1] auto detect C++ system include files
/icppid[=1lst list of C++ include directories to use
/icppsd[=1lst list of C++ system include directories to use
/icppag[=arg .. Additional C++ arguments for the compiler
/imrg[=0]1] synchronlze merged
/iudf[=0]1] use directory filter
/iflt[=1st] directory filter (presets /iudf)
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/ecod[=0]1]
/emrg[=0]1]
/egfn[=0]1]

]

/eusc[=0]1

. comment out deleted

. synchronize merged

. generate missing file names
. use syntax check

options for XMI export:

/exid[=0]1]
/exex[=0]1]
/exdg[=0]1]
/exuv [=ver
UML2.5.1)

. export UUIDs
. export UModel specific extensions
. export diagrams (presets /exex)
] ... UML version (UML2.0 | UML2.1.2 | UML2.2 | UML2.3 | UML2.4 | UML2.5 |

options for merge file:

/mcan=file

. common ancestor file

options for documentation generation:

/doof=fmt
/dsps=file

. output format (HTML | RTF | MSWORD | PDF)
. SPS design file

Example 1: Import Java source code and preserve settings

The following command imports source code and creates a new project file. Notice that the project path
contains spaces and is enclosed in quotes.

"C:\Program Files\Altova\UModel2024\UModelBatch.exe" /new="C:\My
Projects\Fred.ump" /isd="X:TestCases\UModel\Fred" /set /gui /iclg=Java8.0 /ipsd=1 /ijdc=1
/dgen=1 /dopn=1 /dmax=5 /chk

The meaning of all

options is as follows:

/new Specifies that the newly-created project file should be called "Fred.ump" in C:\My Projects

/isd Specifies that the source directory should be X:\TestCases\UModel\Fred

/set Specifies that any options used in the command line tool will be saved in the registry
(When subsequently starting UModel, these settings become the default settings).

/gui Display the UModel graphical user interface during batch processing.

/iclg UModel will import the code as Java 8.0.

/ipsd=1 Recursively process all subdirectories of the root directory specified in the /isd parameter.

/ijde=1 Create JavaDoc from comments where appropriate.

/dgen=1 Generate diagrams.

/dopn=1 Open generated diagrams.

/chk Perform a syntax check.
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Example 2: Synchronize code from the model
The following command updates code from an existing project file ("C:\UModel\Fred.ump").

"C:\Program Files\Altova\UModel2024\UModelBatch.exe™ "C:
\UModel\Fred.ump" /m2c /ejdc=1 /ecod=1 /emrg=1 /egfn=1 /eusc=1

The meaning of all options is the same as in the previous examples, plus:

/m2c Update the code from the model.

/ejdc Comments in the project model should be generated as JavaDoc.
/ecod=1 Comment out any deleted code.

/emrg=1 Synchronize the merged code.

/egfn=1 Generate any missing file names in the project.

/eusc=1 Use the syntax check.

Example 3: Import Java binaries into the model

Let's assume that some Java binary .class files exist in the C:\JavaProject\bin directory, and you want to
import these binaries into UModel. To do this, run the following command:

"<C:\Program Files\Altova\UModel2024\UModelBatch.exe>" /new="C:
\JavaProject\Result.ump" /ibt=*C:
\JavaProject\bin /iclg=Java8.0 /ibrt=JDK1.8.0 144 /dgen=1 /chk

The options used are as follows:

/new Creates a new UModel project at the specified path.

/ibt Instructs UModel to import binary types. The asterisk before the path indicates that all
binary types at that path must be imported.

/iclg Specifies the code generation language ("Java8.0", in this example).

/ibrt Specifies the runtime environment ("JDK1.8.0_144" in this example). This is the same value
that appears on the "Import Binary Types" dialog box in the "Runtime" drop-down list, see
Importing Java, C# and VB.NET Binaries ©. You can also use a value like "jdk-10.0.1" as
set in the gava_HOME environment variable.

For C#, you can use the value /ibrt:any or otherwise values as they appear in the GUI in
the "Runtime" drop-down list, making sure to omit any spaces. Examples:

/ibrt:any
/ibrt: .NET5
/ibrt: .NETFramework4.8 (v4.8.3752)
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The option "any" is the same as selecting "any (use disassembler)" from the "Runtime"
drop-down list and is the recommended option.

/dgen=1 Generate diagrams.

/chk Perform a syntax check after import.
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4.1 Creating, Loading, and Saving Projects in Batch Mode

When you run UModelBatch.exe with a command like UModelBatch MyProject.ump, YOU can use the
following parameters:

/new This parameter defines the path and file name of the new UModel project file (*.ump) to create.
It can also be used to load an existing project and save it under a different name, for example:

UmodelBatch.exe MyFile.ump /new=MyBackupFile.ump

/set This parameter overwrites the current default settings in the registry with the options you
specify.
/qui This parameter displays the UModel graphical user interface (GUI) during the batch process.

The examples below illustrate how to create, load, or save projects in full batch mode (in other words, the /gui
parameter is not set).

new
UModelBatch /new=xxx.ump (options)
creates a new project, executes options, xxx.ump is always saved (regardless of options)
auto save
UModelBatch xxx.ump (options)
loads project xxx.ump, executes options, xxx.ump is saved only if document has changed (like /ibt)
save
UModelBatch xxx.ump (options) /new
loads project xxx.ump, executes options, xxx.ump is always saved (regardless of options)
sawe as

UModelBatch xxx.ump (options) /new=yyy.ump
loads project xxx.ump, executes options, always saves xxx.ump as yyy.ump (regardless of options)

The examples below illustrate how to create, load, or save projects in batch mode with UModel user interface
visible (the /gui parameter is set).

new

UModelBatch /gui /new (options)

creates a new project, executes options, nothing saved, the GUI is left open
save new

UModelBatch /gui /new=xxx.ump (options)

creates a new project, executes options, xxx.ump saved, the GUI is left open
user mode

UModelBatch /gui xxx.ump (options)

loads project xxx.ump, executes options, nothing saved, the GUI is left open
save
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UModelBatch /gui xxx.ump (options) /new
loads project xxx.ump, executes options, xxx.ump is saved, the GUI is left open

save as
UModelBatch /gui xxx.ump (options) /new=yyy.ump
loads project xxx.ump, executes options, xxx.ump is saved as yyy.ump, the GUI is left open

The project will be saved successfully provided that no critical errors occur while executing the options.
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5 How to Model...

Altova website: ©

UML modelin

This chapter provides instructions for creating and manipulating UML elements, diagrams, and relationships
from the UModel graphical user interface. It is intended as a "how to" guide to modeling with UModel. The
enclosed instructions are generic across UModel and not specific to a particular element or diagram type,
unless explicitly mentioned. For information applicable to (and grouped by) each diagram type, refer to the UML

Diagrams chapter.

The information in this chapter is organized into the following categories: Elements, Diagrams, Relationships,

and Stereotypes.

Relationships

Elements Diagrams Relationships Stereotypes
Creating EIements@ Creating Diagrams Creating

StereotﬁEes and Tagged
Values

Inserting Elements from
the Model into a

Diagram

Generating Diagrams

Changing the Style of
Lines and

Relationships

Tagged Values

Renaming, Movingi and
Copying Elements

Opening Diagrams

Viewing Element
Relationships

Applying Stereotypes

Deleting Elements @

Deleting Diagrams

Associations@

Showing or Hidin
Tagged Values

Converting Elements

Changing the Style of
Diagrams

Collection
Associations

Finding and Replacing
Text

Aligning and ResizinE
Modeling Elements

Containment

Checking Where and If
Elements Are Used

Type Autocompletion in
Classes

Constrainin Zooming into/out of
Elements Diagrams
Hyperlinkin Adding Laﬁers to
Elements Diagrams
Documentin
Elements
Changing the Style of
Elements
Note: UModel includes several example projects that you can explore in order to learn the modeling basics

and the graphical user interface. These can be found at the following path: C:

\Users\<username>\Documents\Altova\UModel2024\UModelExamples.
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5.1 Elements

511 Creating Elements

With UModel, new elements can be created as follows:

e  From the Model Tree ® window. With this approach, elements are added to the model only, and you
can insert them later into diagrams if necessary.

e From any diagram window. Any elements added to a diagram are also automatically added to the
model as well. Should you need to delete an element later, you can choose whether it should be
removed from the diagram only, or deleted from the model as well.

To add elements from the Model Tree window:

e In the Model Tree ® window (or Favorites € window), right-click the element (for example, package)
under which you want the new element to appear, and select New Element | <Element Name> from
the context menu. For example, to add a new package under the "Root" package, right-click the
"Root" package, and select New Element | Package.

To add elements from the Diagram window:

1. Create a new diagram (see Creating Diagrams) or open an existing one (see Opening Diagrams@
).
2. Do one of the following:
a. Right-click inside the diagram and select New | <Element Name> from the context menu.
b. Click the toolbar button of the element you wish to add, and then click inside the diagram. To
insert multiple elements of the same type, hold down the Ctrl key before clicking inside the

diagram.
Packages
As you model elements, you will likely need to work with packages more often than with other elements. Each
entry marked with a folder symbol in the Model Tree window represents a UML package. Packages in

UModel serve as containers for all other UML modeling elements (including diagrams, classes, and so on) and
have the following behavior:

e They can be created at any position in the Model Tree.

e They can be moved or copied to other packages (as well as into valid model diagrams), see Renaming,
Moving, and Copying Elements @

o They can be used as source or target elements when code is generated or synchronized with the
model, see Forward Engineering (from Model to Code)@ and Reverse Engineering (from Code to
Model) @

When you create a new UModel project, two packages are available by default, the "Root" and "Component
View" packages. These two packages are the only ones that cannot be renamed or deleted. The "Root"
package serves as starting point for modeling all other elements, while the "Component View" package is
required for code engineering.
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Model Tree x

_|Root
- Component View

ElMUdElTrEE @Diagramﬂ'ee ‘%%Fat-‘-:urites

Default UModel pack ages

5.1.2 Inserting Elements from the Model into a Diagram

Elements present in the model can be inserted into a diagram either individually or as a group. To select
multiple elements from the Model Tree window, hold down the Ctrl key while clicking each item. There are two
ways to insert elements into a diagram: drag left, and drag right.

e Drag left (holding down the left mouse button and releasing it in the diagram) inserts elements
immediately at the cursor position. In this case, any associations, dependencies etc. that exist
between the currently inserted elements and the new one, are automatically displayed.

e Drag right (holding down the right mouse button and releasing it in the diagram) opens a context
menu from which you can select the specific associations, generalizations you want to display.

For example, let's suppose that you want to create a new class diagram from a class that already exists in the
model. To illustrate this scenario, open the sample project Bank_MultiLanguage.ump available at the
following path: C:\Users\<username>\Documents\Altova\UModel2024\UModelExamples. Assuming that
you want to replicate the "Account Hierarchy" diagram in a new class diagram, do the following:

1. Right-click the bankview package and select New Diagram | Class Diagram.
Locate the abstract account class in the model tree, and use drag right to place it in the new
diagram. For this example, we would like to display the class together with its derived classes. To
achiewe this, select Insert with Generalization Hierarchy (specific) from the context menu.
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Model Tree o x plg BankView ]
-# TAccount Transfer A e
- = Bank Server [Bank Server.ump]

[ 2 Banking access [Banking access.ump] C Insert

- =1 BankView [BankView.ump]
. 5] Apply Java Profile C Insert with Generalizations (specific)
. [T ClassDiagrami Insert with Generalization Hierarchy (specific)
E‘ w] com Insert with Full Generalization Hierarchy (general and specific)
SR altova
E--EI w | bankview C Insert with Associations

-------- [ BankView Main

........ T Hierarchy of Account
-------- [ Sample Accounts

- B AgencyBank

- [ John’s 1st

~[# B John's 2nd

- B John's 3rd

-H B Account

-[# B Bank

Insert with All Properties as Assaciations

Insert with TypedElements

3. Select or clear the check boxes for specific items you want to appear in the diagram.

Styles of new items

Style
[+]i5how Attrbutes compartment
Show Operations compartment Cancel

[ ] Show nested Classifiers compartrent

[ ] 5how EnumerationLiterals compartment

[ ] Show Extension Paints compartment

[ ]5how Tagged Yalues

Ilze cwn compartment for MET properties
] Show MET properties compartment

Alwaps shaw thiz dialog befare adding

4. Click OK. The account class, together with its three subclasses, is inserted into the diagram. The
Generalization arrows are also automatically displayed. To automatically arrange the classes inside
the diagram, run the menu command Layout | Autolayout All | Hierarchic.

If you had selected the Insert command instead of Insert with Generalization Hierarchy (specific), the
class would have been added to the diagram without any derived classes. Note that you can still display the
generalization hierarchy later, as follows:

¢ Right-click the account class in the diagram and select Show | Generalization hierarchy from the
context menu. As a result, the derived classes are inserted into the diagram as well.
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51.3 Renaming, Moving, and Copying Elements

You can cut, copy, rename and mowve elements in the Model Tree ® window and inside diagrams of the same
type. These actions may also be possible across diagrams of different type if applicable. You can also copy or
mowe elements from the Model Tree window into a diagram, provided that the diagram is allowed to contain the
corresponding element according to the UML specification.

To rename an element:

e Double-click the element name and edit it.
o Alternatively, click the element and press F2.

The procedures above apply regardless of the window in which the element is displayed, including the Model
Tree window, Properties window, and the Diagram window.

The "Root" and "Component View" packages are displayed at all times in the Model Tree window and
cannot be renamed or deleted.

To copy or move elements:

e Use the standard Windows commands Cut, Copy, or Paste. These commands can be triggered from
keyboard shortcuts (Ctrl+X, Ctrl+C, Ctrl+V, respectively), from the corresponding toolbar buttons, as
well as from the Edit menu.

e Alternatively, drag an element to a destination package (or element). Dragging an element mowes it.
Holding down the Ctrl key and dragging an element creates a copy of it.

For example, in a diagram, you can mowve a class member to another class by dragging it from the source
class to the destination class. To copy the class member rather than moving it, first select it, and then drag it
to the destination class while holding down the Ctrl key.

If you paste a class into the same package, the new class is created with a sequential number appended to
the end, for example, "MyClass1". Likewise, if you paste a property inside the same class, the new property is
created with a sequential number appended to the end, for example, "MyProperty1". The same applies for other
class members, such as operations and enumerations. The same logic is also applicable when you paste
elements in the same diagram, provided that the diagram belongs to the same package as the elements that
are being pasted.

If you paste a class into a different package, the new class will have the same name as the original class. The
same logic applies when you copy class members (such as properties, operations, and so on) to a different
class.

By default, any element that is pasted into a diagram is automatically added to the model as well (and thus is
visible in the Model Tree window). However, you can also copy and paste an element into the current diagram
only, without adding it to the model. To do this, first copy the element, right-click on the diagram, and then
select Paste in Diagram only from the context menu. The Paste in Diagram only command also appears
when you drag an existing item into the same diagram while holding the Ctrl key pressed.
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L T _______ n
1 MyClass1 ] k |
= : s Paste
MyProperty o
':'E gl MyFroperty 1 Paste in Diagram only
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Vd  myOperation?) ' |
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In the example above, Paste will create the new class in the diagram and add it to the model as well, while
Paste in Diagram only will only display a second view of it on the diagram. Note that copies created using the
second approach are merely additional views of the original element and link to it; they are not standalone
copies. (For example, renaming a property in the duplicated class will automatically apply the same change to
the original class.)

514 Deleting Elements

Elements can be deleted in one of the following ways:

e From the Model Tree window. Use this approach if the element should be deleted from the project as
well as any diagrams where it is present.

e Directly from diagrams where they occur. In this case, you can choose whether the element should be
removed from the diagram only, or deleted from the model (project) as well.

To delete elements from the project and all related diagrams (approach 1):

1. In the Model Tree window, click the element you want to delete. Hold the Ctrl key down to select
multiple elements.
2. Press Delete.

To delete elements from the project and all related diagrams (approach 2):

1. Open a diagram and click the element you want to delete. Hold the Ctrl key down to select multiple
elements.

2. Press Delete. A dialog box appears asking to confirm that you want to delete the element both from
the project and the diagram.

3. Click Yes. The element is deleted both from the diagram and the project.

To delete elements from the diagram but not from the project:
1. Open a diagram and click the element(s) you want to remove. Hold the Ctrl key down to select
multiple elements.
2. Hold down the Ctrl key and press Delete. The elements are deleted from the diagram but still kept in

the project.

Before you delete elements from a project, you may want to check if they are used in any diagrams.
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e Right-click an element in the Model Tree, and then select Show element in all diagrams from the
context menu.

Likewise, when a diagram is open, you can quickly select an element in the Model Tree, as follows:

e Right-click the element on the diagram, and select Select in Model Tree from the context menu.
e Alternatively, click the element on the diagram and press F4.

51.5 Converting Elements

Some of the elements support quick conversion to some other element kind. This action may be useful, for
example, if you started designing a class but would like to change it later to an interface, or vice versa. More
specifically, the following kinds of elements support conversion to any other item in the list:

Class
Interface
Enumeration
PrimitiveType
DataType

You can convert the element kinds listed above either from the Diagram window@ or from the Model Tree@.

To convert elements:

1. Open a diagram that includes classes, interfaces, enumerations, primitive types or data types (for
example, a class diagram). Alternatively, locate any of these element kinds in the Model Tree.

2. Right-click the element of interest (for example, a class) and select Convert To | <element kind>
from the context menu.

After conwersion, the name of the element is preserved. If possible, the data associated with the element is also
preserved. For example, a conwersion from interface to class or from class to interface preserves data such as
properties or operations. However, a conversion from a class or interface to an enumeration will result in data
loss. In such cases, if necessary, you can restore the previous state of the element by running the Undo
(Ctrl+Z) command.

5.1.6 Finding and Replacing Text

You can search for modeling elements, diagrams, text, and so on, inside any of following windows:

Diagram window

Model Tree window
Diagram Tree window
Favorites window
Documentation window
Messages window

The search scope is applicable to the window where the cursor is currently placed. Therefore, if you want to
search for text inside a diagram, for example, click inside the diagram first. Likewise, if you want to search for
an item in the UModel project, click inside the Model Tree window first.
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Elements

To search for text or elements:

1. Click inside the window where you want to find text.

2. Do one of the following:

a. Type the search text in the text box of the main toolbar, and then click Find Next E or press F3.
To go to the previous occurrence, press Shift+F3.

i X HER S A2 38| Acoun |~| & &y

DEeE < 4 b

b. On Edit menu, click Find (or press Ctrl+F).

Find

Find what: |f-‘-.ccu:uunt

v| [ FindNest

Dptionz
[ ] tatch whole ward only
[ ] Match caze

Direction
(CiUp
(®) Down

Cancel

Find and replace

You can also find and replace text (for example, in order to quickly rename modeling elements). When the
element is found, it is highlighted in the diagram as well as in the Model Tree. Search and replace works in the

following windows:

Diagram window

Model Tree window
Diagram Tree window
Faworites window
Documentation window

To find and replace text:

1. Click inside the window where you want to find/replace text.

2. Do one of the following:

c. Click the Replace % toolbar button.
d. On the Edit menu, click Replace (or press Ctri+H).
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Find & Replace >
Firid what: |}-‘-.ccu:uur|t w | | Find Mext |
Feplace with: |Savingsﬁ.ccl:uunt v | Eeplace
Options Direction Replace Al
[ ] tatch whole ward only ) Up Ol
[ ]Match caze (®) Down
] Replace in zelection anly

5.1.7 Checking Where and If Elements Are Used

While navigating the elements in the Model Tree, you might want to see where, or if, the element is actually
present in a model diagram. To find where elements are used, do one of the following:

¢ Right-click the element in the Model Tree window, and select Show element in all diagrams (or, ifa
diagram is currently open, Show element in active diagram).

You can also find elements not used in any diagram either for the entire project, or for individual packages.

To find unused elements in the entire project:

¢ On the Project menu, click List elements not used in any diagram.

To find unused elements for a specific package:

¢ Right-click the package you would like to inspect, and select List elements not used in any
diagram.

A list of unused elements appears in the Messages window. Note that the unused elements are displayed for
the currently selected package and its subpackages. ltems inside parentheses are elements which have been
configured to appear in the unused list, from Tools | Options | View tab.
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Messages »
W vlal vjal val wnE X

E_lList all elements [Classifier, Package, Relations, Instancespecification) not used in any diagram...
-------- B Banking access

ProfileApplication: [Banking access -= C#F Profile)
i BankAPl
- .3 elements have been found

Click the element name in the Messages window to locate it in the Model Tree.

51.8 Constraining Elements

Constraints can be defined for most model elements in UModel. Note that constraints are not checked by the
syntax checker, because they are not part of the code generation process.

To constrain an element (from the Model Tree):

1. Right-click the element you want to constrain, and select New Element | Constraints | Constraint.
. Enter the name of constraint and press Enter.
3. Type the constraint text in the "specification" field of the Properties window (for example, name length

> 10).

Properties x
name Constraint

qualified name EBehavior View::BankAPL:Con
element kind Constraint

visibility public |
specification iname length > 10 {
constrained elements BankAPl o
[=] Properties '@ Styles EIHierarchy

To constrain an element (from a diagram):

1. Double-click the specific element to be able to edit it.
1. Type "#", and then type the constraint text inside curly braces, for example, #{interestRate >=0}.
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To assign constraints to multiple modeling elements:

1. Select a constraint in the Model Tree window.
2. Right-click the "constrained elements" property the Properties window, and select Add element to
constrained elements.

Properties x
name Constrainti

gqualified name Design View:BankView::com
element kind Constraint

visibility public |
specification interastRate=0 ... |
constrained elements interestRateCnBalance—

Select in Model Tree

=l Properties | 3 Styles | [F]Hierarchy Add Element To Constrained Elements

Remove Element From Constrained Elements

3. Select the specific element you want to assign the current constraint to. Hold down the Ctrl key to
select multiple elements.

Properties =
name ‘Constraint1
qualified name Design View:BankView:: com:alt
element kind Constraint
visibility public hdl
specification interestRate=0 Lo
interestRate Lo
constrained elements interestRateCnBalance Lo
interestRateOnCashAdvance |
[=] Properties @I Styles EIHierarchy

The "constrained elements” field contains the names of the modeling elements it has been assigned to. For
example, in the image above, Constraintl has been assigned to the following properties: interestRate,
interestRateOnBalance, interestRateOnCashAdvance.

51.9 Hyperlinking Elements

You can manually create hyperlinks between most modeling elements (except lines) and any of the following:

e Other elements (either on the diagram or in the Model Tree)

e Diagrams

e Files external to the project (for example, PDF, Word, or Excel documents, graphics files, and so on)
e Web pages
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A single element can have one or more hyperlinks of any of the kinds mentioned abowe. In a diagram, elements
that contain hyperlinks can be easily recognized by the hyperlink icon [Z] that is visible next to them (either in
the right or left corer). To open the hyperlink target, right-click the hyperlink icon [Z] on the element and select
the target. If there is only one hyperlink defined, you can also click [Z1 and access the target directly.

(7] BankView

@] banks:Bank[*] {ordered}
@1 bankAPL:IBankAPI

% «constructore BankView(in banka&PlBankAP)
@'} collectBankAddressinfos(:boolean

@'} collectAccountinfos(:boolean

<% collectDataf:boolean

¢» getBalanceAtBank(in bankname:String):int
% getBalanceSumOfAlIBanks(kint

Class containing hyperiink s

Tip: As you navigate through the UModel graphical user interface, either with or without hyperlinks, you can

easily go back and forward between views by clicking the Back or Forward toolbar
buttons, respectively.

You can automatically generate hyperlinks between dependent packages and diagrams when importing source
code or binary files into a model, provided tha%)u selected the specific settings on the import dialog box. For

more information, see Importing Source Code and Importing Java, C# and VB.NET Binaries (03] Also, when
you generate UML documentation from the project, you can choose whether to include hyperlinks in the
generated output, see Generating UML documentation @ .

You can create hyperlinks not only from elements that appear in the diagram or in the Model Tree window, but
also from text within notes, as well as text in the Documentation window, as shown in the instructions below.

To create a hyperlink from an element:

1. Right-click an element on a diagram or in the Model Tree window, and select Hyperlinks | Insert/Edit
Hyperlinks from the context menu.

2. Click Add, and select a hyperlink kind (element, diagram, file, or a Web link).
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Edit Hyperlinks
Default name User defined name Address Add L4 | File Link
e e Web Link
Diagram Link

Dielete Link,
sEe Madel Link
Miove Up

tdove Down

Cancel

3. Do one of the following:
e To create a diagram or hyperlink, select the target element or diagram when prompted.
e To create a file hyperlink, click the Ellipsis button and browse for the target file.

Uhodel

File path:
! ..

[[] Make path relative to Bank_CSharp

Cancel

e To create a Web link, type the target address in the "Address" column of the dialog box, for
example:

Edit Hyperlinks

Default name User defined name Address Add k
http thttp:/fwvewaltova,com
Open Link,
Delete Link
bowve Up
kove Do

Carcel

4. Optionally, enter a custom link name in the "User defined name" column. If defined, this custom name
will be displayed in the UModel's graphical interface instead of the target path (or address).
To create a hyperlink inside a note:

e Select some text inside the note, right-click it and then select Insert/Edit Hyperlinks from the context
menu. The same instructions apply for text in the Documentation window.
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This is a hyperlink inside a note, |§1

To change or remove a hyperlink:

e Right-click the hyperlink icon [#] on the element (or the hyperlinked text), and use the appropriate
command in the "Edit Hyperlinks" dialog box.

5.1.10 Documenting Elements

You can add documentation comments to modeling elements as follows:

e Click the element (either in the diagram or in the Model Tree window).
e Enter text in the Documentation window.

Any documentation text will be saved together with the project.

When an element is selected, its documentation is visible at all times in the Documentation window, if
available. You can also display documentation as a comment on the diagram, as follows:

¢ Right-click the element on the diagram, and select Show | Annotating Comments from the context
menu.

Documentation hyperlinks
To create a hyperlink inside the Documentation window, select some text inside the window, right-click it and
then select Insert/Edit Hyperlinks from the context menu. The hyperlink target can be a Web site, a diagram,

a file, or another element, see also Hyperlinking Elements “&#

Documentation =
IThis is some documentation text which
contains a hypedink.

Documentation window

Code generation and documentation comments

If you generate code from class diagrams, any comments applied to classes and their members (in class
diagrams) can be exported to the generated code as well. To do this, select the check box Write
Documentation as Java Docs (for Java) or Write Documentation as DocComments (for C#, VB.NET)

before generating program code, see also Code Generation Options @
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Likewise, if you reverse engineer program code into a model, the code comments can be imported into the
model. To do this, select the check box JavaDocs as Documentation (for Java) or DocComments as
Documentation (for C#, VB.NET) before reverse engineering program code, see also Code Import Options (103 3

For information about how comments in program code (or XML schemas) map to UModel comments, refer to
the mapping tables for each language:

C# Mappings
VB.NET Mappings
Java Mappings

XML Schema Mappings@

5.1.11 Changing the Style of Elements

You can change the appearance (style) of modeling elements, including their color, font size, font weight,
background color, line thickness, and others. The appearance of elements can be changed at various lewels:
globally for all elements in the project, selectively for all elements of the same family (for example, classes), or
for each individual element. For information about changing the style of the diagram itself, see Changing the

Style of Diagrams.

If you would like to use custom images instead of conventional element representations in diagrams, this is
possible by extending your pro!ezst with custom profiles and stereotypes. For more information, see Example:

Customizing Icons and Styles
To change the appearance of elements:
1. Click the element on a diagram.

2. Notice the dropdown list at the top of the Styles Window and do one of the following as applicable:
a. To edit the properties of the current element only, select "Element Styles" from the list.

Styles x
Element Styles e
Head > A
Head hdl
Head |
Header Font-Weight |

Color £CTFEET 1 =53
Pen Colo Llﬁ
Font Colo Llﬁ
Font LI L

=] Properties @St_r.rles ElHierarch],-‘

b. To edit the properties of all elements of the same kind (for example, classes), select "Element
Family Styles" from the list.

c. To edit the properties of all elements globally at the project level, select "Project Styles".

d. To edit the properties of all lines in the project, including association, dependency, and realization
lines, select "Line Styles". (This value is only visible if the currently selected element is a line.)

e. To edit the properties of all elements that are not lines (the so-called "nodes") across the project,
select "Node Styles". (This value is only \isible if the currently selected element is not a line.)
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3. Change the value of the required property (for example, "Fill Color").

A more specific style overrides a more generic style. That is, styles applied at individual element level
override those applied at element family lewel. Likewise, styles applied at element family level override
those applied at project level.

When a style is overridden, a small red triangle appears in the upper-right corner of the overridden property.
Movwe the cursor over the triangle to display a tooltip with information about style precedence.

Styles *

Project Styles ( o Infor:
‘Elerment Styles’, 'Element Family Styles' override this setting

nt-Weight Id |

o white —1 LI@

Trans. Fill Color LI@
olor £525252 HEEE ~ |53

t Color black I LI@

Font Seqoe Ul Ed W

[=] Properties @St_l.rles EIHierarch}-'

Overridden element style
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5.2 Diagrams

5.21 Creating Diagrams

Diagrams represent visually how modeling elements interact, what is their structure, dependencies, hierarchy,
and so on. Diagrams must belong to a package in the project, and therefore must be created under an existing
package in the Model Tree window. You can mowve diagrams from one package to another at any time, by
dragging them into a destination package.

To create a new diagram:

1. Right-click a package in the Model Tree window®.
2. Select New Diagram | <Diagram Kind>.

You can also create a new diagram from the Diagram Tree window@, as follows:

1. Right-click the root node ("Diagrams") in the Diagram Tree window.
2. Select a package where the diagram should belong, and click OK.

When the diagram window is active, the toolbars display only modeling elements applicable to the current
diagram kind. The diagram kind is displayed in the Properties window after you click an empty area of the
diagram. In addition to this, the following icons depict the diagram kind.

Icon | Description

[l Activity Diagram

] BPMN 1 (Business Process Modeling Notation) Business Process Diagram
CH BPMN 2 Business Process Diagram
CH BPMN 2 Choreography Diagram

#1 | BPMN 2 Collaboration Diagram

1 | Class Diagram

E Communication Diagram

2] Component Diagram

= Composite Structure Diagram

& Database Diagram

& Deployment Diagram

|E_-§| Interaction Overview Diagram

= Object Diagram
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Icon | Description

= Package Diagram

Profile Diagram

= Protocol State Machine Diagram
= Sequence Diagram

2] State Machine Diagram

i SysML diagrams (9 diagram types)
E2 | Timing Diagram

il Use Case Diagram

Fsl | XML Schema Diagram
5.2.2 Generating Diagrams

In addition to creating diagrams from scratch, you can also generate certain diagrams automatically from
existing modeling elements or from program code. This topic shows you how to generate diagrams from
existing modeling elements. For information about how to generate diagrams from source code, see:

e Generating Class Diagrams@
e Generating Sequence Diagrams from Source Code@
e Generating Package Diagrams While Importing Code or Binaries

To generate diagrams from existing elements, right-click an element (for example, package) in the Model Tree,
and then select Show in new diagram | <option> from the context menu. Below are some examples:
To create a diagram which shows the contents of an existing package:
¢ Right-click a package in the Model Tree window and select Show in new Diagram | Content from
the context menu.
To create a diagram which shows the dependencies of an existing package:
e Right-click a package in the Model Tree window and select Show in new Diagram | Package
dependencies from the context menu.
To create a diagram which shows the generalization hierarchy of a class:
1. In the Model Tree window, right-click a class which has generalization relationships to or from other

classes (for example, class Account from the sample project C:
\Users\<username>\Documents\Altova\UModel2024\UModelExamples\Bank_CSharp.ump).
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Model Tree

B[ % com
L@l altova

El v bankview

-------- [ BankView Main
-------- [ Hierarchy of Account
-------- [ sample Accounts
-[# B AgencyBank

- E John's 1st

-F B John's 2nd

- E John's 3rd

-F B Account

-F B Bank

-F B BankView

-FH B CheckingAccount
-F B CreditCardAccount
-[F B savingsAccount

L

Ell"-ﬂﬂdElTrEE EDiagram T... %% Favorites

2. Select Show in new diagram | Generalization hierarchy from the context menu. A dialog box
appears where you can adjust the preferences for the diagram to be created, including the diagram
type. Notice the text "N diagram-items", which displays the number of items that are to be added to
the diagram. In the example below, the chosen diagram type is "Class Diagram" and there will be four
diagram items (classes) on the diagram: the Account class and three classes derived from it.

Mew Hierarchy Diagram

Diagram Mame: Higrarchy of Account

Diagrar Type: | Class Diagram

Create hyperlink to diagram
Style

Show Attibutes compartment

[ 1 5how Operations compartment

[] Show nested Classifiers compartment
[ ] 5how EnumerationLiterals compartment

[ ] 5how Extension Points compartment

[ 5how Tagged Yalues

- [4 diagram-itemnz)

Autolapout
Atolayout

hierarchic

IJze own compartment for [MET properties

[ ]5how MET property compartment

Cancel

3. Click OK. The diagram is generated according to the selected options and opens in the Diagram

window, for example:
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pkg ban kl.rl'ew) ;

(2] Account

&1 balance:float
g id:string

i

CreditCard Account

SavingsAccount

@1 creditlimit:float
@] interestRateCnBalance:float
@] interestRateCnCashAdvance:float

CheckingAccount |

g1 interestRate:float
@] minimumBalance:float=10000

5.2.3 Opening Diagrams

If the UModel project contains diagrams, these are displayed in the Diagram Tree window.

Diagram Tree =
¢ Diagrams

------- [E Account Transfer

....... [E] Apply Csharp Profile

....... [El] BankAPI Draft

....... [ BankView Main

------- &7 BankView realization

------- rE'I Collect Account Information
....... [l collectData Draft

------- [ Connect to BankAPI

....... [ Deployment

....... [ Hierarchy of Account

....... =7 Overview

------- E™ Overview Account Balance
....... =] Query BankServer Draft

....... [@ Sample Accounts

EI Model T..| & Diagra... ‘%} Favarites

Diagram Tree window

By default, diagrams are grouped by type in the Diagram Tree window. To display only diagrams

Note:
(without parent groups), right-click inside the window and clear the Group by diagram type context

menu option.

Diagrams are also displayed in the Model Tree window under the packages where they belong, for example:
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Model Tree x

Root

Behavior View
Component View
Deployment View
Design View

HEE s

o ] Owerview
Account Transfer
c# Banking access
- c# BankView
E--?&:}F-‘:Iﬁtl-:-l‘u-
-H Interaction View
H Use Case View
1 [« 7] C# Profile [C# Profile.ump]

Ell"dndel EDiagra... %% Favaorites

To open an existing diagram:

e Double-click the diagram icon in the Model Tree window (or in the Diagram Tree window, or in the
Faworites window).
¢ Right-click the diagram, and select Open diagram from the context menu.

524 Deleting Diagrams

UModel diagrams can be deleted in one of the following ways:

¢ In the Model Tree window (or Diagram Tree window, or Favorites window), right-click the diagram, and
then select Delete from the context menu.
e Click the diagram in any of the windows mentioned abowe, and then press Delete.

Deleting a diagram does not remowve any elements from the project except the diagram itself. To check if
elements are used in any diagrams, right-click the package you would like to inspect, and select List
elements not used in any diagram, see also Checking Where and If Elements Are Used @

For information about deleting elements from a diagram or from a project, see Deleting Elements @

5.2.5 Changing the Style of Diagrams

You can change the appearance (style) of a diagram, including the background color, grid visibility, grid size
and color, as well as the appearance of the diagram heading. You can either change the style of individual
diagrams in the project, or apply the same properties to all diagrams in the project. For information about
changing the style of elements inside a diagram, see Changing the Style of Elements @D
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The size of diagrams is defined by elements and their placement. To enlarge the diagram size, drag an element

to one of the diagram edges and the size will adjust accordingly.

To change the appearance of diagrams:

1. Open a diagram (see Opening Diagrams ).

2. Notice the dropdown list at the top of the Style Window and do one of the following as applicable:
a. To edit the properties of the current diagram only, select "Diagram Styles" from the list. This value
is selected by default if you click anywhere where the diagram background is empty (that is, when

you do not click any diagram elements).

Styles

Diagram Styles

L2|¥]

sund Colo white C =153

La|¥]

e[« )l |1«

[=] Properties @Styles EIHi-‘:rar-:h;-‘

b. To apply changes to all diagrams in the project, select "Project Styles". In this case, scroll down
to the end of the Styles window until you find the styles applicable to diagrams (that is, the ones

that begin with "Diag.").

3. Change the value of the required property (for example, "Diagram Background Color").

Styles applied at diagram level override those applied at project level.

When a style is owverridden, a small red triangle appears in the upper-right corner of the overridden property.
Movwe the cursor over the triangle to display a tooltip with information about style precedence.
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Styles O Info:
Project Styles Diagram Styles' override this setting
Drraw Mirrored 5e hdl h
Diag. Background Color gradient |
Diag. Grid Color black I ﬂﬁ
Diag, Show Grid true |
Diag. Snap to Grid true |
Diag. Grid Size 15 |
Diag, UML Heading abbreviated |
W
=l Properties @ Styles El Hierarchy

Overridden diagram style

The following diagram-specific properties are available as toolbar buttons. Changing the property in the Styles
window will update the state of the toolbar button, and vice versa.

Show grid Shows or hides the diagram grid.
] | show diagram Shows or hides the diagram heading.
heading
44 | Snap to grid When enabled, this property makes all elements adhere to the grid. When
disabled, elements are positioned regardless of the grid pattern.

5.2.6 Aligning and Resizing Modeling Elements

You can change the size of elements on the diagram as follows:

1. Click an element on the diagram. A set of black dots appear at the element's edges.

1 .
#"'F-- -“""‘l-.._
# s
F UseCase “
o= ¥
I_l‘
%, extension points ¢
b

”
. f'

. """-1--""" &=

2. Drag any of the black dots into the direction where you want the element to grow.
To reset the element size to its default boundaries, do one of the following:

e Click the Enable Autosize icon at the lower-right corner of the element.
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] i ]
—_—
-
‘ﬁ

*#,—-- .
P B
Fs UseCasel N
::E"... -
%, extension points | Enable Autosize

et

e

¢ Right-click an element on the diagram, and select Autosize from the context menu.
e Select one or more elements. On the Layout menu, click Autosize.

When at least two modeling elements are selected on the diagram, they can be aligned in relation to each
other (for example, both can be aligned to have the same horizontal or vertical position, or even size). The
commands which align or resize elements are available in the Layout menu and in the Layout toolbar.

Sl fped &ak HTD B BOE O EE P

Layout toolbar

When you select several elements, the element that was selected last serves as a template for the
subsequent align or resize commands. For example, if you select three class elements and run the Make
same width command, then all three will be made as wide as the last class you selected. The element
that was selected last always appears with a dashed border.

The commands specific to element alignment and resizing are as follows:

Icon Command Notes

o Align left

o8 Align right

[T Align top

ﬂ Align bottom

o Center vertically

dla Center horizontally

H Space across This command is available when three or more elements are
selected. It distributes the horizontal space evenly between
selected elements.

a Space down This command is available when three or more elements are
selected. It distributes the vertical space evenly between selected
elements.

g1 Line up horizontally This command repositions all selected elements on the diagram
so that they are arranged horizontally one after the other.
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Icon Command Notes

iy Line up vertically This command repositions all selected elements on the diagram

so that they are arranged vertically one after the other.

Make same width
Make same height
Make same size

You can also automatically layout all elements in the diagram, as follows:

e On the Layout menu, click Autolayout All and choose one of the following options: Force Directed,
Hierarchic, or Block.

Force Directed Displays the modeling elements from a centric viewpoint.

Hierarchic Displays elements according to their hierarchical relationships. For example, a
superclass will be placed abowe any of its derived classes.

The hierarchical layout options can be customized from the Tools | Options
menu, View tab, Autolayout Hierarchic group.

Block Displays elements grouped by element size in rectangular fashion.

5.2.7 Adding Layers to Diagrams

By default, a diagram consists of a single layer—this layer stores all the elements \isible on the diagram
canvas. However, you can optionally add multiple layers to a diagram. With layers, you can make logical
groupings of modeling elements within the same diagram and thus separate concerns. For example, you can
create, in addition to the default layer, some extra layers that would store notes with some internal information,
or unfinished classes. Layers can be viewed and managed from the Layer window.

Layer X
82X @B [

& &/ pefautt (5)
@| & notes (1)

EE Wark in progress [0}

Overview Documentation % Layer

Layer window
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In the image abowe, three layers are defined on the diagram. The layer "Notes" is currently selected. The third
layer, "Work in progress”, is currently locked. The number displayed in the brackets to the right of each layer
denotes how many elements each layer has.

Any UML element can be assigned to any layer. By default, new elements are added to the currently active
layer, which is highlighted in the Layer window. If all layers are \isible, you can create relationships such as
association, generalization, etc between elements on different layers.

When printing diagrams or saving them to an image, only elements from the currently visible layers are printed.
The maximum number of layers per diagram is 20.

The buttons available in the Layer window have the following purpose:

Icon

Command

Notes

Append layer

Appends a new layer to the current layer list, and assigns a default name
which you can change immediately or through the context menu option
"Rename".

Insert layer

Inserts a new layer above the currently active layer in the layer list.

Delete layer

Deletes the currently active layer. Before the layer is deleted, a dialog box
opens asking where the current layer's items (if any) should be moved
(merged).

Focus previous on
active layer

Selects the previous element on the currently active layer. This command is
enabled only if the layer contains elements.

Focus next on
active layer

Selects the next element on the currently active layer. This command is
enabled only if the layer contains elements.

Layer item count

Shows or hides the count of elements in each layer.

Reset all layer
states

Sets all layers to visible and unlocked state.

Some of the commands above are also available as context menu items, when you right-click inside the Layer

window.

To move elements from one layer to another:

Right-click the element on the diagram and select the Layer | <layer name> command from the
context menu. This command is also applicable after you selected multiple elements; in this case, all
of them will be moved to the destination layer.

Alternatively, select one or more elements on the diagram and drag them onto the destination layer in

the Layer window.

To movwe all elements of a layer into a different one, right-click the layer, and select Merge To | <layer
name> from the context menu.
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To show, hide, or lock individual layers, or multiple layers at once:

¢ Right-click the layer in the Layer window, and select the Show, Hide, or Lock command, respectively.
The submenu commands Selected layer and Others let you toggle the command either for the
currently selected layer, or for all layers except the one currently selected.

e Alternatively, right-click the layer, and use the Toggle Visibility or Toggle Lock commands,
respectively. This will hide the layer(s) if they were previously shown, or lock them if they were
previously unlocked (and vice versa).

5.2.8 Type Autocompletion in Classes

When you add operations and attributes to a class, autocompletion of data types is enabled by default in
UModel. This makes it possible to specify the data type of the operation or property directly on the diagram, for
example:

1. Right-click a class, and select New | Operation from the context menu.
Type the name of the operation after the double angle brackets << >>, and then type the colon (: )
character.

3. An autocompletion window is automatically opened.

R R .
1 Account -:I_:‘ _
EE:‘§|1 <= > Balance:f T
o omesmsssses e pe | Name Mamespace Si... |
R B File Unknown Externals A
B FileDescriptor Unknown Externals
B Finalizer Java Lang::java:lang::re
B FinalizerThread Java Lang::java:lang::re
B FinalReference Java Lang::java:lang::re
v

Autocompletion window

The autocompletion window has the following features:

e Clicking a column name sorts the window by that attribute in ascending or descending order.

e The window can resized by dragging the bottom-right corner.

¢ The window contents can be filtered by clicking the respective filters (categories) at the bottom of the
window: Class, Interface, PrimitiveType, DataType, Enumeration, Class Template, Interface Template,
DataType Template.
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To enable only one of the filters at a time:
e Click the Single mode button g5 The image above shows the autocompletion window in "multi-
mode", that is, all filters are enabled. The single mode button is not enabled.
To select or clear all filters simultaneously:

e Click the Set All Categoriesa‘:’: or Clear All Categories o buttons, respectively.

To disable autocompletion:

1. On the Tools menu, click Options, and then click the Diagram Editing tab.
2. Clear the Enable automatic entry helper check box.

To trigger autocompletion on demand (when it is disabled):
1. Make sure that the cursor is inside an attribute or operation of a class, after the colon ( : ) character.

2. Press Ctrl+Space.

5.2.9 Zooming into/out of Diagrams

To zoom into or out of a diagram, do one of the following:

¢ Run the menu command View | Zoom In (Ctrl+Shift+l) or View | Zoom out (Ctrl+Shift+O).
e Select a predefined percentage value from the Zoom toolbar.

100% - _

v

e Hold down the Ctrl key while rotating the mouse wheel.

To fit the diagram area to the visible window:

¢ Run the menu command View | Fit to window (or click the Fit to window toolbar button).
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5.3 Relationships

5.3.1 Creating Relationships

A relationship typically needs two elements, so your diagram must already contain the elements between
which you want to add relationships. You can create relationships as follows:

1. By using a toolbar button that depicts the relationship you need (for example, Association ).
2. By using handles that appear when you click on any element on the diagram.

Creating relationships using toolbar buttons

When a diagram window is active in UModel's main pane (in focus), the toolbar displays all the elements and
relationships supported by that diagram. For example, a Class diagram provides toolbar buttons for all

supported relationships, including Association , Collection Association , Aggregation , Composition

, Realization , Generalization , and others. Likewise, a Use Case diagram provides toolbar buttons for
I

Associations , Generalizations , as well as Include and Extend relationships.

The instructions below illustrate how to create an association relationship between an actor and a use case.
Use the same approach for other relationships you might need.

Click an element on the diagram (actor "Standard User", in the image below).

Click the toolbar button corresponding to the relationship you need (Association , in this example).
3. Mowe the mouse over "Standard User" and drag onto a target element ("get account balance" use
case). Note that the target element is highlighted in green color and accepts the relationship only when
it is meaningful according to UML specifications.

N —

pkg Use Case View |

_Standard User

./ get account balance

Association in a Use Case diagram

Creating relationships using handles

When you click an element on a diagram, several handles may appears to the left, right, top, or bottom of the
element. The handles appear only for elements which support relationships. Each handle corresponds to a
relationship kind. For example, class elements have the following handles:
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InterfaceRealization
Generalization
Association

Collection Association

To view the relationship kind that each handle creates, move the mouse over the handle. For example, in the
image below, the selected top handle can be used to create a Generalization relationship.

Generalization

O-E: SavingsAccount
=L —
R ofu

To create the relationship, click the handle and drag the cursor over a destination element. This creates the
corresponding relationship (Generalization, in this case).

Account

SavingsAccount

Generalization relationship between two classes

5.3.2 Changing the Style of Lines and Relationships

You can change the thickness, color, and bending style of lines from the Styles window. You can also add text
(labels) to relationships, reposition labels, and hide/show labels on the diagram either individually for each
relationship or in batch.

Note: In the instructions below, it is important to distinguish between "lines" (any line on the diagram) and

"relationships" such as association, generalization, composition, and so on. All relationships are lines,
but the opposite is not true. For example, a comment or note link is just a line, not a relationship.

To change line properties:

1. Click a line on the diagram.
2. Inthe Styles window, set the required property (for example, "Line Thickness").
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Styles X
Project Styles W

ested Classifier Fom|11 | s

2 Classifier Forn/normal |

2 Classifier Sort|/no sort |
LutoSize true |

Line Style ‘rectangular x|

Line Thickness 1 |

Ise Syntax Coloring [true x|

5C Stereotypes olive v Ch
SC Name £3F3F3F EEE v 5D
5C Type teal [ KAL)
5C Multiplicity navy AR
=] Properties @ Styles El Hierarchy

The values available for the "Line Style" property are also available as commands under the Layout | Line
Style menu, and as toolbar buttons. If you change this property, the corresponding toolbar button will become
enabled, and vice versa.

Orthogonal line A line with this style will only bend at straight angles.

Direct line A line with this style will make a direct connection between two elements,
without any waypoints.

Custom line A line with this style can bend at any angle. To move the line, drag any
waypoint (small black dots) on the line. To create new waypoints, click in
between two existing waypoints, and drag the line. To delete waypoints,
drag a waypoint directly on the top of an existing one.

Line styles, just like other element styles, can be set for each individual line, or at a more generic level
(project level, for example). The more specific style overrides the generic one. When a style is overridden,
this is indicated by a red triangle next to the affected property in the Styles window, see also Changing the
Style of Elements @D

To add label text to a relationship:

e Click a relationship on the diagram, and start typing.

To move the label text:

e Click the label, and the drag it to some other position on the diagram.
e To mowe the label back to the default position, right-click the relationship, and select Text Labels |
Reposition Text Labels from the context menu.
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e To reposition multiple labels simultaneously, select one or more relationships on the diagram, and then
run the menu command Layout | Reposition Text Labels.

To show or hide the label text:

¢ Right-click the relationship, and select Text Labels | Show/Hide all Text Labels from the context
menu.

5.3.3 Viewing Element Relationships

By default, the relationships of an element are visible in the Model Tree window under that specific element. For
example, the checkingaccount class illustrated below has a Generalization relationship with the account
class:

Model Tree b4

IE Account A
IE Bank
E BankView
-3 B CheckingAccount

-------- «» CheckingAccount

@ O collectAccountinfo

El =, Relations

i —p Generalization: [Account]

-F B CreditCardAccount
-F B SavingsAccount

- = Relations hd

E|M::udEITrEE EDiagramTree 2% Favorites

Relationship in the Model Tree window

Note: To hide relationships from the Model Tree window, right-click inside the window and clear the Show
Relations in Tree option.

To show the relationships of an element on the diagram, right-click the element on the diagram, and select
Show | <relationship kind> from the context menu.

5.34 Associations

An association is a conceptual connection between two elements. You can create association relationships
like any other relationship in UModel, see Creating Relationships ®,

When you create an association between two classes, a new attribute is automatically inserted in the
originating class. For example, creating an association between car and Engine classes adds a property of
type Engine to the Car class.
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Car

Engine

@] Propertyl:Engine

#Propertyl

When a class is added to a diagram, its associations are shown automatically on the diagram, provided that

the following conditions are met:

e The option Automatically create Associations is enabled from Tools | Options | Diagram Editing

tab.

e The attribute's type is set (in the image above, Propertyl is of type Engine)
e The class of the referenced "type" is also present in the current diagram (in the image abowe, the class

Engine).

You can also explicitly show the class properties of any class as associations on the diagram. To do this,

right-click a class property, and select one of the following commands:

e Show | <Property> as Association

e Show | All Properties as Associations

When you click an association on the diagram, its properties can be changed, if necessary, from the

Properties window.

Properties X
name

qualified name

element kind Association

visibility public |
leaf |

abstract |
isFinalSpecialization|]

derived |

A name Propertyl

&: aggregation none |
A& memberEndKind |\memberEnd |
& multiplicity |
B: name

E: aggregation none |
BE: memberEndKind |ownedEnd |
B: multiplicity |
=] Properties @St}-‘les EIHierarch}-'

It is important to note the properties listed below. Modifying these properties changes the appearance of the
association on the diagram, or adds various informative text labels. For information about showing or hiding text
labels, or changing the appearance of the relationship (such as color or line thickness), see Changing the Style

of Lines and Relationships
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Property

Purpose

A: name

The name of the member on end A of the relationship. In the car example abowe, it
is Propertyl.

A: aggregation

Enables you to change the type of association on end A. Changing this property
will also change the representation of the association on the diagram. Valid
values:

none Denotes a normal association
shared Changes the association into an aggregation
composite  changes the association into a composition

A: memberEndKind

Attributes participating in a relationship can belong either to a class or to the
association. This property specifies who owns this end of the relationship and
whether this end of the relationship is navigable. ("Navigable" means that the end
has an "arrow" ending). Valid values:

memberEnd Member on this end belongs to the class.

ownedEnd Member on this end belongs to the association

navigableOwnedEnd Member on this end belongs to the association and

this end becomes navigable.

Setting both A and B ends to ownedEnd makes the association bi-directional.

A: multiplicity

Multiplicity specifies the number of objects at this end of the relationship. For
example, if a car has four wheels, multiplicity would be 1 on one end and 4 on the
other end of the relationship.

Car Fwheels Wheeal

@‘I wheels:Wheel[4]

The same set of attributes are available for end B of the relationship.

If enabled, the property Show Assoc. Ownership in the Styles window displays ownership dots for the
selected relationship. By default, this property is set to False. The following is an example of a class where
Show Assoc. Ownership is set to True:

Car

+ Engine

@‘I Property1l:Engine

#Propertyl
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Creating reflexive associations
Associations can be created using the same class as both the source and target. This is a so-called "self link",
or reflexive association. It may describe, for example, the ability of an ob'ehct to send a message to itself, for

recursive calls. To create a self link, click the association toolbar button =], then drag from the element,

dropping somewhere else on the same element.

CarOccupant
#passenger

driver:CarCicc t[1
@] river:CarCccupant[1] 0.4

#driver

Creating association qualifiers

Associations can be optionally decorated with association qualifiers. Qualifiers are attributes of an association.
In the example below, the association qualifier isbn specifies that a book can be retrieved from the list of books
by this attribute. To add a qualifier:

1. Create an association between two classes.
2. Right-click the association and select New | Qualifier.

Library - pr—
FDO0KIS
T
b e
§1 booklistBook[*] F—— >

To rename or delete association qualifiers, use the same steps as for all other elements, see Renaming,
Moving, and Copying Elements and Deleting Elements .

5.3.5 Collection Associations

A collection association relationship is suitable to illustrate that a class property is a collection of some
kind. For example, in the diagram below, the property colors of the class ColorBox is a list of colors. This
type is defined in this case as an enumeration; however, it may also be another class or even an interface.

ColorBox zenumeration=
Color
@] colors:List<T-> Colors ¢
#colors
RED
GREEM
BELUE
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Before you can create collection associations, the UModel project must contain the collection templates for the
project language you want to use (such as Java, C#, or VB.NET). Otherwise, a tooltip with the text "No
collections defined for this language" appears when you attempt to create the collection association.

Class1 Class2

I Rt S E— Mo collections defined for this language (UML Standard Profile)

If your project is UML only (without support for a specific code engineering language), you can define collection
templates from the menu Tools | Options | Diagram Editing | Collection Templates | UML tab.

If your project already contains a language namespace (such as Java, C#, VB.NET), the collection templates
are predefined from the profile of that language. Additional templates can be added from the menu Tools |
Options | Diagram Editing | Collection Templates.

To create a collection association (between two classes, for example):

Add two classes to the diagram.

Click the Collection Association toolbar button.
3. Drag from the first class and drop it onto the second class. The collection templates defined for the
project appear in the context menu, and you can select the required one.

N

Class1 Class2
-~  |—1

SystemuCollections: Generic:Comparer

System::Collections: Generic:EqualityComparer
System::Collections:Generic:Hash5et
System:Collections:Generic::KeyedByTypeCollection
SystemuCollections: Generic:LinkedList
System::Collections: Generic:LinkedListMode

System:: Collections:: GenericiList

System:Collections:Generic:Queue

SystemuCollections: Generic:Stack

Collection associations and code engineering

If you import program code into the model, collection associations are created automatically by default, based
on predefined collection templates. To enable or disable this option:

1. On the Tools menu, click Options.
2. Click the Diagram Editing tab.
3. Select or clear, as necessary, the check box Resolve collections.

Altova UModel 2024 Professional Edition © 2017-2023 Altova GmbH



How to Model...

Relationships 143

Local Options

When automatically adding tems on diagrams

Ask before adding more than | items
Style
Always show dialog before adding
Show Attributes compartment
Show Operations compartment
[ ]5how nested Classifiers compartment
[ ] Show EnumerationLiterals compartment
[] Show ExtensionPoints compartment
[ ]5how Tagged Values
|se own compartment far MET properties
[ ]5how MET properties compartment

View  Editing Ciagram Editing  File Code Engineering  Source Contral  Scripting

When adding tems on diagrams

Automatically create Associations
Also for MET properties

Associations to collections

Resolve collections

Unknown e:-:te!'ljals:
resolve unqualified

Collection templates. ..

Reset existing Associations. ..

Autocompletion

Enable automatic entry helper

Cancel Apply

The collection associations are resolved by default based on a list of built-in collection templates. To view or
modify the built-in collection templates, click Collection Templates.

To insert custom collection types, use the Append, Insert, or Delete buttons available in the dialog box
below. The column Par.Pos. denotes the position of the parameter which contains the value type of the

collection.
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Collection Templates

Java  CH B LML

Append
Template Mame Par.Pos. Y
javanutib:ArrayList
" . . |nigert
javanutil:AbstractList
javanutil:AbstractCollection

Delete

javanutil:AbstractSet
javanutik:AbstractQueue
javanutil:Collection
javanutil:HashSet
javanutil:LinkedList
javanutil:List
javanutik:Queue
javanutil:Set
javanutil:Vector
javanutil:AbstractMap
javanutil:Dictionary
javanutil:HashMap
imvA kil Hashtahkla

Set Defaultz

Cancel

(O SR T U O N T R I U R I T U U I RIS QU

Collection Templates dialog box

To reset the collection templates to their default values, click Set default.

5.3.6 Containment

A containment line is used to show, for example, parent-child relationships between two classes or two
packages.

To illustrate containment between two classes:

1. Click the Containment toolbar button (in a class or package diagram).
2. Drag from the class that is to be "contained", and drop on the container class.

Car Engine

EH Engine

Note that the contained class, Engine in this case, is now visible in a compartment of car. This also places
the contained class in the same namespace as the container class.
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5.4 Stereotypes and Tagged Values

A stereotype is an extension mechanism; it is intended as a flexible way to extend an existing UML element
and capture some aspect of it that standard UML doesn't. Stereotypes applied to an element signify that that
element has some special use. The UModel built-in profiles (C#, Java, VB.NET, and so on) contain all the
stereotypes required to model projects in the respective languages. However, you can also create your own
profiles (and their respective stereotypes), see Creating and Applying Custom Profiles @

When you import source code or binaries into the model, UModel applies stereotypes to elements
automatically, based on the structure of the original code. For example, if annotations modifiers exist in the
imported Java source code, the corresponding elements in the model get the «annotations» stereotype. For
information about how various language constructs map to UModel elements and become stereotypes in the

model, see UModel Element Mappings.

You can also apply stereotypes to elements manually, while modeling them. For example, you can apply the
«attributes» stereotype to a C# class, which would indicate that the class must be decorated with attributes
in generated code. To specify the attribute values in the generated code, you can add so-called "tagged values"
in UModel, as shown in Applying Stereotypes @ Stereotypes are also used extensively in XML schema
modeling, to model elements such as simple types, complex types, facets, and so on. Likewise, stereotypes
are used in database modeling, to model elements such as tables, columns, indices, and so on, see Designing

Database Objects @.

Across the UModel graphical interface, stereotypes are displayed enclosed within guillemets (for example,
«static»). All stereotypes included into the built-in UModel profiles appear in the Properties window when you
click an element. For example, clicking a Java class in the Model Tree would display in the Properties window
only class stereotypes applicable to the Java profile (in this example, «annotations», «static», «strictfp»).

Properties X
name BankWView

qualified name Design View::BankView
element kind Class

visibility public x|
leaf O

abstract O

isFinalSpecialization  |[]

active O

code file name BankView.java

code file path CAUML_Bank_Sample'Ja
zannotations: O

wstatics O

wstrictfps ]

=] Properties @ Styles El Hierarchy

In class diagrams, stereotypes are visible above the name of the class. For example, the class below has the
«attributes» stereotype applied to it.
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cattributess
Account

@] Balance:decimal

<% aconstructors Account()
<% Calculatelnterest:decimal

In case of methods or properties, stereotypes are displayed inline, like the «constructor» stereotype applied
to the Account() method in the class above.

5.4.1 Tagged Values

Stereotypes may hawe attributes (tagged values) associated with them. Tagged values are name-value pairs
that provide extra information related to the stereotype where they belong. For example, the class illustrated
below has the stereotype «attributes» applied to it. Notice that the «attributes» stereotype has tagged
values associated with it: a key (name) called "sections" and a value called "Serializable".

wattributess
sections = Serializable

=attributes=
SavingsAccount

@] Balance:decimal

¥ wconstructors SavingsAccount]
<% Calculatelnterest():decimal

Tagged values

A stereotype may have multiple pairs of tagged values. Also, a value can be selected from a set of enumeration
values.

| einfos =y
«Infox 4 Usability = 75% |
DemoClass [~ lisObsolete = No i
wEE Yes
Mo

You can change how t%ged values are displayed on the diagram, or hide them altogether, see Showing or
Hiding Tagged Values " For information about changing a stereotype's tagged values, see Applying
Stereotypes . For an example that illustrates how to create stereotypes with tagged values, see Example:

Creating and Applying Stereotypes
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5.4.2 Applying Stereotypes

By applying a stereotype to an element, you indicate that the element has some specific use. In case of code
languages supported in UModel (such as C#, VB.NET, Java), you typically apply stereotypes in order to
comply with the grammar of that language. For example, a Java class may have the «static» stereotype

applied to it.

Before you can apply stereotypes, the corresponding profile must be applied to your package(s) first. This
is done automatically by UModel if you right-click a package and select the Code Engineerin%Set as
{language} namespace root command. For more information, see Applying UModel Profiles “=.

If you created custom profiles, these must be applied manually to the package, see Creating and Applying
Custom Profiles @@

To apply a stereotype to an element:

1. Click the element in the Model Tree window. If the element can be extended by any stereotypes, they
appear as properties in the Properties window, enclosed within guillemets ("«" and "»").
2. Select the stereotype's check box in the Properties window (for example, «static»).

You can also apply stereotypes while designing elements inside a class diagram. To do this, click a property of
a class and start typing text inside the "<< and ">>" characters.

i- zattributess -i
[ Account :
E|' i
i s
oqipl. = v
I < » wcgnew nt) b
1 ¢y callinternal cimal §
e nullable iy |

const

attributes
unsafe

volatile
privateProtected

Some stereotypes are associated with a list of name-value pairs referred in UML as "tagged values". To apply a
stereotype with tagged values to an element, select the stereotype's check box in the Properties window (in
this example, «attributes»). This adds an indented entry where you can select the required value from a

predefined list.

© 2017-2023 Altova GmbH Altova UModel 2024 Professional Edition



148 How to Model... Stereotypes and Tagged Values

Properties X
wstructs | "
adelegates |
sattributess

sections

zinternal= Attributelsage LY
LN CLSCompliant
wstatics ContextStatic
aprivateProtecteds Flags W

. LoaderZptimization —
=] Properties | 53 S ATAThread
MonSerialized

Obsolete
ParamArray

Serializable bl

Tagged values

You can also add multiple values to the same key. To do this, right-click the idented entry, and select Add
Tagged Value | <name> from the context menu.

Properties =
code file name A
code file path
wstructs O]
zdelegates |
sattributess
sections Serializable .
i — |:| ............................ i ' sections
B | Femove Tagged Value

[=] Properties @l Styles | El Hierarchy

Alternatively, you can add tagged values directly from the diagram, by right-clicking a value, and selecting New
| Tagged Value from the context menu.

I wattributess =i
i Lsections = Serializable 2
«attributess —,1-_—" -| Mew b|| Tagged Value ”
SavingsAccount r
- Show 4
@1 Balance:decimal ) )
Show/Hide Mode content.., Ctrl+5hift+H
(} zconstructorz SavingsAccount(
¥ Calculatelnteresti):decimal d Cut Ctrl+X
Copy Ctrl=C
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54.3 Showing or Hiding Tagged Values

When an element has tagged values, you can view all the respective tagged values either in a standalone box,
or inline, as a compartment. You can also hide tagged values completely. To choose how tagged values should
be displayed, right-click the element on the diagram, and select Tagged Values | <display option>. For
example, to display all tagged values outside of the class, right-click the class on the diagram, and select
Tagged Values | all. To hide all tagged values of a class, right-click the class on the diagram, and select
Tagged Values | none.

wattributess
sections = Serializable

=attributes=
SavingsAccount

&1 Balance:decimal

% «constructors SavingsAccount])
™ Calculatelnterest(:decimal

Tagged values displayed outside a class

Toggle compact mode
When some values in a tagged values box are empty, you can hide only the empty values, as follows:

1. Select a tagged values box on the diagram (one that has both empty and non-empty values).

Class Drg[hart-&chemaJ
JESSccconnRRR
i - :
| block = substitution |
:final = restriction :
fixed = i
_,-""1 f::.urm = :
-~ '
[#] celements ' TE
OrgChart

2. Click the Toggle compact mode [5] handle in the bottom-right corner of the box.

When the handle is in expanded state El the empty values are shown as well. When the handle is in
collapsed state El the empty values are hidden.

Changing the display of tagged values globally

You can change the display of tag values either individually for each element as shown abowve, or globally at
project level.
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To change tag values at project level:

1. Select Project Styles from the list at the top of the Styles Window .

2. Scroll down until to the Show Tagged Values property and select the required option from the list (for

example, all, hide empty).

Styles

Project Styles

Show Parameter
Show Par.direction
Show Property Type

Show Expression bodies
Show ExtensionPoints

Show Tagged Values

Show Execution Specifications
Show ge Numbers
Show ge Parametars
Show Type Modifiers

Show Assoc, Ownership Dot

Show MET properties in own £

true ]|

true ]|

true ]|

Show expanded |

Show for all ]|

true ]|
el

element

element, hide empty

all

all, hide empty

Mamespace Display Mode in compartment

Show region names on states o

in compartment, compact

Draw Mirrored false

=] Properties @St_r.rles ElHierarch],-‘

For information about changing styles at various levels, see Changing the Style of Elements @

Possible display options

The possible options for controlling the display of tagged values are listed in the table below. These options are
similar when you change tagged values globally or for individual elements.

None

Hides all tagged values.

All

Displays the tagged values of an element (for
example, a class) as well as those of elements
owned by the class, such as attributes and
operations.

All, hide empty

Displays only those tagged values where a value
exists.

Element

Displays the tagged values of an element (for
example, a class) but not those of owned attributes,
operations, and so on.

Element, hide empty

Displays only those tagged values of an element
where a value exists.
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In compartment Displays the tagged values in a separate
compartment. For example, the class illustrated
below has an «attributes» compartment that contains

tagged values.

sattributess=
SavingsAccount

=Tttributes s

sections = Serializable

@] Balance:decimal

% «constructore Savingsaccount()
% Calculatelnterest(j:decimal

In compartment, hide empty Displays only those tagged values where a value
exists, in a compartment.

In compartment, compact Same as above.
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6 Projects and Code Engineering

This chapter provides information about creating UModel modeling projects (either new, or by importing data
from source code or binaries). It also describes various operations applicable to code engineering with UModel,
namely:

e Forward engineering (generating code from a UModel project)

e Rewerse engineering (importing source code into a UModel project)

e Roundtrip engineering (that is, synchronizing the model and code in either direction, as and when
necessary)

The menu commands applicable to code engineering are available in the Project menu. For example, the menu
command Project | Import Source Project enables you to import C#, or VB.NET Visual Studio solutions, or
Java code, and generate UModel diagrams based on it. When no project solution is available, use the menu
command Project | Import Source Directory, see Importing Source Code (Reverse Engineerin o} Java,
C#, and VB.NET binaries can also be imported, provided that a few basic prerequisites are met, see Importing
Java, C# and VB.NET Binaries @.

The code engineering operations above are applicable not only to programming languages but also to
databases and XML Schema. For example, you could use the menu command Project | Import XML
Schema File to reverse engineer an existing XML schema and automatically generate a class diagram based
on it.

For the list of mappings between UModel elements and elements in each supported language profile (including
databases and XML Schema), see UModel Element Mappings. For database connectivity instructions and
operations applicable to databases, see UModel and Databases S
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6.1 Managing UModel Projects

A UModel project acts as a container for UML modeling elements, diagrams, and various project-related
settings that you may define. UModel projects are saved as files with .ump (UModel Project File) extension.

UModel does not force you to follow any predetermined modeling sequence. You can add any type of model
element: UML diagram, package, actor etc., to the project in any sequence (and in any position). All model

elements can be inserted, renamed, and deleted in the Model Tree window itself, you are not even forced to
create them as part of a diagram.

6.1.1 Creating, Opening, and Saving Projects

When you start UModel for the first time, a new project is open automatically. On subsequent runs, UModel will
open the most recent project you worked with.

Note: UModel includes several example projects that you can explore in order to learn the modeling basics

and the graphical user interface. These can be found at the following path: C:
\Users\<username>\Documents\Altova\UModel2024\UModelExamples.

To create a new project:

e On the File menu, click New (or click the New toolbar button).

A new project with the default name NewProject1 is created. Also, the following packages are automatically
added to the project and visible in the Model Tree window.

e Root
e Component View

These two packages have special use and are the only ones that cannot be renamed, or deleted, as explained

in the tutorial, see Forward Engineering (from Model to Code)m.

Once the project is created, you can add modeling elements to it, such as UML packages and diagrams, see
Creating Elements @ and Creating Diagrams.
To add a new package:

1. Right-click the package under which you want the new package to appear (either Root or Component

View in a new project).

2. Select New Element | Package from the context menu.
Be aware that packages, as well as other modeling elements, can also be added from UML diagrams, in which
case they will appear in the Model Tree window automatically.

To add a new diagram:

¢ Right-click a package in the Model Tree, and select New Diagram.
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To add elements to a diagram:
o Do one of the following:

= Right-click the diagram, and select New Element | <Element Kind> from the context menu.
= Drag the desired element from the toolbar.

For a worked example of how to create a project and generate program code from it, see Forward Engineering

(from Model to Code)@.

To open an existing project:
e On the File menu, click Open, and browse for the .ump project file.
Note: By default, UModel registers any changes made externally to the .ump project file or included file(s),

and displays a dialog box asking you to reload the project. This functionality can be disabled from the
Tools | Options | File tab.

To save a project:
e On the File menu, click Save (or Save as).

All project relevant data is stored in the UModel project file, which has the extension *.ump (UModel Project
File).

Note: The *.ump file is an XML file format which can be optionally "prettified" on saving. Pretty-printing can be

enabled from the Tools | Options | File tab.

6.1.2 Opening Projects from a URL

In addition to opening local project files, you can also open files from a URL. The supported protocols are
HTTP, HTTPS, and FTP. Note that files loaded from URLs cannot be saved back to their original location (in
other words, access to the file is read-only), unless they are checked out from a Microsoft® SharePoint®
Server, as shown below.

To open a file from a URL:

1. On the Open dialog box, click Switch to URL.
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@ Open

g

Cuick access

Desktop

[ |
Libraries

L2

This PC

@

Metwork

Loak i_r1:| IIModelExamples v| ﬁ jl' s [

AP
Bank_MultiLanguage_CSharp
Bank_MultiLanguage_lava
Bmps
IDEPIugin
Scripting
StateMachineCodeGeneration
Tuterial

(% Bank_BPMN.ump

[ Bank_BPMNZ.ump

% Bank_CSharp.ump

% Bank_lava.ump

@ Bank_MultiLanguage.ump

@ Bank_MultiLanguage_Use Case View.ump

@ Bank_SysML.urnp

File name: || e |

Cpen

Files of type: UModel Projects (*.ump) W

Switch to LIRL

Cancel

2. Enter the URL of the file in the File URL text box, and click Open.
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Open *
File LIRL: hitp: /fexample. org/Mydh odelProject. ump w
File lnad
(®) Use cache/prosy () Beload
| dentification
User: | Password: | ] Remember pazzwaord

between application starts

Available filez
Semer URL: | R | Browse

[ ] Thiz is a Microsoft® SharePoint® Server

HMew Folder Delete

Switch ta File Dialog Cancel

If the server requires password authentication, you will be prompted to enter the user name and password. If
you want the user name and password to be remembered next time you start UModel, enter them in the Open
dialog box and select the Remember password between application starts check box.

If the file you are loading is not likely to change, select the Use cache/proxy option to cache data and speed
up loading the file. Otherwise, if you want the file to be reloaded each time when you open UModel, select
Reload.

For servers with Web Distributed Authoring and Versioning (WebDAV) support, you can browse files after
entering the server URL in the Server URL text box and clicking Browse.

Note: The Browse function is only available on servers which support WebDAV and on Microsoft SharePoint
Seneers.

If the senver is a Microsoft® SharePoint® Server, select the This is a Microsoft® SharePoint® Server check
box. Doing so displays the check-in or check-out state of the file in the preview area.
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Open >
File LIRL: hitp: /7 ‘Documentz/B ank_CSharp.ump w
File load
(®) Use cache/prosy (") Reload
| dentification
i i Remember pazsward
User. | Password: | 606868 | [ between application starts
Available files
Semer URL: |htt|:u:.n’.n" R | Browse
Thiz iz a Microzoft® SharePoint® Server
=W Documents *
- Forms
#-[im Reports
W] Bank_CSharp.ump
E ExpReport.sps | Check Out...
@ ExpReportxml Check In...
@ ExpReport xsd Unda Check Out.., ¥
Mew Folder Delete
Switch ta File Dialog Cancel

The state of the file can be one of the following:

[

Checked in. Available for check-out.

]

Checked out by another user. Not available for check-out.

e8| Checked out locally. Can be edited and checked-in.

To be able to modify the file in UModel, right-click the file and select Check Out. When a file is checked out

from Microsoft® SharePoint®, saving the file in UModel sends the changes back to the server. To check in the
file back to the sener, right-click the file in the dialog box above, and select Check In from the context menu
(alternatively, log on to the server and perform this operation directly from the browser). To discard the changes

made to the file since it was checked out, right-click the file, and select Undo Check Out (or perform this

operation from the browser).

Note the following:

e When afile is already checked out by another user, it is not available for check out.
e Ifyou check out a file in one Altova application, you cannot check it out in another Altova application.

The file is considered to be already checked out to you.
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6.1.3 Moving Projects to a New Directory

UModel projects and generated code can be easily mowved to a different directory (or a different computer) and
be resynchronized there. There are two ways to do this:

e Select the menu option File | Save As..., and click Yes when prompted to adjust the file paths to the
new project location.

Utodel

This project contains relative file paths.
Do you want to adjust all these relative paths to the new project file location?

E Yes ; Mo Make Absolute

e Copy the UModel project (*.ump) to a new location, and then adjust the code generation paths for each
component involved in code generation.

For an example of the second approach, open the following sample project: C:
\Users\<username>\Documents\Altova\UModel2024\UModelExamplesBank_Multilanguage.ump.

1. Locate the Bankview component in the Model Tree.

Model Tree 4

Root
A Behavior View
B Component View
-------- =7 Bank realizations
BankView
Component View [Bank Server.ump]
-------- Component View [Bank_MultiLanguage_
Component View [Banking access.ump]

il

Component View [BankView.ump]
@ £] BankView

A Deployment View

- Design View

-H Interaction View

- =7 JDK5.0 [Java [types only].ump]

A Unknown Externals

g Use Case View [Bank_MultiLanguage_Use ¢
[ [« 7] C# Profile [C# Profile.ump]

- [+ 7] Java Profile [Java Profile.ump]

< >

ElMUdElTrEE @DiagramTree ‘%Fav-:urites

2. In the Properties window, locate the directory property and update it to the new path.
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Properties 4
name BankView

qualified name Component View:Compo
element kind Component

visibility public bl
leaf O

abstract O

isFinalspecialization |
indirectlylnstantiated
code language Java5.0 1.5] bl
directory ChUsers\altova\Docum ...
use for code engineeri

[=] Properties @St}-‘les EIHierarchy

3. Re-synchronize the model and code.

6.1.4 Applying UModel Profiles

By default, whenever you start a new modeling project in UModel, the project is unaware of the business
application or code engineering language that you are going to need. Therefore, to tailor your UML project to a
domain or language, you must apply a profile to it.

One must distinguish between two types of profiles:

e Profiles built into UModel (these include C#, VB.NET, Java, BPMN 1.0, BPMN 2.0, SysML, and so
on).
e Custom profiles that you can create to extend UML to your specific domain or needs.

You can add any of the built-in profiles to your project by selecting the menu command Project | Include
Subproject. In addition, UModel prompts you to apply a built-in profile whenever you take an action that
requires that specific profile. For example, when you right-click some new package and select the Code
engineering | Set as Java Namespace Root context menu option, you are prompted to apply the Java profile
to it.

Utodel =

This command will include the UModel Java Profile and apply
it to the selected Package.
Do you want to continue?

Cancel

To view the full list of UModel built-in profiles or add them to your model manually, select the menu command

Project | Include Subproject. See also Including Subproiects.
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For instructions about creating custom profiles in order to extend or adapt UML, see Creating and Applying
Custom Profiles @.

6.1.5 Splitting UModel Projects

You can split UModel projects into multiple subprojects and thus allow several developers to simultaneously
edit different parts of a single project. Subprojects are like standard UModel project files and have the same
*.ump extension. Each individual subproject can be added to a source control system. The top-level project is
called the main project.

You can create a subproject from nearly any package in the main project. You can choose whether the
subproject should be editable from within the main project, or be read-only. In the latter case, the subproject is
editable only if you open it as a standalone project.

Subprojects can be structured in any way that you wish, in a flat or hierarchical structure, or a combination of
both. This makes it theoretically possible to split off every package of a main project into subproject files.

In the Model Tree Window, subprojects appear with the respective .ump file name displayed to the right,
enclosed within square brackets. For example, the project illustrated below includes several subprojects (this is
the Bank_MultiLanguage.ump from the C:
\Users\<username>\Documents\Altova\UModel2024\UModelExamples directory).

Model Tree x

Root
-H Behavior View
- Component View
- Deployment View
= Design View

-[| JAccount Transfer

-[# c#| Bank Server [Bank Server.ump]

-[F = Banking access [Banking access.ump)
- 2 BankView [BankView.ump]

-@ = Relations

H Interaction View

- [E1JDKS.0 [Java [types only).ump]

- Unknown Externals

A Use Case View [Bank_MultiLanguage_Use Case View.ump]
- [« 7] CF Profile [C# Profile.ump]

[ [« ¥]Java Profile [Java Profile.ump]

E|M::udEITrEE EDiagramTree 2% Favorites

During the code-engineering process, all subordinate components of a subproject are considered. There is no
difference between a single project file or one that consists of multiple editable subprojects. This also applies to
UML diagrams—they can also be edited at the main, or subproject, level.
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Note: You can also share packages and UML diagrams they %ht contain, between different projects. For
more information, see Sharing Packages and Diagrams 7.

Creating subprojects

To create a subproject, right-click a package, and select the command Subproject | Create new Subproject
from the context menu.

Create new Subproject

Eile path:
| BankView ump

Make path relative to Bank_MultiLanguage ump

Include subproject elements

O Edtable

(®) Readonly

Cancel

Next, click Browse and select the directory where the subproject should be saved.

Select Editable to be able to edit the subproject from the main project. (Selecting Read-only makes it
uneditable in the main project.)

Note: You can change the file path of the subproject at any time by right clicking the subproject and
selecting Subproject | Edit File Path.

Opening and editing subprojects
You can open a subproject as a standalone UModel project, directly from the main project. For this to be

successful, there should not be any unresolved references to other elements. UModel automatically performs
checks when creating a subproject from the "main" project, and whenever a file is saved.

To open a subproject as a standalone UModel project, right-click the subproject package in the main project
and select Subproject | Open as Project. This starts another instance of UModel and opens the subproject
as a "main" project. Any unresolved references are shown in the Messages window.

Reusing subprojects
Subprojects that have been split off from a main project can be used in any other main project(s).

1. Open a project and select the menu command Project | Include Subproject.
2. Click the Browse button and select the *.ump file that you want to include.
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Include Subproject

Kind of include

{®) Include by reference:  Store a reference to the original data of your subproject.
Include subproject elements: () Editable (@) Readonly

() Include as a copy:; Store a copy of the shared data of your subproject in your UMadel
project file. References to the original data will be lost.

Styles of included diagrams
Retain styles: Included diagrams will appear as defined in their subproject.

|Use project file styles: Diagrams will use cument project file styles.

IModelExamples'Bank_MultiLanguage _Java“BankView ump

Make path relative to MewProject 1 Crice

3. Choose how the file is to be included; by reference or as copy.

Saving projects

When you save the main project file, all editable subproject files are also saved. You should therefore not
create/add data (components) outside of the shared/subproject structure, if the subproject is defined as
"editable" in a main project file. If data exists outside of the subproject structure, a warning message will be
displayed in the Messages window.

Saving subproject files

When saving subprojects (from the main project level), all references to sibling, as well as child subprojects,
are considered and saved. For example, if two sibling subprojects, "sub1" and "sub2", exist and "sub1" uses
elements from "sub2", then "sub1" is saved in such a way that it automatically saves references to "sub2" as
well.

If "sub1" was opened as a "main" project, then it is considered as a self contained project and can be edited
without any reference to the actual main project.

Reintegrating subprojects into the main project

You can copy previously defined subprojects back into the main project again. If the subproject does not
contain any diagrams then the reintegration will be immediate. If diagrams exist, a dialog box will open.

1. Right-click the subproject and select Subproject | Include as Copy. This opens the "Include
Subproject" dialog box, which allows you to define the diagrams styles you want to use when including
the subproject.
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Include Subproject

Kind of include
Include by reference:  Store a reference to the onginal data of your subproject.

Include subproject elements: Editable Readaonly

Include as a copy: Store a copy of the shared data of your subproject in your UMadel
project file. References to the original data will be lost.

Styles of included diagrams
(") Retain styles: Included diagrams will appear as defined in their subproject.

(®)ilise project file styles: Diagrams will use cument project file styles.

Malke path relative to Bank_MultiLanguage ump Crice

2. Select the style option that you want to use, and then click OK.

6.1.6 Including Subprojects

When you want to generate code from a model, or import source code into a model, a profile project applicable
to that specific language (for example, C#, Java, VB.NET) must be included in your UModel project.

To include a UModel project as a subproject of another UModel project, select the menu command Project |
Include Subproject. As illustrated below, several .ump subprojects (language profiles required for code
engineering) are available on the Basic tab. In addition, several .ump subprojects containing C#, Java, and
VB.NET types, organized by version, are available in tabs with the same name.

In order for all types to be recognized correctly during code engineering, make sure to include both the
language profile (for example, the C# profile) and the types project of the corresponding language version
(for example, .NET 5 for C# 9.0). Otherwise, an "Unknown Externals" package will be created in the
project which will include all unrecognized types.
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Include Subproject

Basic CH Java VB

Cancel

@ MET Standard 2.1 for C£8.0 (types

onlyl.ump

JMET Standard 2.0 for C27.1 (types
onlyl.ump

@ Microsoft.MET4.7.1 for CE7.0 (types

onlyl.ump

Microsoft. MET4.6 for C#6.0 (types
onlyl.ump

ATy Microsoft. META.5 for C#5.0 (types W I Browse... I

Description:

Include Subproject dialog box

The tabs and UModel projects (.ump files) available on the "Include Subproject” dialog box are configurable.
Namely, UModel reads this information from the following path relative to the "Program Files" folder on your
operating system: \Altova\UModel2024\UModelinclude. Note that the project files available on the Basic tab
exist directly under the UModellnclude folder, while projects in each of the Java, VB, and C# tabs exist as
subfolders of the UModellnclude folder.

To view all currently imported projects:

e Select the menu option Project | Open Subproject Individually. The context menu displays the
currently included subprojects.

Dpen Subproject As Projeck >| Java Lang.ump

Java Profile.ump

=T T T T T TR

lear Messages

To create a custom tab on the "Include Subproject" dialog box:

¢ Navigate to the \Altova\UModel2024\UModellnclude folder (relative to your "Program Files"), and
create your custom folder in it, for example \UModellnclude\myfolder. The name you give to the
folder determines the name of the tab on the "Include Subproject" dialog box.

e Copy to your custom folder any .ump files that you want to make available on the corresponding tab.
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To create descriptive text for each UModel project file:

e Create a text file using the same name as the *.ump file and place in the same folder. For example,
the MyModel.ump file requires a descriptive file called MyModel.txt. Please make sure that the
encoding of this text file is UTF-8.

To remove an included project:
1. Click the included package in the Model Tree view and press the Delete key.
2. When prompted, click OK to delete the included file from the project.

To delete or remove a project from the "Include Subproject” dialog box:

e Delete or remove the (MyModel).ump file from the respective folder.

6.1.7 Sharing Packages and Diagrams

You can share packages (and UML diagrams they might contain) between different UModel projects. Packages
can be included in other UModel projects by reference, or as a copy.

Also note that subproject files can be split off a main, or subproject, file at any time. The subproject files can be
included as editable or read-only from the main project; each package is shared and saved as a s érqect file.
Subprojects can be added to a source control system, see Teamwork support for UModel projects

Notes

e In order to be shareable, a package must not contain links to external elements (elements outside
of the shared scope).

o When creating UModel project files, do not use one project file as a "template/copy" for another
project file into which you intend to share a packahThls will cause conflicts due to the fact that
every element should be globally unique (see uuid %) and this will not be the case, as two
projects will have elements that have identical uuids.

To share a package between projects:

e Right-click a package in the Model Tree window and select Subproject | Share package. A "shared"
icon appears below the shared package in the Model Tree. This package can now be included in any
other UModel project.
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Model Tree »

|Root
- Component View
o MySharedPackage

ElMUdHTrEE @Diagram Tree %} Favorites

To include/import a shared folder in a project:

1. Open the project which should contain the shared package (an empty project in this example).

Model Tree »

_|Root
-~ Component View

ElMUdHTrEE @Diagram Tree %} Favorites

N

Select the menu item Project | Include Subproject...

3. Click Browse, select the project that contains the shared package, and click Open. The "Include
Subproject” dialog box allows you to choose between including the package/project by reference, or as
a copy.

Include Subproject

Kind of include
(®) Include by reference:  Store a reference ta the original data of your subpraject.

Include subproject elements: () Editable (@) Readonly

() Include as a copy: Store a copy of the tshared data of your subproject in wour kodel
project file. Feferences to the onginal data will be lost.

Styles of included diagrams
Retain styles: Included diagrams will appear as defined in their subproject.

IJze project file shyles: Diagrams will use curent project file styles.

SharedPackage. ump

take path relative to MewProject] Carcel

4. Select the required option ("Include by reference”, in this example) and click OK.
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The "Deployment View" package is now visible in the new package. The packages' source project is displayed
in parenthesis (SharedPackage.ump, in this example).

Model Tree X
|Root
- Component View
b MySharedPackage [SharedPackage.ump]

EIM::ndelTree @Diagram Tree ‘%{%Fav-:nrites

Notes:

¢ When you include a source project which contains subprojects, all subprojects of the source project
will also be included into the target project.

e Shared folders that have been included by reference can be changed to "Include by copy" at any time,
by right-clicking the folder and selecting Subproject | Include as a Copy.

Resolving links to external elements

Attempting to share a package which has links to external elements causes a warning dialog box to appear.
For example, the following message appears if you attempt to share the "Deployment View" package of the
sample project C:

\Users\<username>\Documents\Altova\UModel2024\UModelExamples\Tutorial\BankView-start.ump.

Uhodel >

The shared Package(s) have links to external elements!

o These errors must be solved before the UModel projectfile can be
saved.
Do you still want to change the shared status of this Package?

Yes Mo Cancel

Click Yes to share the package despite of the errors; otherwise, click No. The Messages window provides
information about each of the external links.
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Messages 4

V| val val val B8E X
[El starting Checking shared packages ...
-------- ﬂ Manifestation has links out of the shared Package(s): "utilizedElement’
-------- 'g Manifestation has links out of the shared Package(s): "utilizedElement’
-------- I}.'_ Deployment Diagram "Artifacts’ (Component "BankView') has links out of the shared Package(s)
-------- IL'— Deployment Diagram "Artifacts’ (Component "Bank APl client’} has links out of the shared Package(s)
i+, Package 'Design-phase’ is defined outside of the shared Package(s} and can get lost when you include this

-------- . finished Checking shared packages

Click an entry in the Messages window to display the relevant element in the Model Tree window.

6.1.8 Tips for Enhancing Performance

Some modeling projects can become quite large, in which case there are a few ways you can enhance the
modeling performance:

e Make sure that you are using the latest driver for your specific graphics card (resolve this before
addressing the following tips)

e Disable syntax coloring (from the Styles window, set the property Use Syntax Coloring to false).

e Disable "gradient" as a background color for diagrams, use a solid color (from the Styles window, set
the property Diagram background color to a solid color, for example, white).

e Deactivate automatic completion (go to Tools | Options | Diagram Editing and clear the check box
Enable automatic entry helper).

Altova UModel 2024 Professional Edition © 2017-2023 Altova GmbH



Projects and Code Engineering Generating Program Code 169

6.2 Generating Program Code

After you design the model of your application in UModel (for example, one or more class diagrams), you might
want to quickly generate a prototype project which includes all defined interfaces, classes, operations, and so
on, in your language of choice. UModel enables you to generate C#, VB.NET, or Java program code from a
model, based on UML elements found in your UModel project (such as interfaces, classes, operations, and so
on). This process is also known as "forward engineering". The generated code will create all objects exactly as
they were defined in the model, so that you can proceed to their actual implementation.

Code generation is also applicable to XML schemas and databases*. For example, you could design an XML
schema or a database with UModel and then generate the corresponding file (or SQL script, in case of
databases) from the model. To achieve this, consult the mapping tables to find out which schema or database
elements map to UModel elements, see UModel Element Mappings.

* Engineering databases requires UModel Enterprise or Professional editions.

Prerequisites
In order for code generation to be possible, the UModel project must meet the following minimum requirements:

¢ One of the packages in your project must be designated as namespace root. The namespace root can
be a C#, Java, VB.NET, XSD, or Database namespace. This package must contain all classes and
interfaces from which code is to be generated. For more information, see Setting a Package as
Namespace Root @ .

e A code engineering component must be added to the project. This component must be realized by all
the classes or interfaces from which code is to be generated. For more information, see Adding a Code

Engineering Component.

e In case of databases, a connection to the target database must be created first, using the menu option
Project | Import SQL database. Once the connection is established, you can design or modify the
database structure in the model and commit the changes to the database through a SQL script. For
more information, see UModel and Databases @ ..

In addition to this, it is recommended that you include one of the built-in UModel Sl%)rojects corresponding to
the language (or the language version) you want to use, see Including Subprojects “<¥. For example, if your
application must target a specific version of C#, Java, or VB.NET, this would enable you to use the
corresponding data types while designing your UML classes, interfaces, and so on.

For a worked example of how to create a project from scratch and generate code from it, see Example:
Generate Java Code @.

6.2.1 Setting a Package as Namespace Root

In order to generate program code from your UModel project, a package in your model must be designated as
namespace root.
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To set a package as namespace root:

e Right-click a package in the Model Tree Window® and select Code Engineering | Set as <...>
Namespace Root from the context menu, where <...> is one of the following: C#, Java, VB.NET, XSD,
Database.

When you set a package as nhamespace root, UModel informs you that the UML profile of the corresponding
language will also be added to the project and applied to the selected package. Click OK to confirm when
prompted by a dialog box such as the one below.

Uhodel >

This command will include the UMeodel Java Profile and apply it to the
selected Package.
Do you want to continue?

QK Cancel

6.2.2 Adding a Code Engineering Component

In order to generate program code, your UModel project must contain a code engineering component that
specifies all the code generation details (for example, which classes from the project should be included in
code generation, and what should be the target generation directory). As illustrated in the instructions below,
the component must meet the following criteria for successful code generation:

e The component must have a physical location (directory) assigned to it. Code will be generated in this
directory.

e The classes or interfaces that take part in code engineering must be realized by the component.

e The component must have the property use for code engineering enabled.

To add a component which realizes the desired classes or interfaces:

1. Right-click a package in the Model Tree and select New Element | Component from the context
menu. This adds a new Component to the model.

2. In the model tree, click the class or interface that must be realized by the component, and then drag
and drop the cursor onto the component (in this example, Class1 from packagel was dragged onto
Component1). This automatically creates a ComponentRealization relation in the Model Tree.
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Model Tree

Roat
B 1Component View

E--E_|$:| Compaonenti

E| = Relations
E— .. ComponentRealization: (Classi)

-0 & Packagel

........ E Class1

E--E{’Ff-':l_=.t|-:-|'|:-
-5 [« #]Java Profile [Java Profile.ump]

ElMUdElTrEE @Diagram Tree %%Fat-‘-:urites

There is also an alternative approach to do this, by creating a Component diagram and then drawing a
ComponentRealization relation between the component and the classes or interfaces. For more information,
see Component Diagrams [ 2}

To prepare a component for code engineering:

1.

2.

3.

Select the component in the Model Tree (it is assumed that this component is already realized by at

least one class or interface, as explained abowe).

In the Properties window, locate the directory property and set it to the path where you want to

generate code.

In the Properties window, select the check box use for code engineering.

For example, in the image below, the component Component1 from package Component View is configured

to generate Java 8.0 code into the directory C:\codegen:
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Model Tree x

Root
‘B Component Yiew

E--E| g ] Component

E--ElE”g}F!-':I.=|ti-:-|'|:
(- e ComponentRealization: [Class1)

=] /& Package1

........ B Class1

= Relations
[ [« 7] Java Profile [lava Profile.ump]

EIMcndEITree @DiagramTree %}Fav-:nrites

Properties 4
name Component

gualified name Component View:Com
element kind Component

visibility public dl
leaf 1

abstract 1

isFinal5pecialization |
indirectlylnstantiated

code language Javad.0 (1.8) |
directory Chcodegen e
use for code engineering

[=l Properties '@ Styles EIHierarchy

6.2.3 Checking Project Syntax

It is important to check the syntax of the project before generating code from the model. This will inform you of
any problems which prevent code from being generated. Project syntax can be checked from the menu
command Project | Check Project Syntax (alternatively, press F11). A syntax check will also be performed
automatically before code is updated from the model. The results (errors, warnings, and information messages)
are reported in the Messages window.

When a syntax check is performed, the project file is checked on multiple levels as detailed in the tables
below. Note the following:

e For information about solving common syntax errors, see the Code generation prerequisites (162 3

e For components, the checks below are performed only if the use for code engineering property is
enabled for the component in the Properties window.

e For classes, interfaces, and enumerations, the checks below are performed only if the class, interface,
enumeration is contained in a code language namespace. In other words, it must be under a package
which has been defined as nhamespace root.
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e Constraints on model elements are not checked, as they are not part of the code generation process,
see Constraining Elements @

Level Checksif... Error severity if check fails
Project ...at least one namespace root package exists. Error
Component ...project file or directory is set. Error
...this component has a ComponentRealization relation | Error
with at least one class or interface.
Class ...code file name is set. Error if the option Generate
missing code file names is
Note: This check is not applicable for nested classes. not set in Tools | Options |
Code Engineering tab.
Warning if the option is set.
...type for operation parameter is set. Error
...type for properties is set. Error
...operation return type is set. Error
...duplicate operations (names + parameter types) exist. Error
...a ComponentRealization relation exists to a Warning
component.
Note: This check is not applicable for nested classes.
...name is valid (no forbidden characters, name is not a Error
keyword)
...multiple inheritance occurs Error
Class ...name is valid (no forbidden characters, name is not a Error
operation keyword)
...a return parameter exists. Error
Class ...name is valid (no forbidden characters, name is not a Error
operation keyword)
parameter
...type is valid Error
Interface ...code file name is set. Error if the option Generate

missing code file namesiis
not set in Tools | Options |
Code Engineering tab.
Waming if the option is set.

...interface is contained in a code language namespace.

Error

...type for properties are set.

Error
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Level Checksif... Error severity if check fails
...type for operation parameters are set Error
...operation return type is set Error
...duplicate operations (names + parameter types) Error
...interfaces are involved in a ComponentRealization Warning
...name is valid (no forbidden characters, name is not a Error
keyword)

Interface ...name is valid (no forbidden characters, name is not a Error

operation keyword)

Interface ...name is valid (no forbidden characters, name is not a Error

operation keyword)

parameter

Interface ...name is valid (no forbidden characters, name is not a Error

properties keyword)

Package ...name is valid (no forbidden characters, name is not a Error
keyword)
Note: This check is applicable if the package is inside a
namespace root package and has the <<namespace>>
stereotype applied to it from the Properties window.

Enumeration ...a ComponentRealization relation exists to a Warning
component.

6.24

Code Generation Options

When generating program code into a UModel project, you may want to set or change the options listed below.
These options are available when you run the menu command Project | Project Settings and are saved
together with the project.
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Project Settings

Java  C# VB SPL Templates Scripting

Update Program Code from UModel Project

[ ]#rite Documentation as JavaDocs:

Update UModel Project from Program Code

[ ]JavaDocs as Documentation

Cancs

The options are grouped into tabs as follows.

Tab Options

Java Select the check box Write Documentation as JavaDocs to conwert the
documentation of UModel elements to equivalent JavaDocs-style documentation in
generated code.

Ci# Select the check box Write Documentation as DocComments to convert the
documentation of UModel elements to comments in generated C# code.

VB Select the check box Write Documentation as DocComments to convert the

documentation of UModel elements to comments in generated VB.NET code.

SPL Templates

If you want to force UModel to read SPL templates from a custom path other than
the default one, the custom path must be entered here. See also SPL

Templates @.

Scripting

Options in this tab are only applicable if you developed UModel scripting projects to
handle various events or customize the behaviour of your UModel projects. For
more information, see Scriptin Editor.

In addition to the settings above, there are a few other settings which affect code generation. To access them,
run the menu command Tools | Options, and then click the Code Engineering tab. The settings applicable to
generating code from a model are grouped under Update Program Code from UModel Project. Note that
these settings are local (they will only affect the current installation of UModel and will not be saved with the

project).
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6.2.5 Example: Generate C# Code

This example shows you how to generate C# code with UModel. You will first create a sample C# namespace
that contains a couple of classes, configure the project for code generation, and then generate the actual code.

In this example, the target platform is .NET Standard 2.0 for C# 7.1. This is possible thanks to a profile built
into UModel that defines all the types of .NET Standard 2.0 for C# 7.1. UModel also includes built-in profiles for
specific .NET Framework versions. For details, see Including Subproiects.

Create a new project and its structure

The first step is to create an empty project that has two default packages (rRoot and Component Vview): Click
New in the File menu or in the toolbar. Next, right-click the root package and create a few mora)ackages, as
illustrated below. If you are new to the UModel graphical user interface, see the UModel Tutorial ¥ and How to
Model @ sections to get started.

Model Tree »

JRoot
-------- Component View
E-E_| Design View

- SampleMamespace

ElMcudeIT... @Diagra... ‘%} Favaorites

In this example, the Design View package acts as a container for the design part of your model (e.g., classes
and class diagrams), while the sampleNamespace package acts as a namespace for all classes that are to be
created. In general, you can organize your packages differently.

Code engineering
The next step is to set C# for our package. Right-click the pesign view package and select Code

Engineering | Set as C# Namespace Root from the context menu. UModel will inform you that the C# profile
will be applied to the package. Click OK. The C# profile built into UModel has just been included in the project
(see screenshot below).

Model Tree 4

JRoot

-------- Component View
cx Design View
SampleMamespace

El Model Tr..| ER Diagram... %% Favorites
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Set SampleNamespace as namespace

Next, click the sampleNamespace package and select the <<namespace>> check box in the Properties
window. This applies the namespace stereotype to the package, and its icon changes to ' *!. You can now
create classes under this namespace.

Include a subproject
So far, the model includes the C# profile, which contains the data types applicable to C#. Howewer, the model

does not yet include the types specific to .NET Standard 2.0 (these are available in a separate UModel profile).
To add this profile to the project, do the following:

1. Go to the Project menu and select Include Subproject.
2. Switch to the C# tab and select .NET Standard 2.0 for C# 7.1 (types only).
3. Select Include by reference in the Include Subproject dialog and click OK.

The additional profile has been added to the project (see below).

Model Tree x

- e .MET Standard 2.0 for C# types anly
-------- Component View
- c# Design View

--------- n | sampleMamespace

4 4
ElModelTree @Diagramﬂ'... ‘%{%Fa-.-'-:nrit-'::

Create C# classes

The next step is to create classes, which you can do directly in the Model Tree pane or from a class diagram.
For this example, we have chosen the second option. Follow the steps below:

1. Open the Diagram Tree pane.
2. Right-click Class Diagrams and select New Diagram | Class Diagram.

This example assumes that all your classes must be generated under the sampleNamespace namespace.
Therefore, when prompted to select an owner for the diagram, select the sampleNamespace package. If you
choose a different package, any elements that you add to the diagram will belong to the same package as the
diagram (which may or may not be the intended goal).

Create classes and their structure

Next, create classes, types, and other elements required in your model. For our example, you can create a
simple diagram that contains an Artist class and a MusicStore class (see screenshot below). Follow the
instructions below:

1. Right-click inside the pkg SampleNamespace window and select New | Class.
2. Name this class artist.
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ook w

Artist

[1 IDuint
[1 Mame:string

pkag S.ampleHamespace), ..

Musicstore

[1 lastUpdated:DateTime

% CreateTestArtists|):List«<T-> Artist=

Right-click inside the artist box and create two properties: 1D of type int and Name of type string.
Create the second class called MusicStore.

Create a property called LastUpdated of type DateTime.

Create an operation and type its name and definition as shown below.

For more information about designing classes and their members, see the Class Diagrams@ and How to

Model sections.

About auto-implemented C# properties
In UModel, you can see whether C# properties have been auto-implemented. The auto-implementation option

becomes available after the property check box has been selected (for CreateTestArtist () in our example)
in the Properties window (see screenshots below).

pkg SampleNamespace ]
Artist Musicstore
(1 IDuint [1 LastUpdated:DateTime
1 MName:int
_ C# Properties
< (@roperiyDCreateTestartist():List<T->Artist>

Properties o x
CONCUrrency sequential - |
quETy |
implements
auto impl |
cconstructors ]
@SN O
«destructors ]
wpropertys |
xindexers ]
wimatbrraconry [ -
[=] Properties @St}-‘les EIHierarchy

Add documentation (optional)

Optionally, click the Musicstore class in the diagram and add some documentation by typing the text in the

Documentation window

(see screenshot below). This lets you generate code comments for this class.
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Documentation x

frhis class models a music store, It contains
methods to manage assets such as music tracks
or artists,

Cverview Documentation % Layer

Configure the project for code engineering
In the next step, we need to define code engineering settings. Take the steps below:

1. Sawe the project to a directory.

2. Then right-click the component Vview package in the Model Tree pane and add a new Component £]
(that is, a software component) to it.

3. Click the new software component and set the following properties in the Properties window (see
screenshot below):

¢ Set the code language of the component to C# 7.1, for example.
¢ Select the code generation directory (C:\codegen in our example).
e Select the use for code engineering check box.

Properties x
name Componentl

qualified name Component View:Compone,
element kind Component

visibility public |
leaf O

abstract O

isFinalspecialization |

indirectlylnstantiated

code language CETA |
directory iChcodegen m
use for code engineering

[=] Properties @l Styles EI Hierarchy

Create a ComponentRealization relationship

Next, create a ComponentRealization relationship between the classes from which C# code must be
generated. This can be done as follows: In the Model Tree pane, click the class to be realized by the
component (Artist in this example), then drag and drop it into the code engineering component (Component1)
(see screenshot below). Take the same step for the MusicStore class.

B |Component View
E| g] Component?
E| = Relations

F— "y ComponentRealization: [Artist)
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Note: In case you forget to create a ComponentRealization relationship for a class, UModel still
generates the corresponding code file, even though warnings will be issued in the Messages window.
This setting is configurable from Tools | Options | Code Engineering tab (the Generate missing
ComponentRealizations check box).

Generate C# code
The final step is to generate the actual C# code. Take the steps below:

1. Go to the Project menu and click Merge Program Code from UModel Project. A dialog box
appears where you can adjust whether changes in code should be merged with those in the code or
overwrite them (if applicable). For the scope of this example, you can select Overwrite since a new
project is getting generated.

2. Toinclude the class documentation as comments in the generated code, click Project | Project
Settings and select the Write Documentation as DocComments check box. For more information,

see Code Generation Options @
3. Click OK. The Messages window displays the code engineering result (see below).

Messages »
N T *

Bl starting Syntax Check ...
- o finished Syntax Check - 0 error(s), 0 warning(s)

[l starting update code from project ...
--------- Collecting source files in "Chcodegen’

--------- Creating file: "ChcodegentArtist.cs’

--------- Creating file: "ChcodegeniMusicstore.cs’

--------- Changing file: "ChcodegenArtist.cs’ (Pass 1)

--------- Changing file: "ChcodegeniMusicstore.cs’ [Pass 1)

--------- . finished update code from project - 0 errar(s), 0 warning(s)

If you have added any documentation to the MusicStore class, notice that it appears as code comments in the
generated code:

using System;
using System.Collections.Generic;
namespace SampleNamespace
{
/// This class models a music store. It contains methods to manage assets such as
music tracks or artists.
public class MusicStore
{
public DateTime LastUpdated;
public List<Artist> CreateTestArtists()

{
// TODO add implementation
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6.2.6 Example: Generate Java Code

This example illustrates how to create a new UModel project and generate program code from it (a process
known as "forward engineering"). For the sake of simplicity, the project will be very simple, consisting of only
one class. You will also learn how to prepare the project for code generation and check that the project uses
the correct syntax. After generating program code, you will modify it outside UModel, by adding a new method
to the class. Finally, you will learn how to merge the code changes back into the original UModel project (a
process known as "reverse engineering").

The code generation language used in this tutorial is Java; however, similar instructions are applicable for other
code generation languages.

Creating a new UModel project
You can create a new UModel project as follows:

¢ On the File menu, click New. (Alternatively, press Ctrl+N, or click the New toolbar button.)

At this stage, the project contains only the default "Root" and "Component View" packages. These two
packages cannot be deleted or renamed. "Root" is the top grouping level for all other packages and elements in
the project. "Component View" is required for code engineering; it typically stores one or more UML
components that will be realized by the classes or interfaces of your project; howewver, we didn't create any
classes yet. Therefore, let's first design the structure of our program, as follows:

1. Right-click the "Root" package in the Model Tree window and select New Element | Package from
the context menu. Rename the new package to "src".

2. Right-click "src" and select New Element | Package from the context menu. Rename the new
package to "com"

3. Right-click "com" and select New Element | Package from the context menu. Rename the new
package to "nanonull".

4. Right-click "nanonull" and select New Element | Class from the context menu. Rename the new class
to "MyClass".

Model Tree b4

_|Root
o Component View
EE| SrC
E"L:J com
§.E| nanonull
] B MyClass

EI Model ... BB Diagra... %:% Favaorites

Preparing the project for code generation
To generate code from a UModel model, the following requirements must be met:
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e A Java, C#, or VB.NET namespace root package must be defined.

e A component must exist which is realized by all classes or interfaces for which code must be
generated.

e The component must have a physical location (directory) assigned to it. Code will be generated in this
directory.

e The component must have the property use for code engineering enabled.

All of these requirements are explained in more detail below. Note that you can always check if the project
meets all code generation requirements, by validating it:

e On the Project menu, click Check Project Syntax. (Alternatively, press F11.)

If you validate the project at this stage, the Messages window displays a validation error ("No Namespace Root
found! Please use the context menu in the Model Tree to define a Package as Namespace Root"). To resolve
this, let's assign the package "src" to be the namespace root:

¢ Right-click the "src" package and select Code Engineering | Set As Java Namespace Root from
the context menu.

e  When prompted that the UModel Java Profile will be included, click OK.

Utodel ot

This command will include the UModel Java Profile and apply it to the
selected Package.
Do you want to continue?

QK Cancel

Notice the package icon has now changed to =71, which signifies that this package is a Java namespace root.
Additionally, a Java Profile has been added to the project.

Model Tree x

Roat
-------- Compaonent View
B & src
E| com
EE| nanonull
E B MyClass
= Relations

-[# [+7] Java Profile [lava Profile.ump]

E| Model T..| = Diagram... %% Favorites

The actual namespace can be defined as follows:

1. Select the package "com" in the Model Tree window.
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2. In the Properties window, enable the <<namespace>> property.

Properties b
name com

qualified name SFCCOm

element kind Package

visibility public dl
LR

«Mamespaces

=] Properties @I Styles EI Hierarchy

3. Repeat the step above for the "nanonull" package.

Notice that the icon of both "com" and "nanonull" packages has now changed to %!, which indicates these are
now namespaces.

Another requirement for code generation is that a component must be realized by at least a class or an
interface. In UML, a component is a piece of the system. In UModel, the component lets you specify the code
generation directory and other settings; otherwise, code generation would not be possible. If you validate the
project at this stage, a warning message is displayed in the Messages window: "MyClass has no
ComponentRealization to a Component - no code will be generated". To solve this, a component must be
added to the project, as follows:

1. Right-click "Component View" in the Model Tree window, and select New Element | Component from

the context menu.
2. Rename the new Component to "nanonull".

Model Tree b4

Root
2 JComponent View
- £ ] nanonull
3=

El " com
EE| ~nanonull
: B MyClass
5..;}¢;Ff-':l_=.t|-:-n:-

-[H [+« 7] Java Profile [Java Profile.ump]

EIM::dEITr... EDiagram... %'%Fat-‘-:urites

3. Inthe Properties window, change the directory property to a directory where code should be
generated (in this example, "src\com\nanonull"). Notice that the property use for code engineering
is enabled, which is another prerequisite for code generation.
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name nanonull

Javad.0 {1.9) Ll
srovcominanonull

use for code engineering

=] Properties @I Styles EI Hierarchy

4. Save the UModel project to a directory and give it a descriptive name (in this example, C:
\UModelDemo\Tutorial.ump).

Note: The code generation path can be absolute or relative to the .ump project. If it is relative as in this
example, a path such as src\com\nanonull would create all the directories in the same directory
where the UModel project was saved.

We have deliberately chosen to generate code to a path which includes the namespace name; otherwise,
warnings would occur. By default, UModel displays project validation warnings if the component is configured to
generate Java code to a directory which does not have the same name as the namespace name. In this
example, the component "nanonull" has the path "C:\UModelDemo\src\com\nanonull", so no validation
warnings will occur. If you want to enforce a similar check for C# or VB.NET, or if you want to disable the
namespace validation check for Java, do the following:

1. On the Tools menu, click Options.
2. Click the Code Engineering tab.
3. Select the relevant check box under Use namespace for code file path.

The component realization relationship can be created as follows:

¢ In the Model Tree window, drag from the MyClass created previously and drop onto component
nanonull.
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Model Tree

O Info:

Drop will add ComponentRealizations to the Component

Root
B Compo

H = s

El w | COm

E E--L:_l w | nanonull

: P B MyClass
E--?&;F{-’:L‘ltiﬂl'l‘.’-

& [« Java Profile [Java Profile.ump]

ElMCIdElTrEE EDiagramTree %}Fam-‘-:urites

The component is now realized by the project's only class MyClass. Note that the approach abowe is just one of
the ways to create the component realization. Another way is to create it from a component diagram, as
illustrated in the tutorial section Component Diagrams.

Next, it is recommended that the classes or interfaces which take part in code generation have a file name.
Otherwise, UModel will generate the corresponding file with a default file name and the Messages window will
display a warning ("code file name not set - a default name will be generated"). To remowve this warning:

1. Select the class MyClass in the Model Tree window.
2. In the Properties window, change the property code file name to the desired file name (in this
example, MyClass.java).

Properties x
name My Class

qualified name sroicomananonull:byCl
element kind Class

visibility public il
leaf ]

abstract ]

isFinalspecialization [

active ]

code file name MyClass.java

code file path ChUModelDemotsroico
«annotationss ]

wstatics ]

astrictfps I

=] Properties @I Styles EI Hierarchy

Including the JDK types

Although this step is optional, it is recommended that you include the Java Development Kit (JDK) language
types, as a subproject of your current UModel project. Otherwise, the JDK types will not be available when you
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create the classes or interfaces. This can be done as follows (the instructions are similar for C# and VB.NET):

1. On the Project menu, click Include Subproject.
2. Click the Java tab and select the Java JDK 9 (types only) project.

Include Subproject

Bazsic CH Java Ok

PS
@ ava JDK 9 (types only).ump Cancel

@ Java IDK 8 (types onlyl.ump
@ Java IDK 7 (types onlyl.ump
@ lava IDK & (types onlyl.ump
@ Java DK 5.0.ump

Mo ( WP PP v I Browse. .. I

Description:
Containg acceszible packages: and types from fram Sun Jawva SE 9 far
Java 3 [without operations and properties).

3. When prompted to include by reference or as a copy, select Include by reference.

Include Subproject

K.ind of include

(®)nclude by reference; Store a reference ta the original data of your subpraject.
Include subproject elements: E ditable Fieadonly

() Include as a copy: Store a copy of the ghared data of your subproject in wour kodel
project file. References to the onginal data will be lost,

Styles of included diagrams
Fetain styles: Included diagrams will appear as defined in their subproject.

IJze project file shyles: Diagrams will uze curent project file stules.

|Java'3.[l"-.] ava 0K 9 [lwpes anly].ump
kake path relative to Lk odelT utonial ump Cemee

Generating code
Now that all prerequisites have been met, code can be generated as follows:
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1. On the Project menu, click Merge Program Code from UModel Project. (Alternatively, press F12.)
Note that this command will be called Overwrite Program Code from UModel Project if the
Overwrite Code according to Model option was selected previously on the "Synchronization
Settings" dialog box illustrated below.

Synchronization Settings

Code from Model  Model from Code
SPL templates
|User-defined ovemde default

When deleting Code

(® Comment out () Delete
Synchronization

(®) Merge Model into Code

() Overwrite Code according to Model

[litsheaps show dislog when synchronizing

Project Settings Cancel

2. Leawe the default synchronization settings as is, and click OK. A project syntax check takes place
automatically, and the Messages window informs you of the result:

Messages x
W v|al vjal wlal O)GE X

Bl starting Syntax Check ...
H— .. finished Syntax Check - 0 error(s), 0 warning(s)

Bl starting update code from project ..
i Collecting source files in "ChUModelDematsrdcominananull’

Parsing file: "C\UModelDemosrcicomnanonullMyClass.java'

Resolving type references
---------- w finished update code from project - 0 error(s), 0 warning(s)

Modifying code outside of UModel

Generating program code is just the first step to developing your software application or system. In a real life
scenario, the code would go through many modifications before it becomes a full-featured program. For the
scope of this example, open the generated file MyClass.java in a text editor and add a new method to the
class, as shown below. The MyClass.java file should look as follows:

package com.nanonull;
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public class MyClass{
public float sum(float numl, float num2) {
return numl + num?2;

}

MyClass.java

Merging code changes back into the model
You can now merge the code changes back into the model, as follows:

1.  On the Project menu, click Merge UModel Project from Program Code (Alternatively, press Ctrl +

F12).

Synchronization Settings

Code from Model Meodel from Code

Synchronization
(@ Merge Code into Model

() Overwrite Model according to Code

[litsheaps show dislog when synchronizing

Froject Settings Cancel

2. Leawe the default synchronization settings as is, and click OK. A code syntax check takes place

automatically, and the Messages window informs you of the result:

Messages

V| v|a| v|a| v|a| O/EE| X

B starting update model from code ..
— Collecting source files in "C\UModelDema'sreycomnanonull®

Parsing file: "Ch\UModelDemotsroicominanonull My Class java’
Resolving type references
fr— .. finished update model from code - 0 error(s), O warning(s)

The operation sum (which has been reverse engineered from code) is now \visible in the Model Tree window.
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Model Tree b4
Root
& 1Component View
E--E_|$:| nananull
= Relations
[ B Java JDK 9 {types on ava JDK 9 [types on
8 1E s
3| W com
El w | nanonull
E--E| = MyClass
@< sum
oy num
. ......... O num?
- < return
[ = Relations
-[H [« 7] Java Profile [Java Profile.ump
1 2
= Diagram Tree %%‘ Favarites

Ell"-ﬂﬂdElTrEE

When generating C#, Java, or VB.NET code, as well as XSD schemas, UModel uses a templating language

6.2.7 SPL Templates

called SPL (Spy Programming Language). The SPL templates dictate the syntax of the generated code files. It
is possible to customize the SPL templates, for example, in order to slightly change the syntax of the
generated code. Editing SPL templates is meaningful only for languages supported by UModel. If you want to

create completely new SPL templates for other languages, it would be possible to generate new code but it
would not be possible to update existing code (since the language syntax would be unknown to UModel).

The default SPL templates are available in the UModelSPL directory relative to the program installation

directory.

SPL templates are only used when new code is generated (that is, when new classes, operations etc have
been added to the model, and then code generation takes place). Any existing code is not affected by the SPL

Do not modify the existing default SPL templates, since these directly affect the default code generation.
Should you need to customize code generation, create custom templates instead, as shown below.

templates.
For an introduction to SPL, see SPL Reference.

To modify the provided SPL templates:

Locate the provided SPL templates in the UModel installation directory ("Program Files"), for
example: ...\UModel2024\UModelSPL\Java\Default.
Altova UModel 2024 Professional Edition
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2. Copy the SPL files you want to modify into the parent directory. For example, if you want to modify
the appearance of a Java class in generated code, copy the Class.spl file from ...
\UModel2024\UModelSPL\Java\Default to ...\UModel2024\UModelSPL\Java.

3. Make the changes to the .spl file(s) and save them.

To use the custom SPL templates:

1. Select the menu option Project | Synchronization settings.
2. Select the User-defined override default check box in the SPL templates group.
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6.3 Importing Source Code

Existing Java, C#, and VB.NET program code can be imported into UModel (a process also known as "reverse
engineering"). The following project types can be imported into UModel:

e Java projects (Eclipse .project files, NetBeans project.xml files, and JBuilder .jpx files)
e C# and VB.NET projects (Visual Studio .slIn, .csproj, .csdprj, .vbproj, .vbp as well as Borland .bdsproj
project files)

In addition to importing source code from a source project, it is also possible to import code from a source
directory. Importing from a source directory works in a similar way, and is particularly useful when your code
doesn't use any of the project types listed above. For an example of importing a source directory, see Rewerse
Engineering (from Code to Model) .

It is possible to import source code either into a new, empty UModel project or into an existing UModel project.
During the import, you can specify whether the imported elements should overwrite those in the model (if any),
or be merged into the model. Optionally, Class and Package diagrams can be generated automatically as you
import code.

The import wizard includes various import options specific to each platform (Java, .NET). For example, if the
imported Java/C#/VB.NET code contains comments, these can be optionally converted to UModel
documentation. For a complete list of options, see Code Import Options .

Once your C#, VB.NET, or Java code has been imported into UModel, it is possible to modify the model (for
example, add new classes, or rename properties and operations), and optionally synchronize it back with the
original code, thus achieving full round-trip engineering, see Synchronizing the Model and Source Code @D

Prerequisites

UModel includes several built-in sub-projects that were created specifically for code engineering and which
include the data types applicable to each supported language and platform. Before attempting to import source
code into a UModel project, it is recommended to include the built-in UModel subproject applicable to the
corresponding programming language and platform, see Including Subpro'ects. Otherwise, certain data
types will not be recognized and will be placed after import into a separate package called "Unknown
externals".

To include a subproject with the required language data types:
1.  On the Project menu, click Include Subproject.

2. Click the tab applicable to the source language and platform (for example, Java 8.0, C# 6.0, VB 9.0),
and then click OK.
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Include Subproject
Basic CH  Java VB I oK I
" Cancel
JMET Standard 2.1 for C28.0 (types
onlyl.ump
MET Standard 2.0 for CE7.1 (types
onlyl.ump
Microsoft. MET4.7.1 for CE7.0 (types
onlyl.ump
Microsoft. MET4.6 for C26.0 (types
onlyl.ump
AT Microsoft. NET4.5 for C#5.0 (types v I Browse... I
Description:

Note the following:

e When you include a data type subproject for a particular language, UModel also automatically adds the
profile of that language to your project. The profile subproject (.ump) contains only the most basic
types and is different from the data type subproject (also .ump) which contains more extensive type
definitions.

e If you perform the import without including a data type subproject, the import operation will take place
nonetheless, and UModel will also automatically include the profile of that language to the project.
However, any unknown types will be placed into the "Unknown externals" package. To solve this, make
sure to include the data types subproject for the required language and platform, as explained above.

Importing source code from a project
1. On the Project menu, click Import Source Project. (Alternatively, if you would like to import code
from an existing directory, select Import Source Directory.)
Select the language version of the source project (for example, Java 8.0, C# 6.0).
3. Click Browse El and select the source project file.

4. Set or change the required import options, see also Code Import Options (note that these options
depend on the language selected in step 2).
5. Click Finish to complete the wizard.

For a step-by-step example, see Example: Import a C# Proiect.
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6.3.1 Code Import Options

When importing program code into a UModel project, you may need to set or change the options listed below.
These options are available on the dialog box which appears when you run the menu command Project |

Import Source Project or Project | Import Source Directory.

Import Source Project

.......................

Language: | Java LT i

Project file: |

Import project relative to UMaodel project file

Java Project Settings
[]JavaDocs a= Documentation

Resolve aliases

Synchronization
(@) Merge Code into Model
() Owverwrite Model according to Code

Diagram generation

Enable diagram generation

I
A

Back e mish Cancel

Import Source Project dialog box

Most of the options on the dialog box above can also be changed at any time later, see Code Synchronization
Settings >0}

The following options are applicable to all project types, regardless of the language or platform:

Option Description

By default, this option is selected, which means that a relative path
dependency will be established between the UModel project and

the imported source code project.

Import project relative to UModel
project file

After source code is imported, a UML component is generated
automatically in the UModel project (it is available in the Model
Tree, as a child of "Component View"). This component realizes
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Option

Description

the interfaces or classes to be engineered; it also specifies the
code engineering options, including the path to the source project
or directory. This will be a relative path if Import project relative
to UModel project file is selected; otherwise, it will be an
absolute path.

Merge Code into Model / Overwrite If Merge... is selected, potential name conflicts (such as package
Model according to Code

or class names) will be resolved by appending a number to the
element that is being imported.

If Overwrite... is selected, and if there are name conflicts, the
imported element will take precedence over (overwrite) the one
existing in the project.

Enable diagram generation

Optionally, select this check box if you want to generate Class and
Package diagrams from the imported classes. When this check
box is selected, the import wizard includes additional steps which
enable you to customize the look of the generated diagrams.

The following options are applicable only to C# and VB.NET projects:

Option

Description

DocComments as
Documentation

Select this check box to convert comments found in the C# code into
UModel element documentation (see also Documentation@).

Resolve aliases

This check box is enabled by default. If your C# or VB.NET code contains
namespace or class aliases like in the code listing below, it is
recommended to keep this check box selected. Otherwise, associations
and dependencies involving aliased classes and namespaces in your code
may not be detected automatically by UModel during the import (and thus
would not be present in the model).

using Q = System.Collections.Generic.Queue<String>;
Q myQueue;

Example of an alias in C# code

During the source code import, any potentially conflicting aliases are added
to the "Unknown externals" package of the UModel project if their use is
unclear.

When you update the code back from the model (round-trip engineering),
aliases will be retained as they exist in the generated code.

The Resolve aliases option can be changed at any time later, see Code
Synchronization Settings @ i you enable this option after (not before) the
import operation, UModel prompts you to update the project from the code
again, since the option also has consequences for forward engineering.
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Option Description

Defined symbols If your C# or VB.NET code includes symbols that are defined through
preprocessor directives such as #if, #endif, you can instruct UModel to
take them into account while reverse engineering code.

#1f DEBUG
static void DisplayMessage()
{
Console.WritelLine("Please wait...");
¥
#endif

Example of a conditional compilation symbol in C# code

For example, if you reverse engineer the code abowe, the method
DisplayMessage () Will only be imported into the model if you specified the
DEBUG symbol.

To specify conditional compilation symbols, enter them in the "Defined
symbols" text box, delimited by a semicolon.

During the reverse engineering process, UModel outputs all symbols used
in the source code in the Messages window.

The following option is applicable only to Java projects:

Option Description

JavaDocs as Documentation Select this check box to convert JavaDocs-style comments found in the
code into UModel element documentation (see also Documentation@).

Note: Only comments applicable for Java classes, interfaces, operations,
and properties are converted.

6.3.2 Example: Import a C# Project

This example illustrates how to import into UModel a sample C# solution created with Visual Studio. The
source solution is available as a .zip archive at the following path: C:
\Users\<username>\Documents\Altova\UModel2024\UModelExamples\Tutorial\Anagram_CSharp.zip. It
is not necessary to compile the solution with Visual Studio before importing it; however, make sure to unzip the
Anagram_CSharp.zip archive to a folder of your choice before proceeding to the steps below.

Our goal in this example is to reverse engineer the C# solution and create a UModel project from it. As we
import code, we will opt to generate class and package diagrams automatically.

Step 1: Create a new project

It is possible to import source code either into existing or new UModel projects. For the scope of this example,
we will be importing code into a new UModel project.
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e On the File menu, click New (Alternatively, press Ctrl + N or click the New toolbar button).

Step 2: Include the C# language types

The source project was written in C# with Visual Studio 2015, so we will include a built-in UModel project that
contains the C# 6.0 language types (since the C# language version corresponding to Visual Studio 2015 is
6.0). Earlier versions of C# are also likely to work with our C# example solution.

1. On the Project menu, click Include Subproject.
2. Click the C# tab.

Include Subproject

Bazic CH Java  WE oK
Microsoft. MET4.7.1 for CET.0 (types & Cancel
onlyl.ump

licrosoft.MET4.6 for C#6.0 (types
nly).ump

@ 5

@ Microsoft. MET4.5 for C#5.0 (types

onlyl.ump

Microsoft. MET4.0 for CE4.0 (types
onlyl.ump

@ Microsoft.MET3.5 for C#3.0 (types

onlyl.ump

AT Microsoft. NET2.0 for C22.0 (types v I Browse... I

Description:

3. Select the project Microsoft .NET 4.6 for C# 6.0 (types only).ump, and click OK.
4. When prompted to select the kind of include (by reference or as a copy), leave the default option as is.

Altova UModel 2024 Professional Edition © 2017-2023 Altova GmbH



Projects and Code Engineering

Importing Source Code

197

Include Subproject

K.ind of include

(®)nclude by reference; Store a reference ta the oniginal data of your subpraject.
Inzlude subproject elements: E ditable Readonly

project file. References to the onginal data will be lost,

Styles of included diagrams

IJze project file shyles: Diagrams will uze curent project file styles.

J Inchude as a copy: Store a copy of the shared data of your subproject in wour kodel

Retain styles: Included diagrams will appear az defined in their subproject.

CHE.OMicrozaft MET 4.6 for CHE.O [types only].ump

kake path relative ta HewProject]

Cancel

As a result, both the C# language types and the C# language profile are included and visible in the Model Tree:

Model Tree b4
_|Root
o Component View
e Microsoft. MET4.6 for CFE.0 [types anly)

‘@[5 C# Profile [C# Profile.ump]

£ >

E|M::udEITrEE EDiagram Tr..| 3% Favorites

Step 3: Import the C# solution
1. On the Project menu, click Import Source Project.
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Import Source Project x

Language: |CH ~| |60 w

Project file: |-"||:u:|e|2|}'| 9% UModelExamples Tutoral ' Anagram_CSharp*Anagram sln -~

Import project relative to LUMaodel project file
CH Project Settings
DocComments as Documentation
Resolve aliases

Defined symbols:

Synchronization
() Merge Code into Model
(®) Overwrite Model according to Code

Diagram generation

Enable diagram generation

[==}
51}
0

o> | [

2. Select C# 6.0 as language.

@

Click Browse | next to Project file and browse for the solution .sIn file.

4. Select the DocComments as Documentation check box (this will import the code comments found
on operations or properties into the model).

5. Since we are importing code into a new UModel project, select the option Overwrite Model

according to Code (the other option Merge Code into Model is preferable when you import into an

existing project).

Click Next.

7. Select the diagram generation options as shown below, and click Next. (These options are applicable

to Class diagrams generated automatically on code import.)

o
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Content Diagram Generation >

Content diagrams

] : Style
[«]iSenerate single diagram; b
Show Attributes compartment

Show Operations compartment

[ ] Generate diagram per package
Open diagrams

[ ] Show nested Classifiers compartment
[] Show nested classifiers separately

[ ] 5how EnumerationLiterals compartment
[ ] Show Tagged Values
Ise own compartment for MET properties

[ ] 5how anonymous bound elements
Hyperink package(s) to diagramis)

[]5how .MET properties compartment

Autolayout
Autalayout
hierarchic w
< Back Mext = FEinish Cancel

8. Select the diagram generation options as shown below, and click Finish. (These options are applicable
to Package diagrams generated automatically on code import.)
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Package Dependency Diagram Generation >

Package dependency diagram

Style
Generate diagram
e ses s . Fill color of extemal packages:
Open diagram; " =
St
[ lgnore extemal packages
{nat child of impaort target)
] Hyperink package to diagram Autolayout
Autolayout
hierarchic w

< Back Mext = Cancel

9. Enter a name and select a destination folder for the new UModel project, and click Save (by default,
this dialog box displays the same folder as the solution you are importing).
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@ Save As

Save i_n:| Anagram_CSharp vl @ ﬂ' s [

i Mame Date modified Type
Anagram 2272017 4:42 AM File folder

Cuick access

Desktop

Libraries

L2

This PC

Metwork

File name: Anagram_C5Sham

Save as type: UModel Projects (" .ump) b

Switch to LIRL

The progress of the reverse engineering operation is shown in the Messages window.

Messages

¥ v|al vja| via BBE X

ElStartlng Project Check ..
--------- . finished F‘rcu_|ect Check - 0 error(s], 0 warning(s)

ElStartlng update model from code .
Parsing file: C'-U5Ers\aItcn.ra'-Dncuments'-AItm.ra'-UMndvallmS\UMcudEIExampIES'-Tutnrlal\Anagram CSharphan:

Parsing file: "Ch\WUsers\altovaiDocumentsiAltovasUModel201 8\WUModelExamples\TutorialAnagram_CSharphAni
Parsing file: "Ch\WUsers\altovaiDocumentsiAltovasUModel201 8\WUModelExamples\TutorialAnagram_CSharphAni

Resolving type references
.. finished update model from code - 0 error(s], 0 warning(s)

ElStartlng Project Check ..
. finished F‘rcu_|ect Check - 0 error(s], 0 warning(s)

Also, when code import completes, all generated diagrams are opened automatically since this option was
selected before code generation. All generated diagrams are available in the Diagram Tree:
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Diagram Tree X

EDiagrams Fs
------- rhl &ctivity Diagrams
-@Eusiness Process Diagrams
B [&] Class Diagrams
_— HCnntent of Anagram and all subpackages
------- [&3 Communication Diagrams
------- F&n Component Diagrams
------- [=5 Compasite Structure Diagrams
------- [&1 Database Diagrams

------- [&71Deployment Diagrams

------- [Z3 Interaction Overview Diagrams

------- [E) Object Diagrams

-2 [Cq Package Diagrams

e [E9| Package dependencies of Anagram
....... [Eg) Profile Diagrams

------- ;g'Pl'-jt-jc-jl State Machine Diagrams

ElMUdElTrEE @DiagramTree %{%Famrites

Since we opted to generate documentation from the source code, the imported documentation is \isible in the
Documentation window if you click, for example, the create operation of the Anagram class:

pkg Anagram. T ___________ . ... ... 1 s -

: Anagram -

1 [from Anagram) r |<'-5U|'|'"'|'|Elr'.-"3-"
2 Generates an anagram from the word supplied as
BT = argument.

b (} Create(in word:string):string : oo e </summany=

1 & Shuffle(in chars:char[*|}:char[*] T <param name="word"=</params=

f

<returns=The anagram for the given word.</returns=

[from Anagram] . | =namespace=
Anagram
Ifl} Mainfin args:string[*]l:void

Cverview Documentation ﬁ Layer

Note: The documentation is added only if the option DocComments as Documentation was selected while
importing the C# solution (see "Step 3: Import the C# Solution" above).
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6.4 Importing Java, C# and VB.NET Binaries

UModel supports the import of C# , Java and VB.NET binaries. This is extremely useful when working with
binaries from a third party, or if the original source code has become unavailable. Note the following:

e To import Java binary files, a supported version® of the Java Runtime Environment (JRE) or
Dewelopment Kit (JDK) must be installed. Type import is supported for Java .class files or .jar class
archives adhering to the Java Virtual Machine Specification. This includes Java Virtual Machines such
as OpenJDK, SapMachine, Liberica JDK, and others, see Adding Custom Java Runtimes &9.

e To import C# or VB.NET binary files, .NET Framework, .NET Core, .NET 5, or .NET 6 must be
installed, as applicable. For best results, select the any (use disassembler) option on the import
dialog box. After import, any unrecognized types will be placed in the "Unknown externals" package.
To prevent (or decrease the number of) unknown externals, apply the UModel profile specific to the
version of your code engineering language (for example, ".NET 5 for C# 9.0") before the import. See

also Applying UModel Profiles %=,
e The import of obfuscated binaries is not supported.

The table below lists the available approaches for importing binary types into a UModel project.

C#, VB.NET Java

Import assembly file (.dll, .exe) Import class file archive (.jar, .zip)

Import assembly from Global Assembly Cache Import class file (.class) from a package root folder

(GAC)

Import assembly from Visual Studio .NET Import class archives from class path

References
Import class archives from Java runtime (only for Java
versions up to and including Java 8)

You can import binary files by running the Project | Import Binary Types menu command. Optionally, you
can have UModel generate class and package diagrams from the imported types. For examples, see Example:
Import .NET GAC Assemblies @ and Example: Import Java .class Files @

In addition, you can import binary files from the command line (see UModel Command Line Interface@) and
programmatically using the UModel API (see Importing Binary Types Programmatically).

When importing binary files into a UModel project, you can specify various import options, including:

e You can import any referencing types, in addition to the types defined in the binary file. In addition, you
can restrict importing referencing types to specific Java packages and .NET namespaces.

e You can skip type members while importing. For example, you can import classes and interfaces
without their properties and methods.

e You can import types according to their accessibility modifiers (such as private or public). For
example, you can import only public classes and skip private, protected, and internal classes.

For reference to all options, see Import Binary Options@.
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6.4.1 Adding Custom Java Runtimes

By default, UModel detects JDKs and JREs if they are installed on the local machine. Consequently, these
appear in the list of Java runtimes when you start the binary import wizard. This is the case for JDKs and JREs
released by Oracle, which come with an installer and register themselwves in the system when installed.
Howevwer, other Java Virtual Machine distributions that do not have an installer must be added manually into
UModel. The latter include Oracle OpendDK, SapMachine, and others.

To add custom Java runtimes to UModel:

1. On the Project menu, click Import Binary Types.
2. Select Java as language.
3. Expand the Runtime drop-down list, and click Edit user Java runtime locations.
4. Click Append and browse for the directory of the respective JDK.
Uzer Java Runtime Locations >
MName Directory Append
JDE1.8.0 181 Ch\Program Files (x8e)Javayjdk1.8.0_131
JOE11.0.1 Cihsapmachine-jdk-11.0.1.13_windows-x64_bin'sag Delete
JDE11.001 Chopenjdk-11.0,1_windows-x64_bin'jdk-11.0.1
< >
Cancel
5. Click OK.

The selected runtime now appears in the Runtime list, and you can select it whenever you need to import
binary files targeting that runtime.

Note that these settings affect only the import of binary files. For information about adding a Java Virtual
Machine&th to be used for JDBC connectivity and Java code generation and import, see Java Virtual Machine

Settings

6.4.2 Import Binary Options

When you run the menu command Project | Import Binary Types, one of the wizard steps prompts you to
specify the binary import options. The options you can set are described below. Note that the dialog box
options may be slightly different, depending on whether you are importing .NET or Java binaries.
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Import Binary Options >

Automatic Type Inclusion

[ ]izdd all referenced types, optional restricted to the following packages:

Content Restriction
[]import only types {no fields, operations etc.)
import only elements with visibility greater or equal: | public w

|:| suppress attribute sections

Attribute Section styles
] create only one attribute per attribute section
[ ] suppress "Attribute” suffix on attribute type names

Mext = Finish Cancel

Import Binary Options dialog box

Automatic type inclusion

.NET or Java binaries may reference various external assemblies or packages. Select the option add all
referenced types... if you would like to import all types referenced by the types included in the binary file.

To import referenced types only for specific Java packages or .NET namespaces, enter those packages or
namespaces in the adjacent text box. To separate multiple packages or namespaces, use the comma, semi-
colon, or space characters.

For example, let's assume that the source .NET .dll file references types from System.Reflection and
System.Data hamespaces. If you would like to import types from the System.Reflection namespace but not
from the system.Data namespace, select the option add all referenced types, optionally restricted to the
following packages and enter "System.Reflection" in the text box.

Content restriction
Select the option import only types to skip members such as fields, operations, properties, and so on.

Select the option import only elements with visibility greater than or equal to to import types and type
members according to their visibility. The table below lists visibility of types, beginning with types with least
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visibility. For example, selecting "private" will import all types, whereas selecting "public" will import only public
types and type members.

Note: |If the check box is not selected, all types will be imported, regardless of their visibility.

.NET Java
private private
internal package (default visibility when

no explicit modifier exists)

protected protected

public public

The option suppress attribute sections is applicable for .NET binaries. By default, UModel imports the C# or
VB.NET attributes detected in the binary. Select the suppress attribute sections option if you don't want to
import attributes. Otherwise, members that were decorated with attributes in the original source code will have
the <<attributes>> stereotype applied to them after you import the binary into the model. If attributes are
imported, you can display them on the diagram as tagged values, by right-clicking the class on the diagram
and selecting Tagged Values | All from the context menu. For more information, see Stereotypes and Tagged
Values .

The option suppress annotation modifiers is applicable for Java binaries. By default, UModel imports Java
annotations detected in the binary, provided that their retention policy was defined as RUNTIME (not CLASS or
SOURCE). If you don't want to import annotations, select the suppress annotation modifiers option. If
annotations are imported, members that had annotations in the original source have the <<annotations>>
stereotype, and annotations appear as tagged values, as illustrated below.

wannotationss [
madifiers = com.nanonull.Obsaolete

zannotations=

sumi) (Operation)
MyClass : pe

wannotationse modifiers = com.nanonull.Documented

% wconstructors MyClass()
% «annotations= sum(in p1:float, in p2:float):float

Attribute section styles

These options are applicable to .NET binaries only. As previously mentioned, if types or type members in the
original source code were decorated with attributes, these are imported as tagged values in UModel.

The option create only one attribute per attribute section is best illustrated by an example. Let's assume
that the original C# source code defined a method with two attributes:

using System;
using System.Diagnostics;

namespace MyNamespace
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{
class Program
{
[Conditional ("VERBOSE"), Conditional("TERSE")]
static void reportHeader()
{
Console.WriteLine("This is the header");
}
static void Main(string[] args)
{
reportHeader();
}
}
}

If the option create only one attribute per attribute section is enabled upon importing from the binary file,
then each attribute would appear on a separate line inside the "Tagged Values" element :

Program reportHeader() (Operation)
[from MyMamespace] wattributess sections = System.Diagnostics. Conditional&ttribute[" VERBOSE"
= System.Diagnostics.ConditionalAttribute[ TERSE")

EIB sattributess reportHeader(:void
EI\:’ Mainfin args:string[*]j:void
» «constructor= Program()

Otherwise, attributes would appear as comma-separated:

reportHeader() (Operation)
wattributess sections = System.Diagnostics.ConditionalAttribute["VERBOSE"), System.Diagnostics.ConditionalAttribute["TERSE")

Program
[from MyMNamespace]

EI\:’ watiributess reportHeader{):void
EI\" Main{in args:string[*]}:void
¢» «constructors Program()

Finally, the option suppress 'Attribute’ suffix on attribute type names removes the 'Attribute’ suffix of an
attribute type. For example, if this option is selected, an attribute type defined in the original code as
System.Xml.Serialization.XmlTypeAttribute would be imported as
System.Xml.Serialization.XmlType.
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6.4.3 Example: Import .NET Assemblies

This example shows you how to import binary types from the .NET Global Assembly Cache (GAC) into a
UModel C# project. The instructions are similar if you want to import binary %es from a standalone .d11 or
.exe file. To find out out how to import Java .class files, see the next topic =¥,

To import binary files from the .NET Global Assembly Cache:

1. Go the Project menu and click Import Binary Types (see screenshot below).

Import Binary Types X
Language: |CH “| |73 -
Runtime: | any {use disassembler) b

Synchronization

(® Merge Code into Model
() Overwrite Model according to Code

Diagram generation

Enable diagram generation

Back Mext = Finish Cancel

2. Choose the target language of the UModel project (C#, VB.NET, Java). In this example, C# is selected,
since we are importing a .NET GAC assembly.

3. Ifyou would like to set a specific language version for the imported UModel project, select it from the
adjacent text box. In this example, C# 7.3 is selected.

4. Optionally, select a .NET runtime version from the Runtime drop-down list. The default option is any
(use disassembler). In this case, UModel will choose a reflection API that is most appropriate for the
imported binary.

5. Ifyou import binary types into a new project, select either Merge Code into Model or Overwrite
Model according to Code.

6. Optionally, to generate class diagrams and package diagrams from the imported binary types, select
the Enable diagram generation check box. If you select this option, more diagram generation
options will be available in the next steps. See Generating Class Diagrams@ and Generating

Package Diagrams .
7. Click Next.
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8. Click Add | Assembly from Global Cache (GAC) (see screenshot below). Note that the option
Assembly from Global Cache (GAC) is only available for .NET Framework 2.x-4.x. The GAC is not
relevant to .NET Core, .NET 5 and later versions. For more information, see the Microsoft
documentation. In order to import assembly files for .NET Core, .NET 5 and .NET 6, you will need to
extract the required files from the GAC. Then click Add | Assembly File (DLL/EXE), select the
assembly files manually and add them to the project.

i
Assemnbly File (DLL/EXE]...
Assembly from Global Cache (GAC)...
Assembly from MSVS \NET References...

emaove A [—

9. Select an assembly from the dialog box. In this example, the EventViewer assembly is selected (see
screenshot below).

[El Select Aszemblies from Global Cache (GAC)...
Component Mame |‘ufersic|r1 |Runtime Assembly Name
EnvDTE100 10.0.0.0 v2.0.50727 EnvDTE100, Ve...
EnvDTE2D 2.0.0.0 v1.0.3705 EnvDTERD, Ver...
EnvDTESD 9.0.0.0 v1.0.3705 EnvDTESD, Ver...
EnvDTES03 9.0.0.0 v1.0.3705 EnvDTESOa, Ve...
EventViewer 10.0.0.0 v4.0.30319 EventViewer, V...
EventViewer.Resources 10.0.0.0 va.0 EventViewer.R...

10. Select the types you would like to import and click Next. For more information about other options of
the Import Binary Selection dialog box, see the notes below.

11. Select the import options as applicable. For more information, see Import Binary Options.

12. If you enabled diagram generation in Step 6, click Next and configure the options applicable to diagram
generation. Otherwise, click Finish.

UModel performs the conversion and displays a progress log in the Messages window. If the conversion of
binary types is not possible, the error text may provide additional information. For example, the binary file you
are trying to import is targeting a runtime newer than the one selected in the Import Binary Types dialog box.
In this case, select a newer runtime version and try again.

Notes:

e The text box Override of PATH variable... in the Import Binary Selection dialog box is applicable
only to Java. Optionally, paste here any Java class paths that must be queried in addition to those read
from the cLasspPaTH environment variable. Alternatively, click Add and browse for the required folders.

e The check box use 'reflection only' context... in the Import Binary Selection dialog box is
applicable only when you import a C# or VB.NET binary. This is useful when importing a library which
has dependencies that cannot be resolved or loaded. Selecting this check box will not execute any
static initializer code, which might cause errors when importing.
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6.4.4 Example: Import Java .class Files

This example shows you how to import compiled Java .class files into UModel. In this example, the source
Java .class files originate from a tutorial Java project that was created with UModel, but you can also use other

.class files as an alternative.

Compiling UModel-generated Java code (optional)

This section shows you how to compile a demo UModel-generated Java project with Eclipse. Note that this
step is purely optional, the goal here is to obtain some compiled .class files. You can skip it if you already have
readily available Java .class files. In this example, Eclipse is chosen as compilation environment for
convenience; however, you can use the Java command line or some other Java development environment to

achieve the same result.

1. If you haven't done that already, create a simple Java project with UModel, as shown in Example:
Generate Java Code @ This is a very simple example consisting of a Java package with only one
class. When you complete the example, the directory C:\UModelDemo\src will contain the required
Java source code.

2. Run Eclipse. On the File menu, click Import.

S Import

Select \
Analyzes the content of your folder or archive file to find projects and import thern in the IDE. E i 5 |

Select an import wizard:

JE Archive File -
122 Existing Projects into Workspace

[} File System

] Preferences

[} Projects from Folder or Archive

= Git

3. Select Projects from Folder or Archive, and click Next.

& Import Projects from File Systermn or Archive

Import Projects from File System or Archive

This wizard analyzes the content of your folder or archive file to find projects and irmnport thern in the IDE.

Import sources | ChUModelDeme

4. Enter C:\UModelDemo as directory, and click Finish.
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5. Right-click the com.nanonull package in Eclipse's Package Explorer and select New | Class from

the context menu.

6. Enter a class name ("MainClass", in this example), and select the public static void main... check

box.

Java Class

Source folder:
Package:

[ ] Enclosing type:

Mame:

Modifiers:

Superclass:

Interfaces:

)
@

& Mew Java Class

Create a new Jlava class,

| UhodelDemo/src | Browse...

| com.nanonull | Browse...
Browse...

| MainClass |

(®) public () package private protected

[ ]abstract [ ]final static

|java.|ang.0|::|ject | Browse...

Add...

Eemove

Which method stubs would you like to create?

public static void main(5tring[] args)
] Constructers from superclass

Inherited abstract methods

Do you want to add comments? (Configure templates and default value here

[ ] Generate comments

7. On the Run menu, click Run.

You have now finished compiling the UModel-generated Java project. The compiled .class files should now be
available in the bin sub-directory of your project's directory.

Finally, take note of the Java version used for compilation—this is important if you intend to import binary types
later. By default, if you did not modify your Eclipse project properties, it is likely that it was compiled with the
default Java version available to Eclipse. To view the default Java version, do the following in Eclipse:
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1. On the Window menu, click Preferences.
2. Click Java, and then click Installed JREs.

Importing Java .class files

If you already hawe binary .class files such as the ones compiled previously, you can now proceed to importing
them into UModel.

1. Create a new UModel project, or open an existing one. In this example, we are importing binary types
into a new project.
2. Ifyour project does not contain the Java JDK types already, do the following:

a. On the Project menu, click Include subproject.
b. Click the Java tab and select Java JDK (types only).
c. Select Include by reference when prompted.

Note: This is an optional step which normally prevents the "Unknown externals" package from appearing in
the project after the import is complete.

3. On the Project menu, click Import Binary Types.

4. Select Java as language, and the Java version in which the Java code was compiled (for example,
11.0).

5. Select the Java runtime to be used by UModel for extracting information from the binary files (the so-
called "reflection"). The runtime version must be equal or newer than the Java version selected in the
previous step.
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Note:

Import Binary Types x
Language: |Java P |10 ~
Rurtime: | JOK11.0.1 {C:Ydk-11.0.1) ki

Synchronization

(@) Merge Code into Model
() Owerwrite Model according to Code

Diagram generation

Enable diagram generation

Jack Meat =

1
A

nish Cancel

The Runtime drop-down list contains only Java JDKs and JREs detected automatically. If your JDK or
JRE is not listed, select the entry Edit user java runtime locations and browse for the directory
where the respective distribution is installed on your machine, see Adding Custom Java Runtimes &,

If you import binary types into a new project, select either Merge Code into Model or Overwrite
Model according to Code. Otherwise, select Merge code into Model.

Optionally, to generate class diagrams and package diagrams from the imported binary types, select
the Enable diagram generation check box. If you select this option, more diagram generation
options are available in subsequent steps, see also Generating Class Diagrams and Generating

Package Diagrams .
Click Next.

Import Binary Selection x

Binaries in load order (set check mark to import types): —[=]

Class File Archive (JAR/ZIP)...
Class File Package Root Folder...

Class Archives from Class Path...

Class Archives from Java Runtime...
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9. In this example, we are importing Java .class files from a package root. Select Add | Class File
Package Root Folder. and browse for the C:\UModelDemo\bin directory. If this directory does not
exist, make sure to compile the project first, as shown in the first part of this tutorial.

Import Binary Selection

Binaries in load order (set check mark to impaort types):

o ]|
H v C\UModelDemoibin
e[ com.nanonull.MainClass
: [ com.nanonull.MyClass
Owemide of PATH varable for searching native code libraries:
'
« Back Mext = Einish

Pt

Add J

Remove

Remawve Al

Move Up

Add

Cancel

10. Select the classes to be imported, and click Next.
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Import Binary Options

Automatic Type Inclusion

[ liadd all referenced types, optional restricted to the following packages:;

Cortent Restriction
[ ]import onty types {no fields, operations etc.)
[ ]import onty elements with visibilty greater or equal:  public

[ ] suppress annotation modiiers

< Back Meat = Finish Cancel

11. Select the import options as applicable, see Import Binary Options@.
12. If you enabled diagram generation in an earlier step, click Next and configure the options applicable to

diagram generation. Otherwise, click Finish.

UModel performs the conversion and displays a progress log in the Messages window. If the conversion of
binary types is not possible, the error text may provide additional information. For example, the binary file you
are trying to import is targeting a runtime newer than the one selected in the Import Binary Types dialog box.

In this case, select a newer runtime version and try again.
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6.5 Synchronizing the Model and Source Code

You can synchronize the model and code in either direction, and at different levels (for example, project,
package or class).

When UModel (Enterprise or Professional) runs as an Eclipse or Visual Studio plug-in, synchronization
between model and code takes place automatically. Manual synchronization is possible at the project
level; the option to update individual classes or packages is not available. For more information, see

UModel Plug-in for Visual Studio? and UModel Plug-in for Eclipse &2

When you right-click an element in the Model Tree (for example, a class), the context menu displays the code
synchronization or merging commands under the Code Engineering menu item:

¢ Merge Program Code from UModel ***
¢ Merge UModel *** from Program Code

*** is a Project, Package, Component, Class, and so on, depending on your current selection.

Depending on the settings you have defined from Project | Synchronization Settings, the alternative name of
these two commands may be:

e Overwrite Program Code from UModel ***
e Overwrite UModel *** from Program Code

To update the entire project (but not classes, packages, or other local elements), you can also use the
following commands on the Project menu of UModel:

e Merge (or Overwrite) Program Code from UModel Project
e Merge (or Overwrite) UModel Project from Program Code

For convenience, any of the commands listed above will be generically referred to as "code synchronization
commands" further in this topic.
To synchronize at the project or Root package level, do one of the following:
e Right-click the Root package in the Model Tree, and select the required code synchronization
command.
¢ On the Project menu, click the required code synchronization command.
To synchronize at package level:

1. Use Shift, or Ctrl + Click to select the package(s) you want to merge.
2. Right-click the selection, and select the required code synchronization command.
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To synchronize at class level:

1. Use Shift, or Ctrl + Click to select the classes(s) you want to merge.
2. Right-click the selection, and click the required code synchronization command.

To awid undesired results when synchronizing the model and code, consider the following scenarios:

On the Project menu, click Overwrite
UModel Project from Program Code.

This checks all directories (project files) of all different code
languages you have defined in your project.

New files are identified and added to the project.

An entry "Collecting source files in (...)" appears in the
Messages window.

Right-click a class or interface in the Model
Tree and select Code Engineering |
Overwrite UModel Class from Program
Code.

This updates only the selected class (interface) of your
project.

If the source code contains classes that are new or
modified classes since the last synchronization, those
changes will not be added to the model.

Right-click a Component in the Model Tree
(within the Component View package) and
select Code Engineering | Overwrite
UModel Component from Program Code.

This updates the corresponding directory (or project file)
only.

New files in the directory (project file) are identified and
added to the project.

An entry "Collecting source files in (...)" appears in the
Message window.

Note: When synchronizing code, you might be prompted to update your UModel project before
synchronization. This occurs when you open UModel projects created before the latest release. Click
Yes to update your project to the latest release format, and save your project file. The notification
message will not occur once this has been done.

6.5.1 Synchronization Tips

Renaming of classifiers and reverse engineering

The process described below applies to the standalone application as well as to the plug-in versions (Visual
Studio or Eclipse) when reverse engineering or automatic synchronization takes place.

Renaming a classifier in the code window of your programming application causes it to be deleted and re-

inserted as new classifier in the Model Tree.

The new classifier is only re-inserted in those modeling diagrams that are automatically created during the
reverse-engineering process, or when generating a diagram using the Show in new Diagram | Content
option. The new classifier is inserted at a default position on the diagram, that will likely differ from the previous

location.

See also Refactoring code and synchronization.
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Automatic generation of ComponentRealizations

UModel is capable of automatically generating ComponentRealizations during the code engineering process.
ComponentRealizations are only generated where it is absolutely clear to which component a class should be
assigned:

e Only one Visual Studio project file exists in the .ump project.
e Multiple Visual Studio projects exist but their classes are completely separate in the model.

To enable automatic generation of ComponentRealizations:

1. Open the menu item Tool | Options.
2. Click the Code Engineering tab and activate the Generate missing ComponentRealizations
option.

Automatic ComponentRealizations are created for a Classifier that can be assigned one (and only one)
Component

¢ without any ComponentRealizations, or
e contained in a code language namespace.

The way the Component is found differs for the two cases.
Component representing a code project file (property "projectfile” set)

e ifthere is ONE Component having/realizing classifiers in the containing package

e ifthere is ONE Component having/realizing classifiers in a subpackage of the containing package (top
down)

e ifthere is ONE Component having/realizing classifiers in one of the parent packages (bottom up)

e ifthere is ONE Component having/realizing classifiers in a subpackage of one of the parent packages
(top down)

Component representing a directory (property "directory" set)

e ifthere is ONE Component having/realizing classifiers in the containing package
e ifthere is ONE Component having/realizing classifiers in one of the parent packages (bottom up)

e The option "Code Engineering | Generate missing ComponentRealizations" has to be set.
e As soon as ONE viable Component is found during one of the abowe steps, this Component is used
and the remaining steps are ignored.

Error/Warnings:

e If no viable Component was found, a warning is generated (message log)
e If more than one viable Component was found, an error is generated (message log)
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6.5.2 Refactoring Code and Synchronization

When refactoring code, it is often the case that class names are changed or updated in the code. If it detects
that new types have been added or renamed during reverse engineering, UModel (version 2009 or later) displays
a dialog box. The new types are listed in the "Name in code" column while the assumed original type name is
listed in the "Name in model" column. UModel attempts to determine the original name by relying on
namespace, class content, base classes and other data.

¥ -.

@ Select Renamed Types @

Uk odel has detected new typez while reverse engineerning. |f zome of these
bppes are not new but have been renamed, pleaze zelect the previous type

name.
Name in code Namespace INﬂme in model
Class Account com.altova. bankview Checkingfccount = |

k. l | Cancel [treat all az new)

If a class was renamed, select the previous class name using the combo box in the "Name in model" column,
e.g. C1. This ensures that all related data are retained and the code engineering process remains accurate.

Changing class names in the model and regenerating code

Having created a model and generated code from it, it is possible that you might want to make changes to the
model again before going through the synchronization process.

E.g. You decide that you want to change the class names before generating code the second time round. As
you previously assigned a file name to each class, in the "code file name" field of the Properties window, the
new class and file name would now be out of sync.

UModel prompts if you want the code file name to agree with the new class name, when you start the
synchronization process. Note that you also have the option to change the class constructors as well.

Round-trip engineering and relationships between modeling elements

When updating model from code, associations between modeling elements are automatically displayed, if the
option Diagram Editing | Automatically create Associations has been activated in the Tools | Options
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dialog box. Associations are displayed for those elements where the attributes type is set, and the referenced
"type" modeling element is in the same diagram.

InterfaceRealizations as well as Generalizations are all automatically shown in the diagram when
updating model from code.

6.5.3 Code Synchronization Settings

The code synchronization settings are relevant in the following scenarios:

e When program code is generated from the model (that is, when either the command Project | Merge
Program Code from UModel Project or the command Project | Overwrite Program code from
UModel Project is run)

e When source code is imported into the model (that is, when either the command Project | Merge
UModel Project from Program Code or the command Project | Overwrite UModel Project from
Program Code is run)

e When automatic synchronization takes place in either direction (this applies to UModel Enterprise and
Professional Editions when UModel runs as a Visual Studio or Eclipse plug-in).

To change the code synchronization settings:

e On the Project menu, click Synchronization Settings.

Synchronization Settings

Code from Model  Model from Code

SPL templates
User-defined ovenide default

When deleting Code
(® Comment out () Delete

Synchronization
(®) Merge Model into Code
() Overwrite Code according to Model

Alwayz shaw dialog when synchranizing
: Project Settings k. Cancel

Synchronization Settings dialog box

By default, the Synchronization Settings dialog box will be displayed automatically every time when you initiate
any of the code synchronization commands. To disable this behaviour, clear the check box Always show
dialog when synchronizing.

Altova UModel 2024 Professional Edition © 2017-2023 Altova GmbH



Projects and Code Engineering Synchronizing the Model and Source Code 221

The available options are grouped into two tabs:

¢ Code from Mode

I (options in this tab are applicable when program code is generated from the model)

¢ Model from Code (options in this tab are applicable when program code is imported into the model).

Option

Description

SPL templates

This option is applicable only when generating program code. Select the check box
User-defined override default check box if you have created custom Spy
Programming Language (SPL) templates that should owerride the default ones
supplied with UModel (see also SPL Templates@).

When deleting code

This option is applicable only when generating program code. Select whether
program code should be deleted or commented out during synchronization
(assuming the relevant objects no longer exist in the model).

Synchronization

This option is applicable both when generating and importing program code. It lets
you specify whether changes should be merged as opposed to being overwritten.
Assuming that code has been generated once from a model, and changes have
since been made to both model and code, for example:

e A new class Xhas been added in UModel
e A newclass Y has been added to the external code,

Merge Model into Code means that:

e The newly added class Y in the external code is retained
e The newly added class X, from UModel, is added to the code.

Overwrite Code according to Model means that:
e The newly added class Y in the external code is deleted (or commented
out, depending on the current settings)
e The newly added class X, from UModel, is added to the code.

Merge Code into Model means that:

e The newly added class Xin UModel is retained
e The newly added class Y, from the external code, is added to the model

Overwrite Model according to Code means that:
e The newly added class Xin UModel is deleted (or commented out,

depending on the current settings)
e The newly added class Y, from the external code, is added to the model.

Project settings

Opens the Project Settings dialog box, where you can modify the code engineering
settings gplicable to each language. For reference to all settings, see Code Import
Options and Code Generation Options , respectively.
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Option Description

The Project Settings dialog box can also be triggered from the menu command
Project | Project Settings. Note that the project settings in this dialog box are
global (they are saved together with the project and are applicable on any
workstation where the UModel project is open) whereas the options you define from
Tools | Options are local (they are applicable only to the current installation of
UModel).
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6.6 UModel Element Mappings

This section illustrates how UModel elements map to elements (constructs) in various programming languages
(C#, Java, VB.NET), as well as to databases and XML schemas. The mappings are grouped by language, and
are applicable when importing code into model, or when generating code from model.

C# Mappings &9

VB.NET Mappings

Java Mappings

XML Schema Mappinas@
Database Mappings

6.6.1 C# Mappings

The table below shows the one-to-one correspondence between:

e UModel elements and C# code elements, when outputting model to code
e C# code elements and UModel model elements, when inputting code into model

C# Project
C# UModel
Project projectfile projectfile Component
directory directory
C# Namespace
C# UModel
Namespace name name Package <<namespace>>
C# Class
C# UModel
Class name name Class
modifiers internal visibility package
protected internal protected <<internal>>
public public
protected protected
private private
sealed leaf
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C# UModel
abstract abstract
static <<static>>
unsafe <<unsafe>>
partial <<partial>>
new <<new >>

filename

code file name

associated projectfile/directory

ComponentRealization

base types

Generalization, InterfaceRealization(s)

attribute sections

<<attributes>>

doc comments

Comment(->Documentation)

modifiers internal

visibility package

Field name name Property
modifiers internal visibility package
protected internal protected <<internal>>
public public
protected protected
private private
static static
readonly readonly
volatile <<volatile>>
unsafe <<unsafe>>
new <<new >>
type type
type dimensions multiplicity
type pointer type modifier
nullable <<nullable>>
default value default
attribute sections <<attributes>>
doc comments Comment(->Documentation)
Constant name name Property
<<const>>
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C# UModel
protected internal protected <<internal>>
public public
protected protected
private private
new <<new >>

type type

type dimensions multiplicity
type pointer type modifier
nullable <<nullable>>
default value default
attribute sections <<attributes>>

doc comments

Comment(->Documentation)

Method

name name

modifiers internal visibility package
protected internal protected <<internal>>
public public
protected protected
private private
static static
abstract abstract
sealed leaf
override <<override>>
partial <<partial>>
virtual <<virtual>>
new <<new >>
unsafe <<unsafe>>

attribute sections <<attributes>>

doc comments

Comment(->Documentation)

implemented interfaces

implements

type

direction return Parameter

Operation
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C# UModel
Parameter | name name
modifiers ref direction inout
out out
params varArgList
type type
type dimensions multiplicity
type pointer type modifier
this <<this>>
nullable <<nullable>>
Type name name Template
Parameter Parameter
constraint constraining classifier
predefine | struct <<ValueTypeConstraint
d >>
constraint
class <<ReferenceTypeConst
raint>>
new () <<ConstructorConstrain
t>>
attribute sections <<attributes>>
Construct | name name Operation
or <<constru
modifiers internal visibility package ctor>>
protected internal protected <<internal>>
public public
protected protected
private private
static static
unsafe <<unsafe>>
attribute sections <<attributes>>

doc comments

Comment(->Documentation)

Parameter | name

name Parameter

modifiers

ref

out

direction inout

out
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doc comments

Comment(->Documentation)

type direction return Parameter
type dimensions multiplicity

nullable <<nullable>>

Get modifiers internal visibility internal <<GetAcc

C# UModel
params varArgList
type type
type dimensions multiplicity
type pointer type modifier
nullable <<nullable>>
Destructor | name name Operation
<<destruc
modifiers private visibility private tor>>
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
Property name name Operation
<<propert
modifiers internal visibility package y>>
protected internal protected <<internal>>
public public
protected protected
private private
static static
abstract abstract
sealed leaf
override <<override>>
virtual <<virtual>>
new <<new >>
unsafe <<unsafe>>
attribute sections <<attributes>>
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C# UModel
protected protected
internal internal
protected protected
private private
Set modifiers internal visibility internal <<SetAcc
Accessor essor>>
protected protected
internal internal
protected protected
private private
Operator name name Operation
<<operato
modifiers public visibility public r>>
static static
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
Parameter | name name
modifier params varArgList
type type
type dimensions multiplicity
type pointer type modifier
nullable <<nullable>>
Indexer name (="this") name (="this") Operation
<<indexer
modifiers internal visibility package >>
protected internal protected <<internal>>
public public
protected protected
private private
static static
abstract abstract
sealed leaf
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C# UModel
override <<override>>
virtual <<virtual>>
new <<new >>
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
Parameter | name name
modifier params varArgList
type type
type dimensions multiplicity
type pointer type modifier
nullable <<nullable>>
Get modifiers internal visibility internal <<GetAcc
Accessor essor>>
protected protected
internal internal
protected protected
private private
Set modifiers internal visibility internal <<SetAcc
Accessor essor>>
protected protected
internal internal
protected protected
private private
Event name name Operation
<<event>>
modifiers internal visibility package
protected internal protected <<internal>>
public public
protected protected
private private
static static
abstract abstract
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C# UModel
sealed leaf
override <<override>>
virtual <<virtual>>
new <<new >>
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
type dimensions multiplicity
nullable <<nullable>>
Add Accessor <<AddRemoveAccessor>>
Remove Accessor
Type name name Template
Parameter Parameter
constraint constraining classifier
predefine | struct <<ValueTypeConstraint>>
gonstraint class <<ReferenceTypeConstraint>>
new () <<ConstructorConstraint>>
attribute sections <<attributes>>
C# Struct
C# UModel
Struct name name Class
<<struct>
modifiers internal visibility package >
protected internal protected <<internal>>
public public
protected protected
private private
unsafe <<unsafe>>
partial <<partial>>
new <<new >>
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C# UModel
filename code file name
associated projectfile/directory ComponentRealization
base types InterfaceRealization(s)
attribute sections <<attributes>>
doc comments Comment(->Documentation)
Field name name Property
modifiers internal visibility package
protected internal protected <<internal>>
public public
protected protected
private private
static static
readonly readonly
volatile <<volatile>>
unsafe <<unsafe>>
new <<new >>
type type
type dimensions multiplicity
type pointer type modifier
nullable <<nullable>>
default value default
attribute sections <<attributes>>
doc comments Comment(->Documentation)
Constant name name Property
<<const>>
modifiers internal visibility package
protected internal protected <<internal>>
public public
protected protected
private private
new <<new >>
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C# UModel
type type
type dimensions multiplicity
type pointer type modifier
nullable <<nullable>>
default value default
attribute sections <<attributes>>
doc comments Comment(->Documentation)
Fixedsize | name name Property
Buffer <<fixed>>
modifiers internal visibility package
protected internal protected <<internal>>
public public
protected protected
private private
unsafe <<unsafe>>
new <<new >>
type type
type pointer type modifier
nullable <<nullable>>
buffer size default
attribute sections <<attributes>>
doc comments Comment(->Documentation)
Method name name Operation
modifiers internal visibility package
protected internal protected <<internal>>
public public
protected protected
private private
static static
abstract abstract
sealed leaf

Altova UModel 2024 Professional Edition © 2017-2023 Altova GmbH



Projects and Code Engineering

UModel Element Mappings

233

C# UModel
override <<override>>
partial <<partial>>
virtual <<virtual>>
new <<new >>
unsafe <<unsafe>>
attribute sections <<attributes>>

doc comments

Comment(->Documentation)

implemented interfaces implements
type direction return Parameter
Parameter | name name
modifiers ref direction inout
out out
params varArgList
type type
type dimensions multiplicity
type pointer type modifier
this <<this>>
nullable <<nullable>>
Type name name Template
Parameter Parameter
constraint constraining classifier
predefine | struct <<ValueTypeConstraint
d >>
constraint
class <<ReferenceTypeConst
raint>>
new () <<ConstructorConstrain
t>>
attribute sections <<attributes>>
Construct | name name Operation
or <<constru
modifiers internal visibility package ctor>>
protected internal protected <<internal>>
public public
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C# UModel
protected protected
private private
static static
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
Parameter | name name Parameter
modifiers ref direction inout
out out
params varArgList
type type
type dimensions multiplicity
type pointer type modifier
nullable <<nullable>>
Destructor | name name Operation
<<destruc
modifiers private visibility private tor>>
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
Property name name Operation
<<propert
modifiers internal visibility package y>>
protected internal protected <<internal>>
public public
protected protected
private private
static static
abstract abstract
sealed leaf
override <<override>>
virtual <<virtual>>
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C# UModel
new <<new >>
unsafe <<unsafe>>
attribute sections <<attributes>>

doc comments

Comment(->Documentation)

type direction return Parameter
type dimensions multiplicity
nullable <<nullable>>
Get modifiers internal visibility internal <<GetAcc
Accessor essor>>
protected protected
internal internal
protected protected
private private
Set modifiers internal visibility internal <<SetAcc
Accessor essor>>
protected protected
internal internal
protected protected
private private
Operator name name Operation
<<operato
modifiers public visibility public r>>
static static
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
Parameter | name name
modifier params varArgList
type type
type dimensions multiplicity
type pointer type modifier
nullable <<nullable>>
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C# UModel
Indexer name (="this") name (="this") Operation
<<indexer
modifiers internal visibility package >>
protected internal protected <<internal>>
public public
protected protected
private private
static static
abstract abstract
sealed leaf
override <<override>>
virtual <<virtual>>
new <<new >>
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
Parameter | name name
modifier params varArgList
type type
type dimensions multiplicity
type pointer type modifier
nullable <<nullable>>
Get modifiers internal visibility internal <<GetAcc
Accessor essor>>
protected protected
internal internal
protected protected
private private
Set modifiers internal visibility internal <<SetAcc
Accessor essor>>
protected protected
internal internal
protected protected
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C# UModel
private private
Event name name Operation
<<event>>
modifiers internal visibility package
protected internal protected <<internal>>
public public
protected protected
private private
static static
abstract abstract
sealed leaf
override <<override>>
virtual <<virtual>>
new <<new >>
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
type dimensions multiplicity
nullable <<nullable>>
Add Accessor <<AddRemoveAccessor>>
Remove Accessor
Type name name Template
Parameter Parameter
constraint constraining classifier
predefine | struct <<ValueTypeConstraint>>
Sonstraint class <<ReferenceTypeConstraint>>
new () <<ConstructorConstraint>>
attribute <<attributes>>
sections
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C# Interface
C# UModel
Interface name name Interface
modifiers internal visibility package
protected internal protected <<internal>>
public public
protected protected
private private
unsafe <<unsafe>>
partial <<partial>>
new <<new >>
filename code file name

associated projectfile/directory

ComponentRealization

base types

Generalization(s)

attribute sections

<<attributes>>

doc comments

Comment(->Documentation)

Method

name

name

Operation

modifiers public

visibility public

new <<new >>
unsafe <<unsafe>>
attribute sections <<attributes>>

doc comments

Comment(->Documentation)

Parameter

type direction return
Parameter | name name
modifiers ref direction inout
out out
params varArgList
type type
type dimensions multiplicity
type pointer type modifier
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C# UModel
this <<this>>
nullable <<nullable>>
Type name name Template
Parameter Parameter
constraint constraining classifier
predefine | struct <<ValueTypeConstraint
d >>
constraint
class <<ReferenceTypeConst
raint>>
new () <<ConstructorConstrain
t>>
attribute sections <<attributes>>
Property name name Operation
<<propert
modifiers | public visibility public y>>
new <<new >>
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
type dimensions multiplicity
nullable <<nullable>>
Get modifiers internal visibility internal <<GetAcc
Accessor essor>>
protected protected
internal internal
protected protected
private private
Set modifiers internal visibility internal <<SetAcc
Accessor essor>>
protected protected
internal internal
protected protected
private private
Indexer name (="this") name (="this") Operation
<<indexer
modifiers public visibility public >>
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C# UModel
new <<new >>
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
Parameter | name name
modifier params varArgList
type type
type dimensions multiplicity
type pointer type modifier
nullable <<nullable>>
Get modifiers internal visibility internal <<GetAcc
Accessor essor>>
protected protected
internal internal
protected protected
private private
Set modifiers internal visibility internal <<SetAcc
Accessor essor>>
protected protected
internal internal
protected protected
private private
Event name name Operation
<<event>>
modifiers public visibility public
new <<new >>
unsafe <<unsafe>>
attribute sections <<attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
type dimensions multiplicity
nullable <<nullable>>
Add Accessor <<AddRemoveAccessor>>
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C# UModel
Remove Accessor
Type name name Template
Parameter Parameter
constraint constraining classifier
predefine | struct <<ValueTypeConstraint>>
gonstraint class <<ReferenceTypeConstraint>>
new () <<ConstructorConstraint>>
attribute sections <<attributes>>
C# Delegate
C# UModel
Delegate name name Class
<<delegat
modifiers internal visibility package e>>
protected internal protected <<internal>>
public public
protected protected
private private
unsafe <<unsafe>>
new <<new >>
filename code file name
associated projectfile/directory ComponentRealization
attribute sections <<attributes>>
doc comments Comment(->Documentation)
type direction return Parameter | Operation
Parameter | name name
modifiers ref direction inout
out out
params varArgList
type type
type dimensions multiplicity
type pointer type modifier
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C# UModel
nullable <<nullable>>
Type name name Template
Parameter Parameter
constraint constraini
ng
classifier
predefine | struct <<ValueTypeConstraint
d >>
constraint
class <<ReferenceTypeConst
raint>>
new () <<ConstructorConstrain
t>>
attribute <<attribute
sections S>>
C# Enum
C# UModel
Enum name name Enumeration
modifiers internal visibility package
protected internal protected
<<internal>>
public public
protected protected
private private
new <<new >>
filename code file name
associated projectfile/directory ComponentRealization
base type type <<BaseType>>
attribute sections <<attributes>>
doc comments Comment(-
>Documentation)
Enum Constant name name Enumeration Literal
default value default
attribute sections <<attributes>>
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C# UModel
doc comments Comment(-
>Documentation)
C# Parameterized Type
C# UModel
Parameterized Type Anonymous Bound Element
6.6.2 VB.NET Mappings

The table below shows the one-to-one correspondence between:

e UModel elements and VB.NET code elements, when outputting model to code

e VB.NET code elements and UModel model elements, when inputting code into model

VB.NET UModel
Project projectfile projectfile Componen
directory directory t
Namespac | name name Package
e <<namesp
ace>>
Class name name Class
modifiers Friend visibility package
Protected Friend protected <<Friend>>
Public public
Protected protected
Private private
NotInheritable leaf
Mustinherit abstract
Partial <<Partial>>
Shadow s <<Shadow s>>

filename

code file name

associated projectfile/directory

ComponentRealization

base types

Generalization, InterfaceRealization(s)
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VB.NET

UModel

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)

Field name name Property
modifiers Friend visibility
Protected Friend protected <<Friend>>
Public
Protected
Private
Shared static
ReadOnly readonly
Shadow s <<Shadow s>>
type type
type dimensions multiplicity
nullable <<Nullable>>
default value default
attribute sections <<Attributes>>
doc comments Comment(->Documentation)
Constant name name Property
<<Const>
modifiers Friend visibility >
Protected Friend protected <<Friend>>
Public
Protected
Private
Shadow s <<Shadow s>>
type type
type dimensions multiplicity
nullable <<Nullable>>
default value default

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)

Altova UModel 2024 Professional Edition

© 2017-2023 Altova GmbH



Projects and Code Engineering

UModel Element Mappings

245

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)

implemented interfaces implements
type (function) direction return Parameter
Parameter | name name
modifiers ByRef direction inout
ByVal in
ParamArr | varArgList
ay
Optional default
type type
type dimensions multiplicity
nullable <<Nullable>>
Type name name Template
Parameter Parameter
constraint constraining classifier
predefine | Structure | <<ValueTypeConstraint
d >>

VB.NET UModel
Method name name Operation
modifiers Friend visibility package
Protected Friend protected <<Friend>>
Public public
Protected protected
Private private
Shared static
MustOverride abstract
NotOverridable leaf
Overrides <<Overrides>>
Overridable <<Overridable>>
Partial <<Partial>>
Shadow s <<Shadow s>>
Overloads <<Overloads>>
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VB.NET UModel
constraint | Class <<ReferenceTypeConst
raint>>
New <<ConstructorConstrain
t>>
attribute sections <<Attributes>>
Construct | name name Operation
or <<Constru
modifiers Friend visibility package ctor>>
Protected Friend protected <<Friend>>
Public public
Protected protected
Private private
Shared static
attribute sections <<Attributes>>
doc comments Comment(->Documentation)
Parameter | name name Parameter
modifiers ByRef direction inout
ByVal in
ParamArr | varArgList
ay
Optional default
type type
type dimensions multiplicity
nullable <<Nullable>>
Property name name Operation
<<Propert
modifiers Friend visibility package y>>
Protected Friend protected <<Friend>>
Public public
Protected protected
Private private
Default <<Property>> ( Default <= IsDefault )
Shared static
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VB.NET

UModel
MustOverride abstract
NotOverridable leaf
Overrides <<Overrides>>
Overridable <<Overridable>>
Shadow s <<Shadow s>>
Overloads <<Overloads>>
ReadOnly <<GetAccessor>> ( without
<<SetAccessor>>)
WriteOnly <<SetAccessor>> ( without

<<GetAccessor>>)

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)

type direction return Parameter
type dimensions multiplicity
nullable <<Nullable>>
Get modifiers Friend visibility Friend <<GetAcc
Accessor essor>>
Protected Protected
Friend Friend
Protected Protected
Private Private
Set modifiers Friend visibility Friend <<SetAcc
Accessor essor>>
Protected Protected
Friend Friend
Protected Protected
Private Private
Operator name name Operation
<<Operato
modifiers Public visibility Public r>>
Shared static
Narrow ing name <= Narrow ing
Widening name <= Widening
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VB.NET UModel
type direction return Parameter
Parameter | name name
modifier ByVal direction in
type type
type dimensions multiplicity
nullable <<Nullable>>
Event name name Operation
<<Event>>
modifiers Friend visibility package
Protected Friend protected <<Friend>>
Public public
Protected protected
Private private
Shared static
MustOverride abstract
NotOverridable leaf
Overrides <<Overrides>>
Overridable <<Overridable>>
Shadow s <<Shadow s>>
Overloads <<Overloads>>
kind w ithout specifying a <<Event>> ( Type <= Simple )
delegate type
w ith specifying a <<EBvent>> ( Type <= Regular )
delegate type
w ith custom accessors | <<Event>> ( Type <= Custom)
attribute sections <<Attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
type dimensions multiplicity
nullable <<Nullable>>
Type name name Template
Parameter Parameter
constraint constraining classifier
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VB.NET UModel
predefine | Structure <<ValueTypeConstraint>>
gonstraint Class <<ReferenceTypeConstraint>>
New <<ConstructorConstraint>>
attribute sections <<Attributes>>
Structure | name name Class
<<Structur
modifiers Friend visibility package e>>
Protected Friend protected <<Friend>>
Public public
Protected protected
Private private
Partial <<Partial>>
Shadow s <<Shadow s>>

filename

code file name

associated projectfile/directory

ComponentRealization

base types

InterfaceRealization(s)

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)

Property

Field name name

modifiers Friend visibility package
Public public
Private private
Shared static
ReadOnly readonly
Shadow s <<Shadow s>>

type type

type dimensions multiplicity

nullable <<Nullable>>

default value default

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)
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VB.NET UModel
Constant name name Property
<<Const>
modifiers Friend visibility package >
Public public
Private private
Shadow s <<Shadow s>>
type type
type dimensions multiplicity
nullable <<Nullable>>
default value default
attribute sections <<Attributes>>
doc comments Comment(->Documentation)
Method name name Operation
modifiers Friend visibility package
Public public
Private private
Shared static
MustOverride abstract
NotOverridable leaf
Overrides <<Overrides>>
Overridable <<Overridable>>
Partial <<Partial>>
Shadow s <<Shadow s>>
Overloads <<Overloads>>

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)

implemented interfaces implements
type (function) direction return Parameter
Parameter | name name
modifiers ByRef direction inout
ByVal in
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VB.NET UModel
ParamArr | varArgList
ay
Optional default
type type
type dimensions multiplicity
nullable <<Nullable>>
Type name name Template
Parameter Parameter
constraint constraining classifier
predefine | Structure | <<ValueTypeConstraint
d >>
constraint
Class <<ReferenceTypeConst
raint>>
New <<ConstructorConstrain
t>>
attribute sections <<Attributes>>
Construct | name name Operation
or <<Constru
modifiers Friend visibility package ctor>>
Public public
Private private
Shared static
attribute sections <<Attributes>>
doc comments Comment(->Documentation)
Parameter | name name Parameter
modifiers ByRef direction inout
ByVal in
ParamArr | varArgList
ay
Optional default
type type
type dimensions multiplicity
nullable <<Nullable>>
Property name name Operation
<<Propert

© 2017-2023 Altova GmbH

Altova UModel 2024 Professional Edition



252 Projects and Code Engineering UModel Element Mappings
VB.NET UModel
modifiers Friend visibility package y>>
Public public
Private private
Shared static
Default <<Property>> ( Default <= IsDefault )
MustOverride abstract
NotOverridable leaf
Overrides <<Overrides>>
Overridable <<Overridable>>
Shadow s <<Shadow s>>
Overloads <<Overloads>>
ReadOnly <<GetAccessor>> ( without
<<SetAccessor>>)
WriteOnly <<SetAccessor>> ( without
<<GetAccessor>>)
attribute sections <<Attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
type dimensions multiplicity
nullable <<Nullable>>
Get modifiers Friend visibility Friend <<GetAcc
Accessor essor>>
Private Private
Set modifiers Friend visibility Friend <<SetAcc
Accessor essor>>
Private Private
Operator name name Operation
<<Operato
modifiers | Public visibility Public r>>
Shared static
Narrow ing name <= Narrow ing
Widening name <= Widening

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)
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VB.NET UModel
type direction return Parameter
Parameter | name name
modifier ByVal direction in
type type
type dimensions multiplicity
nullable <<Nullable>>
Event name name Operation
<<Event>>
modifiers Friend visibility package
Public public
Private private
Shared static
MustOverride abstract
NotOverridable leaf
Overrides <<Overrides>>
Overridable <<Overridable>>
Shadow s <<Shadow s>>
Overloads <<Overloads>>
kind w ithout specifying a <<Bvent>> ( Type <= Simple )
delegate type
w ith specifying a <<Event>> ( Type <= Regular )
delegate type
w ith customaccessors | <<Event>> ( Type <= Custom)
attribute sections <<Attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
type dimensions multiplicity
nullable <<Nullable>>
Type name name Template
Parameter Parameter
constraint constraining classifier
predefine | Structure <<ValueTypeConstraint>>
Sonstraint Class <<ReferenceTypeConstraint>>
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VB.NET UModel
New <<ConstructorConstraint>>
attribute sections <<Attributes>>
Interface name name Interface

modifiers Friend visibility package
Protected Friend protected <<Friend>>
Public public
Protected protected
Private private
Shadow s <<Shadow s>>

filename code file name

associated projectfile/directory

ComponentRealization

base types

Generalization(s)

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)

Method name name
modifiers | Public visibility public
Shadow s <<Shadow s>>

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)

type (function) direction return Parameter
Parameter | name name
modifiers ByRef direction inout
ByVal in
ParamArr | varArgList
ay
Optional default
type type
type dimensions multiplicity
nullable <<Nullable>>
Type name name Template

Operation
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VB.NET

UModel
constraint constraining classifier
predefine | Structure | <<ValueTypeConstraint
d >>
constraint
Class <<ReferenceTypeConst
raint>>
New <<ConstructorConstrain
t>>

attribute sections

<<Attributes>>

delegate type

w ith specifying a
delegate type

<<Event>> ( Type <= Regular )

attribute sections

<<Attributes>>

doc comments

Comment(->Documentation)

type direction return Parameter
type dimensions multiplicity
nullable <<Nullable>>

Property name name Operation
<<Propert
modifiers Public visibility public y>>
Default <<Property>> ( Default <= IsDefault )
Shadow s <<Shadow s>>
ReadOnly <<GetAccessor>> ( without
<<SetAccessor>>)
WriteOnly <<SetAccessor>> ( without
<<GetAccessor>>)
attribute sections <<Attributes>>
doc comments Comment(->Documentation)
type direction return Parameter
type dimensions multiplicity
nullable <<Nullable>>
Event name name Operation
<<BEvent>>
modifiers Public visibility public
Shadow s <<Shadow s>>
kind w ithout specifying a <<Event>> ( Type <= Simple )
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VB.NET UModel
Type name name Template
Parameter Parameter
constraint constraining classifier
predefine | Structure <<ValueTypeConstraint>>
Sonstraint Class <<ReferenceTypeConstraint>>
New <<ConstructorConstraint>>
attribute sections <<Attributes>>
Delegate name name Class
<<Delegat
modifiers Friend visibility package e>>
Protected Friend protected <<Friend>>
Public public
Protected protected
Private private
Shadow s <<Shadow s>>
filename code file name
associated projectfile/directory ComponentRealization
attribute sections <<Attributes>>
doc comments Comment(->Documentation)
type direction return Parameter | Operation
Parameter | name name
modifiers ByRef direction inout
ByVal in
type type
type dimensions multiplicity
nullable <<Nullable>>
Type name name Template
Parameter Parameter
constraint constraining classifier

predefine | struct

<<ValueTypeConstraint>>

d
constraint | class

<<ReferenceTypeConstraint>>

new ()

<<ConstructorConstraint>>

attribute sections

<<Attributes>>
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VB.NET UModel
Enum name name Enumerati
on
modifiers Friend visibility package
Protected Friend protected <<Friend>>
Public public
Protected protected
Private private
Shadow s <<Shadow s>>
filename code file name
associated projectfile/directory ComponentRealization
base type type <<BaseTy
pe>>
attribute sections <<Attributes>>
doc comments Comment(->Documentation)
Enum name name Enumerati
Constant on Literal
default value default
attribute sections <<Attributes>>
doc comments
Comment(->Documentation)
Parameterized Type Anonymous Bound Eement
6.6.3 Java Mappings
The table below shows the one-to-one correspondence between:
e UModel elements and Java code elements, when outputting model to code
¢ Java code elements and UModel model elements, when inputting code into model
Java UModel
Project projectfile projectfile Componen
t
directory directory
Package name name Package
<<namesp
ace>>
Class name name Class
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Java UModel

modifiers package visibility package

public public

protected protected

private private

abstract abstract

strictfp <<strictfp>>

final <<final>>
filename code file name

associated projectfile/directory

ComponentRealization

extends clause

Generalization

implements clause

InterfaceRealization(s)

java docs Comment(->Documentation)
Field name name Property
modifiers package visibility package
public public
protected protected
private private
static static
transient <<transient>>
volatile <<volatile>>
final <<final>>
type type
type dimensions multiplicity
default value default
java docs Comment(->Documentation)
Method name name Operation
modifiers package visibility package
public public
protected protected
private private
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Java UModel
static static
abstract abstract
final <<final>>
native <<native>>
strictfp <<strictfp>>
synchronized <<synchronized>>

throw s clause

raised exceptions

protected

private

protected

private

throw s clause

raised exceptions

java docs Comment(->Documentation)
Parameter | name name Parameter
modifier final <<final>>
varArgList
type type
type dimensions multiplicity
Type name name Template
Parameter Parameter
bound constraining classifier

java docs Comment(->Documentation)
type direction return Parameter
Parameter | name name
modifier final <<final>>
varArgList
type type
type dimensions multiplicity
Type name name Template
Parameter Parameter
bound constraining classifier
Construct | name name Operation
or <<constru
modifiers public visibility public ctor>>
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Java UModel
Type name name Template
Parameter Parameter
bound constraining classifier
Interface name name Interface
modifiers package visibility package
public public
protected protected
private private
abstract abstract
strictfp <<strictfp>>
filename code file name
associated projectfile/directory ComponentRealization
extends clause Generalization(s)
java docs Comment(->Documentation)
Field name name Property
modifiers public visibility public
static static
final <<final>>
type type
type dimensions multiplicity
default value default
java docs Comment(->Documentation)
Method name name Operation
modifiers public visibility public
abstract abstract

throw s clause

raised exceptions

java docs Comment(->Documentation)
type direction return Parameter
Parameter | name name
modifier final <<final>>
varArgList
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Java UModel
type type
type dimensions multiplicity
Type name name Template
Parameter Parameter
bound constraining classifier
Type name name Template
Parameter Parameter
bound constraining classifier
Enum name name Enumerati
on
modifiers package visibility package
public public
protected protected
private private
filename code file name
associated projectfile/directory ComponentRealization
java docs Comment(->Documentation)
Enum name name Enumerati
Constant on Literal
Field name name Property
modifiers package visibility package
public public
protected protected
private private
static static
transient <<transient>>
volatile <<volatile>>
final <<final>>
type type
type dimensions multiplicity
default value default
java docs Comment(->Documentation)
Method name name Operation
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Java UModel
modifiers package visibility package
public public
protected protected
private private
static static
abstract abstract
final <<final>>
native <<native>>
strictfp <<strictfp>>
synchronized <<synchronized>>
throw s clause raised exceptions
java docs Comment(->Documentation)
type direction return Parameter
Parameter | name name
modifier final <<final>>
varArgList
type type
type dimensions multiplicity
Type name name Template
Parameter Parameter
bound constraining classifier
Construct | name name Operation
or <<constru
modifiers public visibility public ctor>>
protected protected
private private
throw s clause raised exceptions
java docs Comment(->Documentation)
Parameter | name name Parameter
modifier final <<final>>
varArgList
type type
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Java UModel
type dimensions multiplicity
Type name name Template
Parameter Parameter
bound constraining classifier

Parameterized Type

Anonymous Bound Hement

Annotation

<<annotations> modifiers

6.6.4 XML Schema Mappings

The table below shows the one-to-one correspondence between:

e UModel elements and XML Schema elements, when outputting model to code
e XML Schema elements and UModel model elements, when inputting code into model

Legend:

-}{SDIUML Element
-Steren’wpe property (=tagoed valueg)

XSD UModel
file path projectfile Componen
t
schema target namespace name Package
<<namesp
ace>>
attributeFormDefault attributeFormDefault Class
<<schema
blockDefault blockDefault >>
elementFormDefault elementFormDefault
finalDefault finalDefault
version version
xml:lang xml:lang
xmins xmins
annotation | source source
appinfo Comment
<<appinfo
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XSD UModel
>>
document | xmil:lang xml:lang Comment
ation <<docume
ntation>>
attributeGr | name name Class
oup <<attribute
annotation | appinfo Comment | Group>>
<<appinfo
>>
document Comment
ation <<docume
ntation>>
attribute name name Property
<<attribute
form form >>
use use
ref type
type
default default
fixed fixed
attributeGr | ref type Property
oup <<attribute
Group>>
anyAttribu | namespace namespace Property
te <<anyAttri
processContents processContents bute>>
attribute name name Class
<<attribute
form form >>
use use
type type Property
default default
fixed fixed
annotation | appinfo Comment
<<appinfo
>>
documentation Comment
<<docume
ntation>>
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XSD UModel
simpleType name (= name of Class | DataType
+ <<simpleT
" _anonymousType[n]") | ype>>
element name name Class
<<element
abstract abstract >>
block block
final final
form form
nillable nillable
type type Property
default default
fixed fixed
substitutionGroup general Generaliz
ation
<<substitu
tion>>
annotation | appinfo Comment
<<appinfo
>>
document Comment
ation <<docume
ntation>>
simpleTyp name (= name of Class | DataType
e + <<simpleT
" _anonymousType[n]") | ype>>
complexT name (= name of Class | Class
ype + <<comple
" _anonymousType[n]") | xType>>
group name name Class
<<group>
annotation | appinfo Comment | >
<<appinfo
>>
document Comment
ation <<docume
ntation>>
all name (="_all") Property
name (="mg"_ + "all") Class
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XSD UModel
annotation | appinfo Comment
<<appinfo
>>
document Comment
ation <<docume
ntation>>
element name name Property
<<element
ref type >>
type
choice name (="_choice") Property
name (="mg"_+ Class
"choice") <<choice>
>
annotation | appinfo Comment
<<appinfo
>>
document Comment
ation <<docume
ntation>>
element name name Property
<<element
ref type >>
type
group Property
<<group>
>
any namespac | namespac | Property
e e <<any>>
processC | processC
ontents ontents
choice Property
Class
<<choice>
>
sequence Property
Class
<<sequen
ce>>
sequence name (="_sequence") Property

Altova UModel 2024 Professional Edition © 2017-2023 Altova GmbH



Projects and Code Engineering UModel Element Mappings 267

XSD UModel
name (= "mg"_+ Class
"sequence") <<sequen
ce>>
annotation | appinfo Comment
<<appinfo
>>
document Comment
ation <<docume
ntation>>
element name name Property
<<element
ref type >>
type
group Property
<<group>
>
any namespac | namespac | Property
e e <<any>>
processC | processC
ontents ontents
choice Property
Class
<<choice>
>
sequence Property
Class
<<sequen
ce>>
notation name name DataType
<<notation
system system >>
public public
annotation | appinfo Comment
<<appinfo
>>
document Comment
ation <<docume
ntation>>
complexT | name name Class
ype <<comple
abstract abstract xType>>
block block
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XSD UModel
final final
mixed mixed
annotation | source source
appinfo Comment
<<appinfo
>>
document | xmil:lang xml:lang Comment
ation <<docume
ntation>>
group name (="_ref[n]") Property
<<group>
>
maxOccurs multiplicity
minOccurs
ref type
all name (= "mg"_ + "all") Class
<<gll>>
name (="_all") Property
maxQOccurs multiplicity
minOccurs
choice name (= "mg"_+ Class
"choice[n]") <<choice>
>
name (="_choice[n]") Property
maxQOccurs multiplicity
minOccurs
sequence name (= "mg"_+ Class
"sequencel[n]") <<sequen
ce>>
name (= Property
"_sequence[n]")
maxQOccurs multiplicity
minOccurs
attribute name name Property
<<attribute
ref type >>
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XSD UModel
type
attributeGr | ref Property
oup type <<attribute
Group>>
anyAttribu | namespace namespace Property
te <<anyAttri
processContents processContents bute>>
complexC | restriction Generaliz
ontent ation
<<restricti
on>>
base general
extension Generaliz
ation
<<extensi
on>>
simpleTyp | name name DataType
e <<simpleT
final final ype>>
Enumerati
annotation | source source on
<<simpleT
appinfo Comment | ype>>
<<appinfo
>>
document | xmil:lang xml:lang Comment
ation <<docume
ntation>>
itemType name (= Property <<list>>
"_itemTyp | <<itemTyp
st e") e>>
simpleType DataType
<<simpleType>>
union memberTy name (= Property <<union>>
pes "memberT | <<member
ype[n]") Type>>
simpleTyp DataType
e <<simpleType>>
minExclusi | value value <<minExcl
ve usive>>
fixed fixed
mininclusi | value value <<mininclu
ve sive>>
fixed fixed
maxExclu | value value <<maxExc
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XSD UModel
fixed fixed
maxInclusi | value value <<maxIncl
ve usive>>
fixed fixed
totalDigits | value value <<totalDigi
ts>>
fixed fixed
fractionDi | value value <<fraction
gits Digits>>
fixed fixed
length value value <<length>
>
fixed fixed
minLength | value value <<minLen
gth>>
fixed fixed
maxLengt | value value <<maxLen
h gth>>
fixed fixed
w hitespac | value value <<w hitesp
e ace>>
fixed fixed
pattern value value <<w hitesp
ace>>
enumerati | value name Enumerati
on onLiteral
simpleTyp DataType
e <<simpleT
ype>>
restriction | base general Generaliz
ation
<<restricti
on>>
complexT | name name DataType
ype <<comple
simpleCon | annotation | source source xType>>
tent <<simpleC
appinfo Comment ontent>>
<<appinfo
>>
document | xmil:lang xml:lang Comment
ation <<docume
ntation>>
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XSD UModel
minExclusi | value value <<minExcl
ve usive>>

fixed fixed
mininclusi | value value <<mininclu
ve sive>>
fixed fixed
maxExclu | value value <<maxExc
sive lusive>>
fixed fixed
maxInclusi | value value <<maxIncl
ve usive>>
fixed fixed
totalDigits | value value <<totalDigi
ts>>
fixed fixed
fractionDi | value value <<fraction
gits Digits>>
fixed fixed
length value value <<length>
>
fixed fixed
minLength | value value <<minLen
gth>>
fixed fixed
maxLengt | value value <<maxLen
h gth>>
fixed fixed
w hitespac | value value <<w hitesp
e ace>>
fixed fixed
pattern value value <<w hitesp
ace>>
attribute name name Property
<<attribute
ref type >>
type
attributeGr | ref type Property
oup <<attribute
Group>>
anyAttribu | namespac namespac Property
te e e <<anyAttri
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XSD UModel
processC processC
ontents ontents
simpleTyp DataType
e <<simpleT
ype>>
restriction | base general Generaliz
ation
<<restricti
on>>
extension | base general Generaliz
ation
<<extensi
on>>
import schemalocation schemalocation Hementim
port
namespace namespace <<import>
>
include schemal.ocation schemal.ocation Blementim
port
<<include
>>
redefine schemalocation schemalocation Hementim
port
<<redefin
e>>
simpleTyp DataType
e <<simpleT
ype>>
complexT Class
ype <<comple
xType>>
<<redefine>>
attributeGr Class
oup <<attribute
Group>>
group Class
<<group>
>

6.6.5 Database Mappings

The table below shows the one-to-one correspondence between:

e UModel elements and database elements, when outputting model to code
e Database elements and UModel model elements, when inputting code into model
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Database UModel
Databas | connection connection Compon
e ent
Databas | name name Package
e <<name
Schema | name name Package | space>
<<name | >
Table name name Class space> | <<Datab
<<Table | > ase>>
Column | name name Property | >> <<Sche
ma>>
Data Type type
Not Null <<not_null>>
Null <<nullable>>
Length
Precision Multiplicity
Scale
Default default
Autoincrement <<autoincrement>>
Part of Primary Key | <<PK>>
Part of Foreign Key | <<FK>>
Part of Unique Key | <<unique>>
Primary [ name name Class
Key <<Prima
Column | name name Property | ryKey>>
Foreign [ name name Class
Key <<Forei
Column | name name Property | gnKey>
>
Foreign | name name Property
Column
foreign | type
table
Unique | name name Class
Key <<Uniqu
Column | name name Property | eKey>>
Index name name Class
<<Index
Column | name Property | >>
order: <<asce
ascendi | nding>>
ng
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Database UModel
order: <<desc
descen | ending>
ding >
CheckC | name name Class
onstrain <<Chec
t definitio definitio kConstr
n n aint>>
View name name Class
<<View
definition definition >>
Column | name name Property
Data Type type
Not Null <<not_null>>
Null <<nullable>>
Length
Precision Multiplicity
Scale
Default default
Autoincrement <<autoincrement>>
Stored name name Operatio | Class
Procedu n <<Store
re definition definition <<Store | dProced
dProced | ures>>
name name ure>>
Paramet | direction mode directio | Paramet
er n er
data type type
Functio | name name Operatio | Class
n n <<Functi
definition definition <<Functi | ons>>
on>>
Paramet | name name Paramet
er er
direction mode directio
n
data type type
Trigger | name name Class
<<Trigg
definition definition er>>
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6.7 Merging UModel Projects

It is possible to perform a two-way or three-way project merge in UModel. Both operations merge different
UModel project files into a common UModel *.ump model. This option is useful if multiple persons are working
on the same project at the same time, or you just want to consolidate your work into one model.

To merge two UML projects:

1. Open the UML file that is to be the target of the merge process, i.e. the file into which the second
model will be merged - the merged project file.

2. Select the menu option Project | Merge Project....

3. Select the second UML project that is to be merged into the first one. The Messages window reports
on the merge process, and logs the relevant details.

Messages x
b4 v o X
Elstarting merge project ...
i Successfully loaded snapshotfile 'C:\Usershaltova\Documents\AltovatlUModel2021\UModelExamples'\Bank_CSharp.ump’
Setting ‘visibility' for Operation 'CollectBankAddressinfos' [Class 'Root:Design View:BankView: com::altova:bankview:BankWiew')
Setting ‘operation’ for CallOperationAction "collectAccountinfos’ (Activity 'Root:Behavior View::BankView')
Setting ‘type’ for Parameter ‘return’ (Operation 'Root:Design View::BankView::com:altova: bankview::BankView:CollectAccountinfos’)
i Removing 'ownedOperation’ Operation 'CollectAccountinfos’ from Class "BankView' [Package 'Root:Design View:BankView:: com::altova:bankview')
(— W finished merge project - O error(s], 0 warning(s)

Note: Clicking on one of the entries in the Messages window displays that modeling element in the Model
Tree.

Merging results:

¢ New modeling elements i.e. those that do not exist in the source, are added to the merged model.

e Differences in the same modeling elements; the elements from the second model take precedence,
e.g. there can only be one default value of an attribute, the default value of the second file is used.

e Diagram differences: UModel first checks to see if there are differences between diagrams of the two
models. If there are, then the new/different diagram is added to the merged model (with a running
number suffix, activity1 etc.) and the original diagram is retained. If there are no differences, then
identical diagrams(s) are ignored, and nothing is changed. You can then decide which of the diagrams
you want to keep or delete, you can of course keep both of them if you want.

o The whole merge process can be undone step-by-step by clicking the Undo toolbar button, or pressing
Ctri+Z.

¢ Clicking an entry in the message window displays that element in the Model Tree.

e The file name of the merged file (the first file you opened) is retained.

6.7.1 3-Way Project Merge

UModel supports the merging of multiple UModel projects that have been simultaneously edited by different
dewelopers, in a 3-way project merge. The 3-way project merge works with top-level UModel projects, i.e. main
projects that may contain subprojects, it does not support individual file merging, when these files have
unresolved references to other files.
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When merging main projects, any editable subprojects are automatically merged as well. There is no need for a
separate subproject merging process. For an example, see Example: Manual 3-Way Project Merge. Note
the following:

e The whole merge process can be undone step-by-step by clicking the Undo toolbar button, or pressing
Ctrl+Z

e Clicking an entry in the message window displays that element in the Model Tree.

e The file name of the merged file, the first file you opened, is retained.

Merging results
In the following text, "source" means the initial/first project file you open before starting the merge process.

¢ New modeling elements in the second file i.e. that do not exist in the source, are added to the merged
model.

e New modeling elements in the source file i.e. that do not exist in the second file, remain in the merged
model.

e Deleted modeling elements from the second file i.e. those that still exist in the source, are removed
from the merged model.

e Deleted modeling elements from the source file i.e. that still exist in the second file, remain deleted
from the merged model.

Differences to the same modeling elements:

e Ifa property (e.g. the visibility of a class) is changed in either the source, or second file, the updated
value is used in the merged model.

e Ifa property (e.g. the visibility of a class) is changed in both source and second file, the value of the
second file is used (and a warning is shown in the messages window).

Mowved elements:

e Ifan element is moved in the source, or second file, then the element is moved in the merged model.
e Ifan element is moved (to different parents) in both the source and second file, a prompt appears, and
you have to manually select the parent element in the merged model.

Diagram differences:

UModel first checks to see if there are differences between diagrams of the two models. If yes, then the
new/different diagram is added to the merged model (with a running number suffix, activity1 etc.) and the
original diagram is retained. If there are no differences, then identical diagrams(s) are ignored, and nothing is
changed. You can then decide which of the diagrams you want to keep or delete, you can of course keep both
of them if you want.

Source control systems support for 3-way merging

When checking in/out project files, UModel automatically generates "Common ancestor" (or snapshot) files
which are then used for the 3-way merge process. This enables a much finer merge result than the normal 2-
way merge.

The specific source control system you use, determines if the automatic snapshot 3-way merge process is
supported by UModel. A manual 3-way merge is however, always possible.
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e Source control systems that perform automatic file merging without user intervention, will probably not
support an automatic 3-way merge.

e Source control systems that prompt you to choose between Replace or Merge, when a project file has
been changed, will generally support a 3-way merge. After the source control plug-in has replaced the
file, selecting the Replace command activates the UModel file alert which then allows you to do a 3-
way merge. UModel must be used for the check in/out process.

e Main projects as well as subprojects can be placed under source control. Changing data in a
subproject automatically prompts you if the subproject(s) should be checked out.

e Each check in/out action, creates a Common ancestor, or a snapshot, file which is then used during
the 3-way project merge process.

Note: Snapshot files are automatically created and used only with the standalone versions of UModel, i.e.
these functions are not available in the Eclipse or Visual Studio plug-in versions.

Example

User A edits a UModel project file and changes the name of a class in the BankView Main diagram. User B
opens the same project file and changes the visibility of the same class.

As snapshot files are created for each user, the snapshot editing history allows the individual changes to be
merged into the project. Both the name and visibility changes are merged into the project file during the 3-way
merge process.

6.7.2 Example: Manual 3-Way Project Merge

This example illustrates a simple 3-way project merge. Let's suppose that two users, Tom and Alice, created
their own copies of a UModel project and made changes to them. There are now three versions of the same
project: the original one, Tom's copy, and Alice's copy. In the context of 3-way merging, the original project
represents the "common ancestor file".

For the scope of this example, let's assume that the common ancestor file is Bank_CSharp.ump project,
available in the folder C:\Users\<username>\Documents\Altova\UModel2024\UModelExamples. The copies
of Tom and Alice must be created manually. Therefore, let's first create two copies of the Bank_Csharp.ump
project in child folders below the ...\UModelExamples folder. Let's call the child folders Alice and Tom; the
project name can remain as is.

Use the File | Save Project As command to create the copies of Tom and Alice. When prompted to
adjust the relative paths, click Yes. This way you will awid introducing syntax errors in the project
copies.

The goal of the example is to show how Alice should merge changes not only from the original
Bank_CSharp.ump, but also from Tom's project into a new merged model (a so-called "3-way merge").

Step 1: Prepare Tom's project

Tom opens the Bank_CSharp.ump project file in folder Tom, opens the "BankView Main" diagram, and
makes changes to the Bankview class.

1. Operation CollectAccountInfos () :bool is deleted from the Bankview class.
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2. The visibility of the CollectBankaddressInfos () :bool operation is changed from "protected" to
"public".

Bank\View

@] banks:Bank[*] {ordered]
@] bankAPLIBankAPI

a} «constructors BankView(in bankAPl:[BankAPI)
¥ ColledtBankAddressinfos(:bool

¥ CollectDatal:bool

a'} GetBalanceAtBank(in bankname:string)iint
% GetBalanceSumOfallBanks(int

—

3. The project is then saved.

Step 2: Prepare Alice's project

Alice opens the Bank_CSharp.ump project file in folder Alice, opens the "BankView Main" diagram, and
makes changes to the Bank class.

1. The operations CollectAccountInfos and GetBalanceOfAccounts are both changed from "public" to

"protected".
Bank
@] bankname:string
ien @1 IPaddress:string
#banks )
@] username:string o
— .
> @] password:string 1 #accounts
ﬁ.] accounts:Account[*] .
C# Propertiss

R} wizetAccessor, property» BankMame():string
R} xzizetAccessor, property: IPAddress():string
R} «ietAccessor, property= Username():string
k} xethccessor, property= Password():string

Method's
a} econstructors Bank(in name:string, in [P:string, in userstring, in pw:string)
ﬁ} CollectAccountinfos(in api:lBankAPl):bool
ﬁ.} GetBalanceOfAccounts(jiint

2. The project is then saved.

Step 3: Perform the 3-way merge

Alice now starts a 3-way project merge:

1. Open Alice's project from Alice folder.
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2. On the Project menu, click Merge Project (3-way), and select the project file changed by Tom from
Tom folder.

3. You are now prompted to open the common ancestor file. Select the original Bank_CSharp.ump
project file from the ...\UModelExamples folder.

The 3-way merge process is started and you return to the project file from which you started the 3-way merge
process, i.e. from the project file in the Alice folder. The Messages window shows you the merge process in
detail.

Messages b4
5 T »

EJStarting merge project ...

i Successfully loaded snapshotfile "Ch\Users\altovatDocuments\AltovatUModel2021WUModelExamplesiBank_CSharp.ump’

Setting ‘wisibility’ for Operation 'CollectBankAddressinfos’ (Class ‘Root:Design View:BankViews:com::altova:bankview: BankView')

Setting ‘operation’ for CallOperationAdtion 'collecticcountinfos’ (Activity ‘Root:Behavior View::BankView')

Setting ‘type’ for Parameter ‘return’ [Operation 'Root::Design View:BankView::com:altova:bankview:BankView:: CollectAccountinfos’)

Remoaving ‘ownedOperation’ Operation "CollectAccountinfos” from Class "BankView' [Package "‘Root:Design View::BankView::com::altova:bankview')

.. finished merge project - 0 error(s), 0 warning(s)

The outcome of the 3-way merge is as follows:

e The changes made to the project by Tom are replicated in Alice's project.
e The changes made to the project by Alice are retained in the project file.

Note: The project file in the Alice folder should now be used as the common ancestor file for future 3-way
merges between the project files in folders Tom and Alice.
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6.8

UML Templates

UModel supports the use of UML templates and their mapping to or from Java, C# and Visual Basic generics.

Templates are "potential" model elements with unbound formal parameters.

These parameterized model elements, describe a group of model elements of a particular type:
classifiers, or operations.

Templates cannot be used directly as types, the parameters have to be bound.

Instantiate means binding the template parameters to actual values.

Actual values for parameters are expressions.

The binding between a template and model element, produces a new model element (a bound element)
based on the template.

If multiple constraining classifiers exist in C#, then the template parameters can be directly edited in
the Properties tab, when the template parameter is selected.

Template signature display in UModel:

MyVector

@] mylrray T[]

Class template called MyVector, with formal template parameter "T", visible in the dashed rectangle.
Formal parameters without type info (T ) are implicitly classifiers: Class, Datatype, Enumeration,
PrimitiveType, Interface. All other parameter types must be shown explicitly e.g. Integer.

Property myArray with unbounded number of elements of type T.

Right clicking the template and selecting Show | Bound elements, displays the actual bound
elements.

Template binding display:

intvector:Myvector<T-~int>

A bound named template intvector
Template of type, MyVector, where
Parameter T is substituted/replaced by int.
"Substituted by" is shown by - >.

Template use in properties/operations:

Clag=s3

.§|‘| My Flostector: yWector=T-=float=

An anonymous template binding:

Property MyFloatVector of type MyVector<T->float>

Templates can also be defined when defining properties or operations. The autocomplete function helps you
with the correct syntax when doing this.
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Class3

% Operation (O Mysector=T-=flost=

e Operation1 returns a vector of floats.

6.8.1 Template Signatures

A Template signature is a string that specifies the formal template parameters. A template is a parameterized
element that is used to generate new model elements by substituting/binding the formal parameters to actual
parameters (values).

Formal template parameter
T
Template with a single untyped formal parameter
(stores elements of type T)

Multiple formal template parameters
KeyType:DateType, ValueType

Parameter substitution
T>aBaseClass

The parameter substitution must be of type "aBaseClass", or derived from it.

Default values for template parameters
T=aDefaultValue

Substituting classifiers
T>{contract}aBaseClass

allowsSubstitutable is true
Parameter must be a classifier that may be substituted for the classifier designated by the classifier
name.

Constraining template parameters
T:Interface>anlinterface

When constraining to anything other than a class, (interface, data type), the constraint is displayed
after the colon ":" character. E.g. T is constrained to an interface (T:Interface) which must be of type
"aninterface" (>aninterface).

Using wildcards in template signatures
T>vector<T->?7<aBaseClass>

Template parameter T must be of type "vector" which contains objects which are a supertype of
aBaseClass.
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Extending template parameters
T>Comparable<T->T>

6.8.2 Template Binding

Template binding involves the substitution of the formal parameters by actual values, i.e. the template is
instantiated. UModel automatically generates anonymously bound classes, when this binding occurs. Bindings
can be defined in the class name field as shown below.

intvector:hMyvector<T-=int>

Substituting/binding formal parameters
vector <T->int>

Create bindings using the class name
a_float_vector:vector<T->float>

Binding multiple templates simultaneously
Class5:vector<T->int, map<KeyType->int, ValueType<T->int>

Using wildcards ? as parameters (Java 5.0)
vector<T->7>

Constraining wildcards - upper bounds (UModel extension)
vector<T->?>aBaseClass>

Constraining wildcards - lower bounds (UModel extension)
vector<T->?<aDerivedClass>

6.8.3 Template Usage in Operations and Properties

Operation returning a bound template
Class1
Operation1():vector<T->int>

Parameter T is bound to "int". Operation1 returns a vector of ints.
Class containing a template operation

Class1

Operation1<T>(in T): T
Using wildcards

Class1

Property 1:vector<T->7?>

This class contains a generic vector of unspecified type (? is the wildcard).
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Typed properties can be displayed as associations as follows:

¢ Right click a property and select Show | PropertyX as Association, or
e Drag a property onto the diagram background.
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7 Generating UML Documentation

Altova website: UML project documentation

Run the Project | Generate Documentation menu command to generate detailed documentation about your
UML project in HTML, Microsoft Word, RTF or PDF format. The documentation generated by this command
can be freely altered and used; permission from Altova to do so is not required.

Notes
e To generate documentation in PDF format or to customize the generated documentation, Altova
StyleVision (https://www.altova.com/stylevision) must be installed and licensed.
e To generate documentation in Microsoft Word format, Microsoft Word 2000 or later is required.

Documentation is generated for the modeling elements you select in the Generate Documentation dialog box.
You can either use the fixed design, or specify a custom StyleVision Power Stylesheet (SPS). Using a
StyleVision Power Stylesheet enable%ou to customize the output of the generated documentation, see

Customizing Output with StyleVision

You can also create partial documentation of modeling elements. To do this, right-click an element (or multiple
elements using Ctrl+Click) in the Model Tree and select Generate Documentation. The element can be a
folder, class, interface, and so on. The documentation options are the same in both cases.

Related elements are hyperlinked in the generated output, enabling you to navigate from component to
component. All manually created hyperlinks also appear in the documentation.

If your project contains UModel profiles (such as C#, Java, VB.NET, and so on), the generated documentation
will include these if the Included subprojects option is enabled in the Include tab, see Documentation

Generation Options D
To generate documentation:
1. Open a project (for example, C:

\Users\<username>\Documents\Altova\UModel2024\UModelExamples\Bank_Java.ump).
2. On the Project menu, click Generate Documentation.
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Generate Documentation >

Main  Include Details Fonts

Documentation Design

(®) Use fixed design for documentation in HTML, Word or RTF format.
i) Use user-defined design for HTML, Word, RTF or POF format. Requires StyleVision,

Select SPS design: ZealtovalModelDoc % \UModelDocumentation. sps Browse Edit
Output format Generate links to local files
(IHTML [ ]Embed diagrams ®absolute:
(®) Microsoft Word [ ] create folder for diagrams O relative to resutt file
i JRTF

PDF (see above)

Split output to multiple files
Embed C55 in HTML

Show result file after generation

Corcs

3. Select an output format (HTML, Word, RTF, PDF).
4. Optionally, customize the generation options, see Documentation Generation Options @,
5. Click OK and choose a target output folder.

The following image shows a fragment of UModel fixed-design documentation generated from the
Bank_Java.ump project file.
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Bank_Java.ump

project location C\sers) \UMeodelExamples\Bank Java.ump

Index of diagrams:

Structure Diagram

Deployment
Diagram

Object Diagram

Profile Diagram

Deployment

Sample Accounts

Apply Java Profile

Activity Diagram  collectData Draft
Class Diagram  BankView Main Hierarchy of Account
Component BankView realization Owerview
Diagram
Composite  Account Transfer

Sequence  Collect Account Information
Diagram

Connect to BankAPI

State Machine BankAPI Draft
Diagram

Query BankServer Draft

UseCase Diagram  Owerview Account Balance

Index of elements:

Actor  Bank Standard User

Class  iAccount Bank BankView
CreditCardAccount SavingsAccount

Component  Bank AP client BankView BankView GUI

Interface  |BankAPI

As illustrated above, the generated documentation includes an index of diagrams and elements (with links) at
the top of the HTML file.

The image below shows a fragment of the generated documentation for the account class. Note that the
individual members in class diagrams are also hyperlinked to their definitions. For example, clicking a property
or operation takes you to its definition. The hierarchy classes, as well as all underlined text, are also
hyperlinked.
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Class Account

diagram Account
@] balancefloat=0
gl id:5tring
¢» «constructors Account()
¢» getBalance(:float
» getld():String
% collectAccountinfolin bankAPEIBankAP:boaolean
hierarchy
H Account
[ IFI~ ]
H Checkingfcoount | | SavingsAccount  H CreditCardAccount
owner | bankview
properties

isFinalspecialization false

qualified name Design View::BankView::com::altova::bankview:: Account
visibility public
leaf false
abstract true

active false
code file name Account.java
code file path CAVUML _Bank_SampletJavaCode\comtaltova\bankview'\Account,java
«annotations» false
«statice false
xstrictfp= false

© 2017-2023 Altova GmbH

Altova UModel 2024 Professional Edition



288

Generating UML Documentation Documentation Generation Options

7.1

Documentation Generation Options

When generating documentation from UModel projects, you can set various options as described below. The
options are organized by the tab in which they appear in the "Generate Documentation" dialog box.

Main tab

The Main tab includes the general documentation generation options.

Generate Documentation

Main  |nclude Detailz Fonts

Documentation Design
{®) Use fixed design for documentation in HTML, Word or RTF format.
() Use user-defined design for HTML, Word, RTF or PDF format. Requires StyleVision,

Select SPS design: tAltovalModelDoc b UModelDocumentation. sps Browse
Qutput format Generate links to local files
{IHTML [ ]Embed diagrams @:al:us-:ulute
(®) Microsoft Word [ ] create folder for diagrams O relative to resutt file
{IRTF

POF (zee above)

split output to multiple files
Embed C55 in HTML

Show result file after generation

Edit

Cancel

Documentation Design:

Select Use fixed design... to use the UModel built-in documentation design.

Select Use user-defined... to generate documentation formatted with the help of a custom StyleVision
Power Stylesheet (.sps file) created in StyleVision. Note: This option requires Altova StyleVision to be

installed, see also Customizing Output with StyleVision
Click Browse to browse for a predefined stylesheet file.

Click Edit to launch StyleVision and open the selected stylesheet file in a StyleVision window.

Output format:
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e The output format can be one of the following: HTML, Microsoft Word, RTF, or PDF. Microsoft Word
documents are created with the .doc file extension when generated using a fixed design, and with a
.docx file extension when generated using a StyleVision Power Stylesheet. The PDF output format
requires Altova StyleVision to be installed.

e Split output to multiple files generates an output file for each modeling element (class, interface,
diagram, and so on). Clear this check box to generate one global file with all modeling elements.

e Select the Embed CSS in HTML check box to embed the generated CSS code in the HTML
documentation. Clear this check box to keep the CSS file external.

e The Embed diagrams option is enabled for the Microsoft Word and RTF output options. When this
check box is selected, diagrams are embedded in the generated file. Diagrams are created as .png
files, which are displayed in the result file via object links.

e Create folder for diagrams generates a subfolder below the selected output folder, that will contain
all diagrams.

e The Show result file after generation option is enabled for all output formats. When this check box
is selected, the main generated file is displayed in the default browser (for HTML files), in Microsoft
Word (for Word files), or in the default application (for .pdf or .rtf files).

¢ The Generate links to local files option allows you to specify if the generated links are to be
absolute, or relative, to the output file.

Include tab
This tab allows you to select which diagrams and modeling elements are to appear in the documentation.
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Generate Documentation >

Main  Include  Details  Forts

Diagrams: Elements:
[w] Activity Diagram a | AcceptEventiction - Imdes
EPMM 1 Business Process [] Action
w| Named elements on
BEPMM 2 Business Process [[] actionExecutionSpecification by
EPMM 2 Choreography D [] ActioninputPin [ ] Included subprojects
[+ BPMM 2 Callaboration Di [] Activity ' !
Predefined subprojects
Class Diagram [] ActivityEd ge prel
Communication Diagram [] ActivityFinalMode |:| Unknown Extemnals
Component Diagram [ ActivityGroup
Composite Structure Diag [ ActivityNode i
1 Select All Diagrams
Database Diagram [] activityParameterMode d
Deployment Diagram [] activityPartition )
Interaction Overview Dia: [l Actor SIIoCoTIT
Ohbject Diagram [] AnyReceiveEvent
Package Diagram [] Artifact Select Ml Bements
Frofile Diagram [] associationClass
Protocol State Machine C [l Behaviar Select No Elements
[ Sequence Diagram [ BehavioralFeature
¥l state Machine Diaaram ~  |[ | BehavioredClassifier v
L 3 L | 3 Select Default

Corcs

To prevent subprojects or profiles from being documented, clear the Included subprojects check box. Be
aware that, if this check box is not selected, any elements or diagrams that are in subprojects will not be
included in generated documentation. Select the Predefined subprojects check box to include UModel built-
in profiles such as C# or Java profiles. Note, however, that generating documentation from predefined projects
takes a very long time. Unknown externals refers to elements whose kind could not be identified—this
usually happens after you import source code into UModel without first including the built-in subprojects for that
language or language version, see Mgmmj% for more information.

Details tab

This tab allows you to select the element details that are to appear in the documentation.

e Ifyou intend to import XML tags text in your documentation, clear the as HTML option under the
Documentation option.

e The up and down fields allow you to define the nesting depth shown above or below the current class
in the hierarchy diagram.

e The expand each element only once option allows only one of the same classifiers to be expanded
in the same image or diagram.
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Documentation Generation Options

Generate Documentation

Main  Include Details  Fors

Element details

1 Diagram Generals
Hierarchy diagram Specifice

Expanded nesting depth up:| 5 Implemented Interfaces

down: [ 112 Associations to/from

Expand each element only onece Sourcearget of other refations
Owner Typed elements
Template parameters Bound elements
Template parameter substitutions Shown on diagram
Properties Hyperinks
Operation parameters Constraints
Owned diagrams Documentation Select Al

as HTML
[+] Owned members Celect None
Cancel
Fonts tab

This tab allows you to customize the font settings for the various headers and text content.
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Documentation Generation Options

Generate Documentation

Main  Include Details Forts

Header
Header?

Element Name Header

Elerment Kind Header
Line Title

Line Content

Sub-line Title

Sub-line Content
Footer

Footer2

Fort face

|Segu:ue 1l w

[] Use the zame for all

Size

[] Use the same for al

Styles

Text Color
Background Calar

Set Defaults

Cancel
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7.2 Customizing Output with StyleVision

You can customize the design of UModel-generated documentation with the help of StyleVision Power
Stylesheet (.sps) files. Such files are created in Altova StyleVision (https://www.altova.com/stylevision). The
advantage of using an .sps file is that you have complete control over the design of the documentation. In
addition, PDF output is available if an .sps file is used.

To generate documentation with .sps files, Altova StyleVision must be installed and licensed.

UModel includes a predefined .sps file, which is available at the following path: C:
\users\<username\Documents\UModel2024\Documentation\UModel\UModelDocumentation.sps. To
format the generated documentation using a custom .sps file, select this option while generating
documentation, for example:

Generate Documentation >

Main  Include Details Forts

Documentation Design
(") Use fixed design for documentation in HTML, Werd or RTF format,
(@) Usze uzer-defined design for HTML, Word, RTF or POF format. Requires Stylevision, i
Select SPS design: %ealtovalModelDoc % \UModelDocumentation. sps ~ | | Browse Edit

You can begin the customization by creating a copy of the default UModelDocumentation.sps and editing it
in StyleVision. For example, you can change the existing formatting or add links and images to the design.

Any StyleVision Power Stylesheet is based on an XML Schema. In case of stylesheets that control the design
of UModel-generated documentation, this schema is available at the following path: C:
\users\<username\Documents\UModel2024\Documentation\UModel\UModelDocumentation.xsd. Note
that the UModelDocumentation.xsd file references the Documentation.xsd file located in the folder abowe it.

When you author custom .sps files in StyleVision for UModel documentation, the UModelDocumentation.xsd
file must be used as a schema. The image below illustrates the Design Oveniew window of StyleVison after
you open the UModelDocumentation.sps file. Notice that it uses the UModelDocumentation.xsd schema
file, and a working XML required to preview the design. The working XML file is available in the SampleData
subfolder relative to the schema file.
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Design Overview x
T Sources
(2 $XML (main)
Schema UModelDocumentation, xsd
Working XML Bank_MultiLanguage. xml
Template XML
¥ML Signature | Disabled
add new Source...

T Modules
add new Module...
© CSS Files
add new C55 File...
© Parameters
add new Parameter. ..
% XSLT Files
add new XSLT file. ..

For instructions about how to edit .sps files, refer to the StyleVision documentation

(https://www.altova.com/documentation).
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8 UML Diagrams

Altova website: UML diagrams

There are two major groups of UML diagrams, Structural diagrams, which show the static view of the model,
and Behavioral diagrams, which show the dynamic view. UModel supports all fourteen diagrams of the UML 2.5
specification, as well as Additional diagrams.

e Behavioral diagrams include Activity, State machine, Protocol State Machine and Use Case
diagrams; as well as the Interaction, Communication, Interaction Overview, Sequence, and Timing
diagrams.

e  Structural diagrams@ include: Class, Composite Structure, Component, Deployment, Object, and
Package diagrams.

e Additional diagrams XML schema diagrams, Business Processing Modeling Notation (BPMN),
SysML diagrams, Database diagrams.

Note: The Ctrl+Enter keys can be used to create multi-line labels for most of the modeling diagrams, e.g.
Lifeline labels in sequence diagrams, timing diagrams; guard conditions, state names, activity names
etc.
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8.1 Behavioral Diagrams

These diagrams depict behavioral features of a system or business process, and include a subset of diagrams
which emphasize object interactions.

1! Activity Diagram

=| State Machine Diagram

= Protocol State Machine Diagram
%7 Use Case Diagram

A subset of the Behavioral diagrams are those that depict the object interactions, namely:

“z Communication Diagram
&2 Interaction Oveniew Diagram
7 Sequence Diagram

Timing Diagram

8.1.1 Activity Diagram

Altova website: ©° UML Activity diagrams

Activity diagrams are useful for modeling real-world workflows of business processes, and display which
actions need to take place and what the behavioral dependencies are. The Activity diagram describes the
specific sequencing of activities and supports both conditional and parallel processing. The Activity diagram is
a variant of the State diagram, with the states being activities.

The Activity diagram shown below is available in the Bank_MultiLanguage.ump sample, in the ...
\UModelExamples folder supplied with UModel.
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manual invokation

Receive Update Ul Event

Validate References

1 sec since last update

[reference missing]

[walic]

akarted

collectAccountinfos

[Bank\iew::)
]

Handle Display Exception

|_|_|

1

{Drdering = ordered}

Exception

{wveight="}

==datasztores==

Send AfterUpdate Signal
Updatelog

finished

8.1.1.1 Inserting Activity Diagram elements

To add elements to the diagram:

1. Click the element's toolbar button in the Activity Diagram toolbar.
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Activity Diagran
mEn @ e 0 X Dt e @ @k =ik

Abk

T

OREBE M| — M| hids s

2. Click in the Activity Diagram to insert the element.
To insert multiple elements of the selected type, hold down the Ctrl key and click in the diagram window.
Dragging existing elements into the activity diagram
Most elements occurring in other activity diagrams can be inserted into an existing activity diagram.

1. Locate the element you want to insert in the Model Tree Window & (you can use the search function

text box, or press Ctrl+F to search for any element).
2. Drag the element(s) into the activity diagram.

Inserting an action (CallBehavior)

1. Click the Action (CallBehavior) toolbar button, and click in the Activity diagram to insert it.

2. Enter the name of the Action, e.g. "Validate References", and press Enter to confirm.

Properties o =

Mame Walidate References

clement kind | CallBehaviorAction manual invokation

wizibility unzpecified =]

leat O .,. R —— -, -
=Sy nchHronoUE ' Validate References j_':‘
behavior - g mmmmsmmsseeee W

Note: Use Ctrl+Enter to create a multi-line name.

Inserting an action (CallOperation) and selecting a specific operation

1. Click the Action (CallOperation) icon in the icon bar, and click in the Activity diagram to insert
it.

2. Enter the name of the Action, e.g. "collectAccountinfo”, and press Enter to confirm.

3. Click the Browse button to the right of the operation field in the Properties tab. This opens the "Select
Operation” dialog box in which you can select the specific operation.
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] P ——— - ]
Properties o ox i Y
4 o— collectAccountinfos }—D
MSimE collect&ccountinfos e m &
] E =
element kind CalloperationAction
wizibility unzpecified i M Select operation
=Y |
i=Synchronous ~|Roat
opetation _% Behavior Wiew
Component Yiew
ll @[ Deployment Vie
[thlcolleckDat, | (8| Desion iew
| Interaction i

Il Select operation

a

E| wlattova

3 [ bankview

........ [ Bankigw hain
........ [ Hierarchy of Account
........ [ zample Accounts
- & AgencyBank

-F | John's 1=t

-[F B John's 2nd

- B John's 3rd

- B Account

-[# B Bank

-2 B BankView

-------- & | bankAP|
-3 R} Bank\iew
-Eg > collectBankAddressinfos
g collectAccountinfos

[ < collectData

x|

Properties

operation

Mame collectAccourtinfos
element kind CalloperationAction
wizibility unzpecified

liesarf O

i=Synichronous

collectAccourtinfos]): boolean

u e = E NN = -
[ L]
i collectAccountinfos i_n
1‘ (Bankhiew::] !

n e ————————— E’ u
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8.1.1.2 Creating branches and merges

A branch has a single incoming flow and multiple outgoing guarded flows. Only one of the outgoing flows can
be traversed, so the guards should be mutually exclusive.

In this example the (BankView) references are to be validated:

e branch1 has the guard "reference missing", which transitions to the abort activity
e branch2 has the guard "valid", which transitions to the collectAccountInfos activity.

Creating a branch (alternate flow)

(118}

P

1. Click the DecisionNode icon

(’u‘alidate Referem:es)

in the title bar, and insert it in the Activity diagram.

collectAccountinfos
[BankYiew::]

®
2. Click the ActivityFinalNode icon which represents the abort activity, and insert it into the

Activity diagram.

3. Click the "Validate References" activity to select it, then click the right-hand handle, ControlFlow, and
drag the resulting connector onto the "DecisionNode" element. The element is highlighted when you
can drop the connector.

4. Click the "DecisionNode" element, click the right-hand connector, ControlFlow, and drop it on the
"collectAccountinfos" action. Please see "Inserting an Action (CaIIOperation@" for more information.
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(‘Ualida’te Rﬂferences)

collectAccountinfos
[Bank iew::)

s

5. Enter the guard condition "valid", in the guard field of the Properties tab.

Properties
[rame (’l.l‘alidate References)
elemert kind CortrolFlosw

wizibility unspecified |
lleat O

guard fealic

wveight @

IishﬂurtiCast |

izmutiReceive (] [valicl]
=election o
transformation o collectAccountinfos
[(Bank'iew: )

6. Click the DecisionNode element and drag from the right-hand handle, ControlFlow, and drop it on the
"ActivityFinalNode" element. The guard condition on this transition is automatically defined as "else".
Double click the guard condition in the diagram to change it e.g. "reference missing".

(’u’alidate Rﬂferences)

[reference mizsing)

®

[walid]

collectAccountinfos
[(Bank"iew::

Note: UModel does not validate, or check, the number of Control/Object Flows in a diagram.
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Creating a merge

l%l

1. Click the MergeNode icon

IF'rn:nperties lSt':.ers ‘

" e
Properties o X
MEme MergeMode
H | | n
element kind  [MergeMode /«‘
wisibility unzpecified ad " s
lle=t ] = YHa

in the icon bar, then click in the Activity diagram to insert it.

2. Click the ControlFlow (ObjectFlow) handles of the actions that are to be merged, and drop the arrow(s)

on the "MergeNode" symbol.

8.1.1.3 Activity Diagram elements

Action (CallBehavior)

Inserts a CallBehaviorAction element which directly invokes a specific behavior. Selecting an existing
behavior using the behavior combo box, e.g. HandleDisplayException, displays a rake symbol within the

element.

Properties o x

MEme Handle Display Exception - __l ______________ -
elemert kind  |CallBehaviorAction " Handle Display Exception |
wizibility unzpecified i ] I'|_| :_‘:‘
e ] _"-.. _______________ -'_
i=Synchronous

behavior HandleDisplayException |

Action (CallOperation)

Inserts a CallOperationAction which indirectly invokes a specific behavior as a method. Please see "Inserting

an action (CaIIOperatiom@

" for more information.
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Properties
name collectAccourtinfos " T T e e ="
element kind Callsperationction D_: collectAccountinfos i_n
wvizibility unspecified =] 1‘ (Bankhiew::] !
leat O g mmmmmmmm e Gl =
i=Synchronous
operation collectAccountinfos(boolean ...
. .

Action (OpaqueAction)

A type of action used to specify implementation information. Can be used as a placeholder until you decide
which specific action type you want to use.

=

Action (ValueSpecificationAction)

A type of action that evaluates(/generates) a specific value at the output pin. (Defined by the specific properties,
e.g. upperBound.)

]

AcceptEventAction
Inserts the Accept Event action which waits for the occurrence of an event which meets specific conditions.

e

AcceptEventAction (TimeEvent)

Inserts an AcceptEventAction, triggered by a time event, which specifies an instant of time by an expression
e.g. 1 sec. since last update.

Receive Update Ul Event

ENCES

1 sec since last update

C

SendSignalAction

Inserts the SendSignalAction, which creates a signal from its inputs and transmits the signal to the target
object, where it may cause the execution of an activity.
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i
Propetties o x ",'
narme =end Afterlpdate Signal
element kind | SendSignal dction k=1
wvizibility unspecified =] 'r ------------------ .
LY
leat L |_o—! Send AfterUpdate Signal  }
zignal e m g
[ E E.
finizhed
DecisionNode

Inserts a Decision Node which has a single incoming transition and multiple outgoing guarded transitions.
Please see "Creating a branch " for more information.

C’u‘alidate Rﬂferences)

[reference missing)

®

[walid]

collectAccountinfos
[(Bankiew::

Lt
¢ MergeNode

Inserts a Merge Node which merges multiple alternate transitions defined by the Decision Node. The Merge
Node does not synchronize concurrent processes, but selects one of the processes.

InitialNode
The beginning of the activity process. An activity can have more than one initial node.

®

ActivityFinalNode

The end of the activity process. An activity can have more that one final node, all flows in the activity stop when
the "first" final node is encountered.
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@

FlowFinalNode

Inserts the Flow Final Node, which terminates a flow. The termination does not affect any other flows in the
activity.

§
ForkNode
Inserts a vertical Fork node. Used to divide flows into multiple concurrent flows.

4

™ | ForkNode (Horizontal)
Inserts a horizontal Fork node. Used to divide flows into multiple concurrent flows.

L JoinNode
Inserts a vertical Fork node. A Join node synchronizes multiple flows defined by the Fork node.

Aol

T

Join Node (horizontal)
Inserts a horizontal Fork node. A Join node synchronizes multiple flows defined by the Fork node.

.

g InputPin

Inserts an input pin onto a Call Behavior, or Call Operation action. Input pins supply input values that are used
by an action. A default name, "argument”, is automatically assigned to an input pin.

Properties o x
<<parallel>>
riame argumerit
element kind  [InputPin "=
wiibility unspecified ad update I'.I'IEIT.I ui
|:eaf ]
WEIE x|

The input pin symbol can only be placed onto those activity elements where the mouse pointer changes to the

hand symbol "_/. Dragging the symbol repositions it on the element border.

OutputPin

Inserts an output pin action. Output pins contain output values produced by an action. A name corresponding
to the UML property of that action e.g. result, is automatically assigned to the output pin.
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Properties ox

name result

elemert kind  |(OutputPin update qeny ui
wizibility unzpecified i 1=

[=2=0] ] -I'EI‘\
bype i

g el ifice (=B

The output pin symbol can only be placed onto those activity elements where the mouse pointer changes to

the hand symbol . Dragging the symbol repositions it on the element border.

Exception Pin

An OutputPin can be changed to an Exception pin by clicking the pin and selecting "isExceptionPin" from the
Properties pane.

ValuePin

Inserts a Value Pin which is an input pin that provides a value to an action, that does not come from an
incoming object flow. It is displayed as an input pin symbol, and has the same properties as an input pin.

|

ObjectNode

Inserts an object node which is an abstract activity node that defines object flow in an activity. Object nodes
can only contain values at runtime that conform to the type of the object node.

5 CentralBufferNode

Inserts a Central Buffer Node which acts as a buffer for multiple in- and out flows from other object nodes.

8 DataStoreNode

Inserts a Data Store Node which is a special "Central Buffer Node" used to store persistent (i.e. non transient)
data.

=

ActivityPartition (horizontal)

Inserts a horizontal Activity Partition, which is a type of activity group used to identify actions that have some
characteristic in common. This often corresponds to organizational units in a business model.
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Properkies o x

-
name 'I i
element kind ActivityPartition -
izibility unspecified i
i=Dimension o

[
i=External O =

=

Double clicking a label allows you to edit it directly; pressing Enter orients the text correctly.

Please note that Activity Partitions are the UML 2.0 update to the "swimlane" functionality of previous UML
versions.

e Elements placed within a ActivityPartition become part of it when the boundary is highlighted.

e Objects within an ActivityPartition can be individually selected using Ctrl+Click, or by dragging the
marquee inside the boundary.

e Click the ActivityPartition boundary, or title, and drag to reposition it.

M ActivityPartition (vertical)
Inserts a vertical Activity Partition, which is a type of activity group used to identify actions that have some
characteristic in common. This often corresponds to organizational units in a business model.

Properties ax

name Manager - .
element kind ActivityPartition Clark Manager E
wizibility unspecified hadl

IisDimensiDn O

izExternal O

i ActivityPartition (2 Dimensional)

Inserts a two dimensional Activity Partition, which is a type of activity group used to identify actions that have
some characteristic in common. Both axes have editable labels.
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|
Crim1

To remove the Dim1, Dim2 dimension labels:

1.

EU SCO

M anzger

Clerk

Click the dimension label you want to remowve e.g. Dim1

2. Double click in the Dim1 entry in the Properties tab, delete the Dim1 entry, and press Enter to confirm.

Properties o x
MEmeE

element kind ActivityPartition

wizibility unzpecified had
izDimenzion

izExternal |

IF‘rl:uperties lSters ‘

Owverview o x

[ - 2

Note that Activity Partitions can be nested:

1.

Right click the label where you want to insert a new partition.

Select New | ActivityPartition.

Crim1
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ControlFlow

A Control Flow is an edge, i.e. an arrowed line, that connects two activities/behaviours, and starts an activity
after the previous one has been completed.

Properties o X ____m _______________
IE=linl=
element kind  |ControlFlow {wveight="}
wisibility unspecified =] R E— -
B ] . Send AfterUpdate Signal
Updatelog
ouard
weeight
! .
ObjectFlow

A Object Flow is an edge, i.e. an arrowed line, that connects two actions/object nodes, and starts an activity
after the previous one has been completed. Objects or data can be passed along an Object Flow.

Properties

rame
elerment kind OhjectFlow
izikility unzspecified
et O

cjLiarc

sneeicht

ishuttiCast O
izhiuttiReceive |
=zelection

Lranzformation

lF‘ererties lSt':.-'Ies ‘

KIE]

{ordering = ordered}

(.
(Eend data to Display i

L]
!
1
1
1
1
1
1

S

ExceptionHandler

An Exception Handler is an element that specifies what action is to be executed if a specified exception occurs
during the execution of the protected node.
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Properties o x
element kind ExceptionHandler e Ll L
raized exception Exception . — I‘|‘I_/
ng = ordered}
________ -,
|
|
|
|
|
]—\L : Exception
Di=play . .
| - i

An Exception Handler can only be dropped on an Input Pin of an Action.

izReadonly |
iz SingleExecution ]

M| Activity

Inserts an Activity into the activity diagram.

Properties o=
. T T T T T T - -y L

name Payment i "'I

Element kind A ctivity { Payment |

visibility public | Ik |

leat O i :

abstract O : '

reertrant O ‘ Send payment Accept payment | !
‘ ‘
i 1
i 1
i 1
i 1
‘ ‘
i 1

IF'ru:uperties lSt':.ers ‘ 20 e e & =

= ActivityParameterNode

Inserts an Activity Parameter node onto an activity. Clicking anywhere in the activity places the parameter node
on the activity boundary.
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"
Requested order Process Order [arder rejected)

eletmnent kindd ActivityParameterMoce

wizibility Lnspecified =] I: ﬁ;aﬁés'tea order ':.

leat O o= == "= Tl

by e =l

vioe modifier nfa

izCartralType [ Receive order = Fill oder

ordering FIFC =

zelection hadl [Crder accepted)

Lt Baurnc

“* | StructuredActivityNode

Inserts a Structured Activity Node which is a structured part of the activity, that is not shared with any other
structured node.

Properties o X
IS Structured ActivityPMoce L _ "
L]

element kinc StructuredActivityPoce i .
P o =structured=->
wisibility unzpecified =] H h
leaf O "-.‘_ ___________ !
inuztizolate O - G~ .

Pl
e

ExpansionRegion

An expansion region is a region of an activity having explicit input and outputs (using ExpansionNodes). Each
input is a collection of values.

Properties o —

name ExpanzionRegion {ordering = ardered}
element kind ExpanzionRedgion -

izibility Lnspecified |

liesarf O

imuztlzolste O

mode parallel i

e T T
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The expansion region mode is displayed as a keyword, and can be changed by clicking the "mode" combo box
in the Properties tab. Available settings are:parallel, iterative, or stream.

e ExpansionNode

Inserts an Expansion Node onto an Expansion Region. Expansion nodes are input and output nodes for the
Expansion Region, where each input/output is a collection of values. The arrows into, or out of, the expansion
region, determine the specific type of expansion node.

Properties ox

name ExpanzionMode . {Drn:iering = ordered}
element kind Expanzionhode HE
wvizibility unspecified |

It O

bypae i

[vie modifier  |nfa

isContralType ]

ordering ordered =]

=election i

Lipaper Bound

I Properties l Skyles ‘

o
L

b

InterruptableActivityRegion

An interruptible region contains activity nodes. When a control flow leaves an interruptible region all flows and
behaviors in the region are terminated.

To add an interrupting edge:

1. Make sure that an Action element is present in the InterruptableActivityRegion, as well as an outgoing
Control Flow to another action:

2. Right click the Control Flow arrow, and select New | InterruptingEdge.

FE LT
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Properties 3 X |

eletnent kind Irterruptiblesctivity Redion
interruptingEdge [ControlFlow: (Action -= collec |

.

Note: You can also add an InterrupingEdge by clicking the InterruptableActivityRegion, right clicking in the
Properties window, and selecting Add InterruptingEdge from the pop-up menu.

8.1.2 State Machine Diagram

The State Machine Diagram models the behavior of a system by describing the various states an object may
be in, and the transitions between those states. They are generally used to describe the behavior of an object
spanning several use cases.

Two types of processes can achiewe this:
1. Actions, which are associated to transitions, are short-term processes that cannot be interrupted (for
example, internal error /notify admin in the diagram below)
2. State Activities (behaviors), which are associated to states, are longer-term processes that may be
interrupted by other events (for example, listen for incoming connections, in the diagram below).

A state machine can have any number of State Machine Diagrams (or State Diagrams) in UModel.
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?

|'/— Hot Connected T
bﬂ !Histen for incaming connections

o dizconnect, [akort

connect [S5L available]

. User Connected ™y

laggin

Logging in User

[authertication ok] [authertication failed] Aog failure

irternal errar inctify admin

>0

Suspended

User Autherrtit:ated)

transact
- Performing Transaction Y

Tran=zacting : BankServer
fa¥a)
e

Logging Transactiun)—

vy
b -~

Sample State Machine diagram

The State machine diagram illustrated abowe is available in the following sample UModel project: C:
\Users\<username>\Documents\Altova\UModel2024\UModelExamples\Bank_MultiLanguage.ump.

8.1.2.1 Inserting state machine diagram elements

To insert state machine diagram elements:

1. Click the specific state machine diagram icon in the State Machine Diagram toolbar.

State Machine Diagram

O Ee® ® 00 8 o XEkailbRmipae| - | OB 8|
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2. Click in the State Diagram to insert the element. To insert multiple elements of the selected type, hold
down the Ctrl key and click in the diagram window.

Dragging existing elements into the state machine diagram
Most elements occurring in other state machine diagrams can be inserted into an existing state machine.
1. Locate the element you want to insert in the Model Tree tab (you can use the search function text

box, or press Ctrl+F to search for any element).
2. Drag the element(s) into the state diagram.

8.1.2.2 Creating states, activities and transitions

To add a simple state:

i
1. Click the State toolbar icon ( ), and then click inside the diagram.

2. Enter the name of the state and press Enter to confirm.

To add an activity to a state:

¢ Right-click the state element, select New, and then one of the entries from the context menu.

iY Constraint
rh Dot Ackiviey

.

.3 Do Inkeraction
= Do StateMachine
1 Entry: Activity

(.2 Enkry: Inkerackion
“o Ertry: StateMachine
r Exit: Activity

0,3 Exit: Interaction

S=  Exit: SkakeMachine
=
[

Internal Transition

Fegian

The Entry, Exit, and Do activities are associated with one of the following possible behaviors: "Activity",
"Interaction", and "StateMachine". Therefore, the options available in the context menu are:

Do: Activity

Do: Interaction
Do: StateMachine
Entry: Activity
Entry: Interaction
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Entry: StateMachine
Exit: Activity

Exit: Interaction
Exit: StateMachine

These options originate in the UML specification. Namely, each of these internal actions are behaviors, and, in
the UML specification, three classes derive from the "Behavior" class: Activity, StateMachine, and Interaction.
In the generated code, it does not make a difference which particular behavior (Activity, StateMachine, or

Interaction) has been selected.

You can select one action from the Do, Entry and Exit action categories. Activities are placed in their own
compartment in the state element, though not in a separate region. The type of activity that you select is used
as a prefix for the activity e.g. entry / store current time.

Properties o x
name store current time
elemert kind A ctivity

wizibility public =]
| O

ahatract |

reertrant |

i=ReadOnly |

i=SingleE xecutio[]

IF'ru:uperties lSt':.ers ‘

SL command sent

R L =y

Wating for result

:Eentry ! ztare current time
: exit f free allocated memary

|
"

result accepted fstore result

ExitPoint

To delete an activity:

e Click the respective activity in the state element and press the Del key.

To create a transition between two states:

1. Click the Transition handle of the source state (on the right of the element).
2. Drag-and-drop the transition arrow onto the target state.
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Logging in User

'r_ Hot Connected
: dao J listen for incoming connections
\

User Connected

lodin

The Transition properties are now \visible in the Properties tab. Clicking the "kind" combo box, allows
you to define the transition type: external, internal or local.

IPererties lSters ‘

Properties a3 x I('f Hot Connected ™
name Eu:u flizten for incoming connections:
clement kind | Transition oy
visikility unspecified [ connect [SSL available]
| O
kind external dl User Connected
cuard ==L available

oin

_I > Loqgqging in User
4

Transitions can have an event trigger, a guard condition and an action in the form eventTrigger [guard
condition] /activity.

To automatically create operations from transitions:

Activating the "Toggle automatic creation of operations in target by typing operation names" icon ,

"
st

automatically creates the corresponding operation in the referenced class, when creating a transition and
entering a name e.g. myOperation().

Note:

To automatically create operations from activities:

Operations can only be created automatically when the state machine is inside a class or interface.

1. Right click the State and select the specific action/activity, e.g. New | Entry:Activity.
2. Enter the name of the activity making sure to finish with the open/close brackets "()", e.g. entry /
OnEntryCooler().
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Note:

el Tree o x
boo. [E0] AP ConditionStatetachineDisgr s ;I
LT i : Operating
[ MainRegion
........ . ity Operstingl)
........ sk CiperatinC)
........ El:)) E I(f' Heater -\II
"""" Lot entry § OnEntryHester)
~Ef) Cperating et ¢ OrExitHester()
-E[[] Rediontocde
........ g:l feselectt) JL TmndeSelem(j
.. . - -y -
B Conler ‘& Cooler y
: ---rher:tr?rféOEEﬁrgrmiIer centry f OREntryCooler() "o
QT: rieAit-ooler ¢ exit J OnExitCaoler() !
[ eater 1 )
-[F] = Relations B b B =

The new element is also visible in the Model Tree. Scrolling down the Model Tree, you will notice that
the OnEntryCooler operation has been added to the parent class AirConditionController.

Maodel Tree

1

I EATTRGTTe Y

[ B AirCondtionController

B "= AirCondition
-------- [E] AirCondition=tatetachineliagral
(1] MainRedgion

- = IRegion

-E O~ State

- B CallBventiction

- [E] Tstateld

- <> modeSelect

S On_Off_Operating_Effect

[ < OnDebughlessage

- 4% OnErtryCooler

[ < OnErtryHeater

| B

El Model Tree ‘ K Diagram Tree | 2% Favorites

Operations are automatically added for: Do:Activity, Entry:Activity, Exit:Activity, as well as guard
condition activities and effects (on transitions).

-3 [E] T=tateld
- o modeSelect
@ s On_Off_Opersting_Effect

@ ¥ onDebughessane _ILI =
. - — - . } ) )

povverButton) -I-an_raff-_Oraerating_Effact(—j
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To create a transition trigger:

1. Right-click a previously created transition (arrow).
2. Select New | Trigger.

M| i Activity
_|[:1 Trigger

k

|| [l Activity Diagram

An "a" character appears in the transition label above the transition arrow, if it is the first trigger in the
state diagram. Triggers are assigned default values of the form alphabetic letter, source state -> target
state.

3. Double-click the new character and enter the transition properties in the form eventTrigger [guard
condition] / activity.

Transition property syntax

The text entered before the square brackets is the trigger; the text between brackets is the guard
condition, and the text after the slash—the activity. Manipulating this string automatically creates
or deletes the respective elements in the Model Tree.

Note: To see the individual transition properties, right-click the transition (arrow) and select "Select in Model
Tree". The event, activity and constraint elements are all shown below the selected transition.

EC 1 Uszer Connected ﬂ I/’ Hot Connected I
El :}’-3 Relations do J listen for incoming connections
-------- = Transition: [ -= Mot Connected) k v
-ED%I- Transition: [connect [SSL available],
P [:lu:cunneu:t connect [S5L availakble]
551 available

Adding an Activity diagram to a transition

UModel has the unique capability of allowing you to add an Activity diagram to a transition, to describe the
transition in more detail.

1. Right-click a transition arrow in the diagram, and select New | Activity Diagram. This inserts an
Activity diagram window into the diagram at the position of the transition arrow.

2. Click the inserted window to make it active. You can now use the scroll bars to scroll within the
window.
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o

(Reading tran=action data)

database
-
Kl =ert jeffect

exit f free allocated memary

L7
|»

entry

3. Double-click the Action window to switch into the Activity diagram and further define the transition, e.g.
change the Action name to "Database logon". Note that a new Activity Diagram tab has now been
added to the project. You can add any activity modeling elements to the diagram, please see "Activity
Diagram <" for more information.

=
l" [ 2, n
o— Database logon [—©
LY
g Tmmmmmm——— E’rl
w
Kl E
[=]ouery BankServer Draft lnctivityDiagraml ‘ g [

4. Click the State Machine Diagram tab to switch back to see the updated transition.
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(Rﬂading transaction data)

l data read
_____ u
database

o] zert jeffect

3
entry ﬁrrslurrsmr‘; 'a

exit f free allocated memary

1
s

result accepted fstare result
i

tirmeowt

ki

[=]|Query BankServer Draft l.ﬁ.ctivityDiagraml

5. Drag the Activity window to reposition it in the diagram, and click the resize handle if necessary.

(Rﬂading transaction data)

data read

(Sending command to datahase)

- Lgpmand sent feffect

e
-hlhq..h_hq"‘.
-

I'/_ Wating for result -\'I
entry f store current time

-

exit f free allocated memary

Dragging the Activity window between the two states displays the transition in and out of the activity.
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S
(Sending command to datahase)

command sent feffect

|/— Wating for result -\-I
entry Fstore current time

exit § free allocated memary

8.1.2.3 Composite states

= Composite state

This type of state contains a second compartment comprised of a single region. Any number of states may be
placed within this region.

To add a region to a composite state:

¢ Right-click the composite state and select New | Region from the context menu. A new region is
added to the state. Regions are divided by dashed lines.

To delete a region:
e Click the region you want to delete in the composite state and press the Del key.

Deleting a region of an orthogonal state reverts it back to a composite state; deleting the last region of a
composite state changes it back to a simple state.

To place a state within a composite state:

¢ Click the state element you want to insert (e.g. Logging in User), and drop it into the region
compartment of the composite state.

The region compartment is highlighted when you can drop the element. The inserted element is now
part of the region, and appears as a child element of the region in the Model Tree pane.
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-3 ?p ser Connected ;I
A 1] Regiont

........ O ' User Connected
........ & _
........ -}I:; J |I:Igll'| u ,._._._..______..,“'
-------- i H Logging in User j—ﬂ
........ ) I = =
-------- 1 Connecting to BankServer \[
________ ) Logging in User [authentication ok] [autherticat
-[FH ) Performing Transaction - | |

Moving the composite state moves all contained states along with it.

Orthogonal state
This type of state contains a second compartment comprised of two or more regions, where the separate
regions indicate concurrency.

Right clicking a state and selecting New | Region allows you add new regions.

e ———— - n
E'onhngunalma«tm )

i .

1 h

( o
1

i :

: |

1 ;

p eeSSSooos B =

To show/hide region names:

e Click the Styles tab, scroll to the "Show region names on states" entry, and select true/false.

Submachine state
This state is used to hide details of a state machine. This state does not have any regions but is associated to
a separate state machine.

To define a submachine state:

1. Having selected a state, click the submachine combo box in the Properties tab. A list containing the

currently defined state machines appears.
2. Select the state machine that you want this submachine to reference.

© 2017-2023 Altova GmbH Altova UModel 2024 Professional Edition



324 UML Diagrams Behavioral Diagrams

Propetties ~
Mame Transacting
element kind  [State transact
- Performing Transaction T

wizibility unspecified =

lEaf N emmmmmammmmmmm==a -

submachine e @ransacﬁng : BankSeruer@,_
oD

- I“ ---------------- T =

= Hank=ervet  Root:Behavior View

StateMachine! Root::Behavior Wiesw = ( Logging Transat:tlun_/'.
ol | . -
£l

Properties

Overview
F "

A hyperlink icon automatically appears in the submachine. Clicking it opens the referenced state
machine, "BankServer" in this case.

To add entry / exit points to a submachine state:

The state which the point is connected to, must itself reference a submachine State Machine (visible in

the Properties tab).
e This submachine must contain one or more Entry and Exit points

1. Click the ConnectionPointReference icon = in the title bar, then click the submachine state that

you want to add the entry/exit point to.

- Performing Trangaction ™

""*i:-]i:ﬂnsac’ting = BankSeruer)

a i

2. Right-click in the Properties tab and select Add entry. Please note that another Entry, or Exit Point
has to exist elsewhere in the diagram to enable this pop-up menu.

it
M lf/'_ Perfurming Tran=action _R\,
MEme ConnectionPointReferen

element kind ConnectionPointReferem h..{
,|-1F|:ﬂnsan’ting : BankServer

wizibility unzpecified =] ‘CL\ M)

L}u add entry i
Femove entry  OOOING Transan‘tiun:}

add exit vy

Remowve exit

IPererties lSters ‘

This adds an EntryPoint row to the Properties tab, and changes the appearance of the
ConnectionPointReference element.
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Iname ConnectionPointReferen

element kind ConnectionPointReferem
wizibility unzpecified =]
ity EntryPoint =]

-

Performing Trangaction

~

Entry;b"rﬁt

-y
.f | Foansacting : BankServer
-,

[ ]

,

M

KLngging Transan‘tiunj}

vy

3. Use the same method to insert an ExitPoint, by selecting "Add exit" from the context menu.

8.1.2.4 Generating code from State Machine diagrams

UModel can generate executable code from State Machine diagrams (C#, Java, VB.NET). Almost all of the

State Machine diagram elements and features are supported:

State

Region
InitialState
FinalState
Transition
Guard

Trigger
Call-Event
Fork

Join

Choice
Junction
DeepHistory
ShallowHistory
Entry/exit/do actions
Effects

CompositeState, with any hierarchical level
OrthogonalState, with any number of regions

State Machine code generation is integrated into the "normal” round-trip engineering process. This means that
State Machine code can be automatically updated on every forward-engineering process.
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-~

Operating

entry FOnEntryOperating
exit F OnExtOperating()

Regionkode s

Heater =

entry ! OnEntryHeater() H
poyvverButton)

e

exit f OnExitHeater()

-

modeselect()

modeselect()

-

Cooler \-I

entry f OnEntryCoaler()
exit f OnExitCooler()

(H

Regionzpeed

speedSelect)

speedzelect)

sheedzelect()

povwerButtoni()
Fon_Off_Operating_Effect() o

(Hj=—

standbyButton()

I/— Standby -\-I

eritry F OnErtryStandiby ()
exit ¥ OnExitStandbyy ()

standbyButton()

-~

The screenshot above shows the AirCondition State Machine diagram which is available in the ..
\StateMachineCodeGeneration directory under ...\UModelExamples. A separate directory exists for each
of the code generation languages supported by UModel.

Each directory contains an AirCondition and Complex folder, which contains the respective UModel project,
programming language project files, as well as the generated source files. The Complex.ump project file
contains almost all of the modeling elements and functionality that UModel supports when generating code

from State Machine diagrams.

Each directory also contains a test application, e.g. TestSTMAIirCondition.sIn for C#, allowing you to work with

the generated source files immediately.
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-

o2 Test State Machine Code generated by Altova UModel E@g

modeSelect powerButton  speedSelect  standbyButton

Cument state(s):

ArCandition|

=~ MainRegion : Operating
- RegionMode : Heater
RegionSpeed : Low

Debug owtput messages:

======= E\,‘En‘t 1 =========

BEGIMN_EVEMNT: powerButton
TRAMSITION: Off —= <Forc:
SET_CURRENT_STATE: Operating
ACTION: OnEntryOperating
TRAMSITION: <Forc: —= Heater
SET_CURREMNT_STATE: Heater
ACTION: OnEntryHeater
TRAMSITION: <Farcs —= Low
SET_CURRENT_STATE: Low

EMD_EVEMT: powerButton

*

m
T

To generate code from a State Machine diagram:

¢ Right-click in the State Machine diagram and select "Generate State Machine code", or
e Select the menu option Project | Generate State Machine Code

Generate State Machine Code |

—General

v getcCalEvents

¥ Generate debug messages

IRegion—— ] [ I5tate
v gekMame

¥ getstates v getld

v getMarne

v getRegions

X

Additional impartsideclarations:

Kl

¥ Automatically update state machine code

@SuppressWwarnings){"serial", "unused"})

o]

=

vl

Cancel |

The default settings are shown abowe. Click OK to generate the code.
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State Machine code is automatically updated when you start the forward engineering process. You can
however change this setting by clicking on the State Machine diagram background and clicking the "Automatic
Update Code" check box.

Changes should not be made manually in the generated code, as these changes are not reflected in the State
Machine diagram during the reverse-engineering process.

Properties
Mame AjirConditionStateMachinelDiagram
element kind Stete Machine Disgram

sutomatic Update Code

=l Froperties | 55 Skyles | EI Hierarchy

Clicking the —- icon of the Automatic Update field, opens the Generate State Machine Code dialog box,
allowing you to change the code generation settings.

To perform a syntax check on a State Machine diagram:

¢ Right-click the diagram and selecting Check State Machine Syntax from the context menu.

8.1.2.5 Working with state machine code

The parent class of the state machine (i.e. the "controller class", or "context class") is the one, and only,
"interface" between the state machine user and the state machine implementation.

The controller class provides methods which can be used from "outside" to change the states (e.g. after
external events occur).

The state machine implementation however, calls controller class methods ("callbacks") to inform the state
machine user about state changes (OnEntry, OnExit, ...), transition effects, and the possibility to override and
implement methods for conditions (guards).

UModel can automatically create simple operations (without any parameter) for entry/exit/do behaviors,
transition effects, ... when the corresponding option is turned on (also see Creating states, activities and
transitions ). These methods can be changed to whatever you want in UModel (add parameters, set them as
abstract, etc.).

A state machine (i.e. its controller class) can be instantiated several times. All instances work independently of
each other.

e The UML State machine execution is designed for the "Run-to-completion execution model".
¢ UML state machines assume that processing of each event is completed before the next event is
processed.
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e This also means no entry/exit/do action or transition effect may directly trigger a new transition/state
change.

Initialization
e Every region of a state machine has to hawe an initial state.
e The code generated by UModel automatically initializes all regions of the state machine (or when the
Initialize () method of the controller class is called).
e If OnEntry events are not wanted during initialization, you can call the Initialize () method manually
and ignore OnEntry events during the startup.

Getting the current state(s)

UModel supports composite states as well as orthogonal states, so there is not just one current state—ewvery
region (in any hierarchy level) can have one current state.

The AirCondition.ump example shows how to walk through the regions to the current state(s):

TreeNode rootNode = m CurrentStateTree.Nodes.Add(m STM.getRootState () .getName ()) ;
UpdateCurrentStateTree (m_ STM.getRootState (), rootNode) ;

private void UpdateCurrentStateTree (AirCondition.AirConditionController.IState state,
TreeNode node)

{

foreach (AirCondition.AirConditionController.IRegion r in state.getRegions())

{

TreeNode childNode = node.Nodes.Add(r.getName() + " : " +
r.getCurrentState () .getName () ) ;
UpdateCurrentStateTree (r.getCurrentState (), childNode) ;

}

Example 1 - a simple transition

Statet State2

The corresponding operation is automatically generated in UModel

MyEwvent1()

TestController

% MyEventi():boo

Generated method in code:

private class CTestStateMachine : IState

{
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public bool MyEventl ()
{

e The state machine user should call the generated method "MyEwent1" when the corresponding event
occurs (outside the state machine).

e The return parameter of these event-methods provides information about whether the event caused a
state change (i.e. if it had any effect on the state machine) or not. For example, if "State1" is active
and event "MyEvent1()" occurs, the current state changes to "State2" and "MyEwvent1()" returns true. If
"State2" is active and "MyEwvent1()" occurs, nothing changes in the state machine and MyEvent1()
returns false.

Example 2 - a simple transition with an effect

MyEwvent1(} / OnState1State2E ffect()

State1 State2

The corresponding operation is automatically generated in UModel

TestController

% MyEvent1()bool
¢%» OnState!State?Effect(in text: String):void

Generated method in code:

private class CTestStateMachine : IState

{

// Override to handle entry/exit/do actions, transition effects,...:
public virtual void OnStatelState2Effect () {}

Notes:

¢ "OnState1State2Effect()" will be called by the state machine implementation, whenever the transition
between "State1" and "State2" is fired.

e To react to this effect, "OnState1State2Effect()" should be overridden in a derived class of
"CTestStateMachine".

e "CTestStateMachine:: OnState1State2Effect()" can also be set to abstract, and you will get compiler
errors until the method is overridden.
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e When "OnState1State2Effect()" is not abstract, and the "Generate debug messages" option is active,
UModel will generate following debug output:

// Override to handle entry/exit/do actions, transition effects,...:
public virtual void OnStatelState2Effect () {OnDebugMessage ("ACTION:
OnStatelState2Effect") ;}

Example 3 - a simple transition with an effect and parameter

MyEvent1(} / OnState1State2Effect("™ == 27}

State1 State2

The corresponding operation is automatically generated in UModel

TestController

¢» MyEvent1(}bool

™% OnStateState2Effect(in text: String)ovoid

Generated method in code:

private class CTestStateMachine : IState

{

// Additional defined operations of the controller class:
public virtual void OnStatelState2Effect (String text)

{
}

Notes:

e To effect operations (automatically created by UModel) parameters can be added manually (UModel
cannot know the required type).

e Inthis sample, the parameter "text:String" has been added to the Effect method in TestController. A
proper argument has to be specified when calling this method (here: "1 => 2").

e Another possibility would be: e.g. to call static methods ("MyStatic.OnState1State2Effect("1 => 2")"),
or methods of singletons ("getSingleton().OnState1State2Effect("1 => 2")").
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Example 4 - entry/exit/do actions

o State3 Ty MyEvent2() 7 Stated N
exit / OnExit=tate3() entry / OnEntryStated()
k oy do / OnDoStated()
p

The corresponding operations are automatically generated in UModel

TestController

&% MyEvent!()bool
% OnState1State2Effect(in text: String)ovoid

Generated method in code:

private class CTestStateMachine : IState

{

Notes:

// Override to handle entry/exit/do actions, transition effects,...:
public virtual void OnExitState3 () {}

public virtual void OnEntryState4 () {}

public virtual void OnDoStated () {}

States can have entry/exit/do behaviors. UModel automatically creates the corresponding operations to
handle them.

When "MyEwent2()" occurs in the sample above, the state machine implementation calls
"OnEXxitState3()". If "MyEvent2" would have an Effect, it would be subsequently called, then
"OnEntryState4" and "OnDoState4" would be called.

Normally, these methods should be owverridden. When they are not abstract and the "Generate debug
messages" option is active, UModel provides default debug output as described in Example 2.

These methods can also have parameters as shown in Example 3.

Example 5 - guards
Transitions can have guards, which determine if the transition really can fire.
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MyEvent2(} [CanGoStates()]
States State6

The corresponding operation is automatically generated in UModel

TestController

% MyEvent2()bool

% CanGosStates()bool

Generated method in code:

private class CTestStateMachine : IState

{

// Additional defined operations of the controller class:
public virtual bool CanGoState6 ()
{

return true; // Override!

}

Notes:

If "State5" is the active state and "MyEvent2" occurs, the state machine implementation will call

"CanGoState6" and, depending on its result, the transition will fire or not.

¢ Normally, these methods should be overridden. When they are not abstract and the "Generate debug
messages" option is active, UModel provides default debug output as described in Example 2.

o These methods also can have parameters as shown in Example 3.

e Multiple transitions with the same event, but having different guards, are possible. The order in which

the different guards are polled is undefined. If a transition does not have a guard, or the guard is "else",

it will be considered as the last (i.e., only when all other transition guards return false, will this one will

fire). For example, in the diagram below, it is undefined whether canGoState6 () or CanGoState7 () is

called first. The third transition will only fire if CanGoState6 () and canGoState7 () return false.
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MyEwvent2(} [CanGoStates()]

| states | State
-

MyEventZ(} [CanGoState7(}]

)

State?

MyEwventZ() [elze]
Stated

0e

Additional constructs and functionality can be found in the AirCondition.ump and Complex.ump samples.

8.1.2.6 State Machine Diagram elements

InitialState (pseudostate)
The beginning of the process.

]

FinalState
The end of the sequence of processes.

8]

EntryPoint (pseudostate)

The entry point of a state machine or composite state.

@

ExitPoint (pseudostate)
The exit point of a state machine or composite state.

<

Choice

This represents a dynamic conditional branch, where mutually exclusive guard triggers are evaluated (OR
operation).

* Junction (pseudostate)
This represents an end to the OR operation defined by the Choice element.

X

Terminate (pseudostate)
The halting of the execution of the state machine.
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y

Fork (pseudostate)

Inserts a vertical Fork bar. Used to divide sequences into concurrent subsequences.

4

£

Fork horizontal (pseudostate)

Inserts a horizontal Fork bar. Used to divide sequences into concurrent subsequences.

ik

Join (pseudostate)

Joins/merges previously defined subsequences. All activities have to be completed before progress can

conti

Jbd

T

nue.

Join horizontal (pseudostate)

Joins/merges previously defined subsequences. All activities have to be completed before progress can
continue.

()

DeepHistory

A pseudostate that restores the previously active state within a composite state.

G

ShallowHistory

A pseudostate that restores the initial state of a composite state. All pseudostate elements can be changed to
a different "type", by changing the kind combo box entry in the Properties tab.

Properties

NAMmEe

elemernt kind Pzeudostate

ExitPoint

wizibility unzpecified =]

kil a!ml d
initial -
deepHistary
shallowHistary
jir

Properties | SEfark

. junction

OveErviem )
chioice
entryPoint

lerminate ;L
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&4 | ConnectionPointReference

A connection point reference represents a usage (as part of a submachine state) of an entry/exit point defined
in the state machine reference by the submachine state.

To add Entry or Exit points to a connection point reference:

e The state which the point is connected to, must itself reference a submachine State Machine (visible in
the Properties tab).
e This submachine must contain one or more Entry and Exit points

—

Transition

A direct relationship between two states. An object in the first state performs one or more actions and then
enters the second state depending on an event and the fulfillment of any guard conditions. Transitions have an
event trigger, guard condition(s), an action (behavior), and a target state. The supported event subelements are:

ReceiveSignalEvent
SignalEvent
SendSignalEvent
ReceiveOperationEvent
SendOperationEvent
ChangeEvent.

+
4]
&,

Toggle automatic creation of operations in target by typing operation names

Activating the "Toggle automatic creation of operations in target by typing operation names" icon, automatically
creates the corresponding operation in the referenced class, when creating a transition and entering a name
myOperation ().

Note: Operations can only be created automatically when the state machine is inside a class or interface.

8.1.3 Protocol State Machine

Altova website: UML Protocol State Machine diagrams

Protocol State Machines are used to show a sequence of events that an object responds to, without having to
show the specific behavior. The required sequence of events, and the resulting changes in the state of the
object, are modeled in this diagram.

Protocol State Machines are most often used to describe complex protocols, e.g. database access through a
specific interface, or communication protocols such as TCP/IP.

Protocol State Machines are created in the same way as State Machine diagrams, but have fewer modeling
elements. Protocol-Transitions between states can have pre- or post conditions which define what must be true
for a transition to another state to occur, or what the resulting state must be, once the transition has taken
place.
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stm ProtocolStateMachined {prntu:u:u:ul})

[creste] §

CreateDB

[close] J

open f[good login]

.| OpenDB
.

[queryStatement==null] / [com&resa set]
[cancel] I [comirea cleared]

ﬂu@

[fetch] F [comares recordioK]

FetchData

p

[cancel] f [comArea cleared) [close] /

[close] §

A

Clo=eDB

[destroy] §

8.1.3.1 Inserting Protocol State Machine elements

Protocol State Machine Diagram

COREE® ® 008 ¢ XEkmibasl - OB 0

Using the toolbar icons:

1. Click the Protocol State Machine icon in the toolbar.
2. Click in the Protocol State Machine Diagram to insert the element. To insert multiple elements of the
selected type, hold down the Ctrl key and click in the diagram window.
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Dragging existing elements into the Protocol State Machine diagram
Most elements occurring in other Protocol State Machine diagrams, can be inserted into an existing diagram.

1. Locate the element you want to insert in the Model Tree tab (you can use the search function text

box, or press Ctrl+F to search for any element).
2. Drag the element(s) into the Protocol State Machine diagram.

To insert a simple state:

—
1. Click the State icon in the icon bar and click in the Protocol State Machine diagram to insert it.

2. Enter the name of the state and press Enter to confirm. Simple states do not have any regions or any
other type of substructure.

To create a Protocol Transition between two states:

1. Click the Transition handle of the source state (on the right of the element), or use the Protocol
Transition icon in the icon bar.

2. Drag-and-drop the transition arrow onto the target state. The text cursor is automatically set for you to
enter the pre and/or post condition. Please make sure to use the square brackets [] and slash
character when entering the conditions directly.

Entering the pre/post conditions in the Properties window automatically inserts the square brackets
and slash character into the diagram.

Properties

Marme ProtocolTransitions y,
oualified name Protocol=tateMachine::Regic
elemert kind  |ProtocolTranstion b,

[fetch] §F [comares FecordOR]

wizibility unspecified =1 K

et ] - B "

i exdernal - .[cancel] I [comArea cleared].

pre condition  ancel [close] ¥

post condition comArea cleared

&

[destroy] §

For information about how to create and insert composite state elements and submachine states, see
Composite states @
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8.1.3.2 Protocol State Machine Diagram elements

—

State

A simple state element with one compartment.

= Composite state

This type of state contains a second compartment comprised of a single region. Any number of states may be
placed within this region.

Orthogonal state

This type of state contains a second compartment comprised of two or more regions, where the separate
regions indicate concurrency. Right clicking a state and selecting New | Region allows you add new regions.

Submachine state

This state is used to hide details of a state machine. This state does not have any regions but is associated to
a separate state machine.

InitialState (pseudostate)
The beginning of the process.

]

FinalState
The end of the sequence of processes.

(@]

EntryPoint (pseudostate)

The entry point of a state machine or composite state.

&

ExitPoint (pseudostate)
The exit point of a state machine or composite state.

<

Choice

This represents a dynamic conditional branch, where mutually exclusive guard triggers are evaluated (OR
operation).
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* Junction (pseudostate)
This represents an end to the OR operation defined by the Choice element.

*

Terminate (pseudostate)
The halting of the execution of the state machine.

'k Fork (pseudostate)

Inserts a vertical Fork bar. Used to divide sequences into concurrent subsequences.

4

£

Fork horizontal (pseudostate)
Inserts a horizontal Fork bar. Used to divide sequences into concurrent subsequences.

b Join (pseudostate)

Joins/merges previously defined subsequences. All activities have to be completed before progress can
continue.

Jbd

T

Join horizontal (pseudostate)

Joins/merges previously defined subsequences. All activities have to be completed before progress can
continue.

fasi}

ConnectionPointReference

A connection point reference represents a usage (as part of a submachine state) of an entry/exit point defined
in the state machine reference by the submachine state.

To add Entry or Exit points to a connection point reference:

e The state which the point is connected to, must itself reference a submachine State Machine (visible in
the Properties tab).
e This submachine must contain one or more Entry and Exit points

—

Protocol Transition

A direct relationship between two states. An object in the first state performs one or more operations and then
enters the second state depending on an event and the fulfillment of any pre- or post conditions.

Please see Inserting Protocol State Machine elements@ for more information.
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8.1.4 Use Case Diagram

Please see the Use Cases section in the tutorial for more information on how to add use case elements to
the diagram.

Standard User
get account balance
qqincfgfrde:b
get account balance sum
Bank
8.1.5 Communication Diagram

Altova website: ¢ UML Communication diagrams

Communication diagrams display the interactions i.e. message flows, between objects at run-time, and show
the relationships between the interacting objects. Basically, they model the dynamic behavior of use cases.

Communication diagrams are designed in the same way as sequence diagrams, except that the notation is laid
out in a different format. Message numbering is used to indicate message sequence and nesting.

UModel allows you to generate Communication dia%rams from Sequence diagrams and vice versa, in one
simple action see "Generating Sequence diagrams %" for more information.
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— 1a: Message]
Hy s[k]B

1h1: Message3 4+
Jr 1h1.1: Mezsaged
1h: Message? ~yg
¢ 1h1.2 Messages

s[ul:B

8.1.5.1 Inserting Communication Diagam elements

Using the toolbar icons:

1. Click the specific communication icon in the Communication Diagram toolbar.

Add Elements - Communi » =

= | e x| B

2. Click in the Communication diagram to insert the element. To insert multiple elements of the selected
type, hold down the Ctrl key and click in the diagram window.

Dragging existing elements into the Communication Diagram
Elements occurring in other diagrams, e.g. classes, can be inserted into a Communication diagram.

1. Locate the element you want to insert in the Model Tree tab (you can use the search function text
box, or press Ctrl+F to search for any element).
2. Drag the element(s) into the Communication diagram.

=

Lifeline

The lifeline element is an individual participant in an interaction. UModel allows you to insert other elements into
the sequence diagram, e.g. classes. Each of these elements then appear as a new lifeline. You can redefine
the lifeline colors/gradient using the "Header Gradient" combo boxes in the Styles tab.

To create a multiline lifeline, press Ctrl+Enter to create a new line.
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To insert a Communication lifeline:

1. Click the Lifeline icon in the title bar, then click in the Communication diagram to insert it.

Properties o x

natme Lifeline1 ': -------- -:'
cualified name Interaction?::Lifeline1 ' Lifelinet '
element kind Lifeline : :
vizihility unzpecified | == m——— G
represents |

destruction |

=elector

2. Enter the lifeline name to change it from the default name, Lifeline1, if necessary.

Messages

A Message is a modeling element that defines a specific kind of communication in an interaction. A
communication can be e.g. raising a signal, invoking an Operation, creating or destroying an instance. The
message specifies the type of communication as well as the sender and the receiver.

_}
Message (Call)

Message (Reply)

Message (Creation)

b

Message (Destruction)

To insert a message:

1. Click the specific message icon in the toolbar.
Drag and drop the message line onto the receiver objects.
Lifelines are highlighted when the message can be dropped.

Properties ox
Marme Messaged
qualified name Irteractiont::Mezzag Lifelined Lifeline?
element kind Meszage
wvizibility unzpecified | — 1. Mezzagel
messagesort synchCall hdl . .
operation -] 1.1 Mesaagel
asynich O " B
uzer defined sequence

Lifelinel
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Note: Holding down the Ctrl key allows you to insert a message with each click.

To insert additional messages:

1. Right-click an existing communication link and select New | Message.

Lifelined Lifeline2

— 1. Meszagel

JY 1.1: Message?
‘L 1.2 Messaged

Lifeline3

e The direction in which you drag the arrow defines the message direction. Reply messages can point in
either direction.

¢ Having clicked a message icon and holding down Ctrl allows you to insert multiple messages by
repeatedly clicking and dragging in the diagram tab.

Message numbering

The Communication diagram uses the decimal numbering notation, which makes it easy to see the hierarchical
structure of the messages in the diagram. The sequence is a dot-separated list of sequence numbers followed
by a colon and the message name.

Generating Sequence diagrams from Communication diagrams

UModel allows you to generate Communication diagrams from Sequence diagrams and vice versa, in one
simple action:

¢ Right-click anywhere in a Communication diagram and select Generate Sequence Diagram from the
context menu.

Altova UModel 2024 Professional Edition © 2017-2023 Altova GmbH



UML Diagrams Behavioral Diagrams 345

| o Lifeli... | O Lifeli... | o Lifeli...
Lifelined Lifeline2 Lifeline3
: 1: Message : :
- - :
1.1: Mezsage? .
-
Reply A‘
q 1
1.2 Mezsage3
-
Reply2 *‘
ol ;
Reply3 .
i ; :
8.1.6 Interaction Overview Diagram

Altova website: ¢ UML Interaction Oveniew diagrams

Interaction Oveniew Diagrams are a variant of Activity diagrams and give an oveniew of the interaction between
other interaction diagrams such as Sequence, Activity, Communication, or Timing diagrams. The method of
constructing a diagram is similar to that of Activity diagram and uses the same modeling elements: start/end
points, forks, joins etc.
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?

EzstablizhAccess("lllegal PIN™)

ref )

{0,253
sd
User ACSystem
: CardOut :
[phzr{]
sd
User ACSystem
Please enter :

Two types of interaction elements are used instead of activity elements: Interaction elements and Interaction
use elements.

Interaction elements are displayed as iconized versions of a Sequence, Communication, Timing, or Interaction
Oweniew diagram, enclosed in a frame with the "SD" keyword displayed in the top-left frame title space.

Interaction occurrence elements are references to existing Interaction diagrams with "Ref" enclosed in the
frame's title space, and the occurrence's name in the frame.

8.1.6.1 Inserting Interaction Overview elements

Using the toolbar icons
1. Click the specific icon in the Interaction Oveniew Diagram toolbar.
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Add Elements - Interaction Overyiew Diagram

2 4 @ o Brrib Hi — B 1

2. Click in the diagram to insert the element. To insert multiple elements of the selected type, hold down
the Ctrl key and click in the diagram window.

Dragging existing elements into the Interaction Overview Diagram

Elements occurring in other diagrams, e.g. Sequence, Activity, Communication, or Timing diagrams can be
inserted into a Interaction Ovenview diagram.

1. Locate the element you want to insert in the Model Tree tab (you can use the search function text box,

or press Ctrl+F, to search for any element).
2. Drag the element(s) into the diagram.

Inserting an Interaction element

1. Click the CallBehaviorAction (Interaction) icon
Oveniew diagram to insert it.

in the icon bar, and click in the Interaction

Properties 1 X o ]
name CallBehavior&ction (Interaction) s .;-’:::::;"
gualified name  |Design Visw:: Activity]: CallBieh: || SReRERH=e
element kind CallBehavior Action ! R
wizibility unzpecified Sl | : : :
oat I:l : 4 ok oA R H : :
=Sy nchronous ] ; :
behavioridiagram  Callect Account Information = | i I, S 2 wccoargaurcn i
| e 1
1 i dbank
1 g rn o HLIERR
1 ik FLE Y
1 ipHIHIMI:’H-II
: Py e
1 rianiks
1 rin
1
i decoarBuliecH| ]
I weccrin v
1 7 T
=] Froperties | &5 Stvles ; coleciec cuminicn . i
1 L M ' '
Creeryig ax H
I 1
1
I- ........................................

The Collect Account Information sequence diagram is automatically inserted if you are using the
Bank_Multilanguage.ump example file from the ...\UModelExamples folder. The first sequence
diagram, found in the model tree, is selected by default.

2. To change the default interaction element: Click the behavior/diagram combo box in the Properties
tab. A list of all the possible elements that can be inserted is presented.
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Properties

e
qualified name
element kindd
wizikility

leaf
iz=ynchronous

Overview

behaviotidiagrarm

gk d b 1
IR
Ete deribs Jrci e
L

L]
CallBehaviorAction (Interaction] IE:I
Dezign Wiew: Activity:: CallBeh| (f §
CallBehavior &ction .
unspecified i :
O i
i
3 F|I ..................... ﬂ i

ol chrinil]

=ref= (write empty result, log error)
=ref= [BankWiew)

=ref= (FiterDisplayData)

=ref= (HandleDizplayException)

. =ref= (lizten for incaming connections)
Properties
IE' R lqc:refb (Bark APl

=ref= (Collect Accourt Information)

Collect Account Infarmstion
=ref= (Connect to Bank &P

Foot::
Foot:
Foot::

Behavior Wiew

Root:: Behavior Wiew

Root:: Interaction Wiew
Root::
Root:: Interaction Wiew

2 Inter or

3. Click the element you want to insert to e.g. Connect to BankAPI.

:Behavior View: BankWiew
Behavior View: BankWiew

Irteraction Wiew: Collect Ad

onnect t

Properties

ax

e
qualified name
elemert kind
wizibility

leaf
iz=ynchronous
behavioridiagram

CallBehaviorAction (Inte
Dresign Wieww:: Activity1:
CallBehavior Sction
unspecified

O

fod]|

coPrkE|

sd

herdSPED kS —

corra|

Connect to BankaPl =

T

CTELTL LY TLTEN NPT -2 | hersOenkC

kealei]

EEmEE. fusmsmmn

As this is also a sequence diagram, the Interaction element appears as an iconized version of the
sequence diagram.
If you select <ref> BankAPI, then the Interaction element occurrence is displayed.

Properties

q X

rame

cualified name
elemert kind
wizibility

leaf
izSynchronous
behavioridiagram

CallBehavior Action (Inte
Design Yiesn:: Activity1:

CalBehaviar Action "
Lnspecified | !
[l i
=ref= (BankaP i
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Inserting an Interaction element occurrence

1.

Click the CallBehaviorAction (InteractionUse) icon in the icon bar, and click in the Interaction
Oweniew diagram to insert it.

Collect Account Information is automatically inserted as a Interaction occurrence element, if you are
using the Bank_Multilanguage.ump example file from the ...\UModelExamples folder. The first
existing sequence diagram is selected per default.

Properties o x

name CallBehavior Action (InteractionlUse) .
qualified name Design Yiew:: Activity1:: CallBehavior &) -

clemert kind  |CallBehavior ction : sl sl LU s
wizibility Lnspecified |
leaf O ]

i=Synchronous
hehavioridiagram |=ref= (Collect Account Information) = |

To change the Interaction element, double-click the behavior combo box in the Properties tab. A list
of all the possible elements that can be inserted is presented.
Select the occurrence you want to insert.

Note: All elements inserted using this method appear in the form shown in the screenshot abowe i.e. with

it
£

"ref" in the frame's title space.

DecisionNode

Inserts a Decision Node which has a single incoming transition and multiple outgoing guarded transitions.
Please see "Creating a branch©d" for more information.

lél

MergeNode

Inserts a Merge Node which merges multiple alternate transitions defined by the Decision Node. The Merge
Node does not synchronize concurrent processes, but selects one of the processes.

InitialNode

The beginning of the activity process. An interaction can have more than one initial node.

®

ActivityFinalNode

The end of the interaction process. An interaction can have more that one final node, all flows stop when the
"first" final node is encountered.
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1L ForkNode

Inserts a vertical Fork node. Used to divide flows into multiple concurrent flows.

4

™ | ForkNode (Horizontal)
Inserts a horizontal Fork node. Used to divide flows into multiple concurrent flows.

ik JoinNode

Inserts a vertical Fork node. A Join node synchronizes multiple flows defined by the Fork node.

Abd

T

Join Node (horizontal)
Inserts a horizontal Fork node. A Join node synchronizes multiple flows defined by the Fork node.

[ AddDurationConstraint

A Duration defines a ValueSpecification that denotes a duration in time between a start and endpoint. A
duration is often an expression representing the number of clock ticks, which may elapse during this duration.

—

ControlFlow

A Control Flow is an edge, i.e. an arrowed line, that connects two behaviours, and starts an interaction after the
previous one has been completed.

8.1.7 Sequence Diagram

Altova website: UML Sequence diagrams

UModel supports the standard Sequence diagram defined by UML, and allows easy manipulation of objects
and messages to model use case scenarios. The sequence diagrams shown in the following sections are
available in the Bank_Java.ump, Bank_CSharp.ump and Bank_MultiLanguage.ump samples, in the ...
\UModelExamples folder supplied with UModel.

You can model sequence diagrams manually, or, alternatively, generate them from reverse-engineered source
code, as described in Generating Sequence Diagrams from Source Code®@. The 